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E1/E20 Emulator

Additional Document for User’'s Manual
(Notes on Connection)

Supported Devices:
RX Family / RX600 Series
RX610, RX621, RX62N, RX62T, RX630, RX631, and RX63N Groups

RX Family / RX200 Series
RX210 Group

Aboutthe Recommende@ircuit for Connection
betweerthe Connectolandthe RX62G Groupor RX63T Group(48-pinor 64-pin)
1. Recommendedircuit for connectiorbetweerthe connectomandthe RX62G Group
is sameasthatfor the RX62T Group.
Pleaseaeferto Figure2.6 (P19)or Figure2.10(P24).
2. Recommendedircuit for connectiorbetweerthe connectorandthe RX63T Group (48-pinor 64-pin)

is sameasthosefor the RX630,RX631andRX63N GroupsexceptPC7.
Sincethe RX63T Group (48-pinor 64-pin)doesnot havePC7,it is notnecessaryo connectPC7.
Pleaseaeferto Figure2.7 (P20)or Figure2.8 (P21).

All information contained in these materials, including products and product specifications,
represents information on the product at the time of publication and is subject to change by
Renesas Electronics Corporation without notice. Please review the latest information published
by Renesas Electronics Corporation through various means, including the Renesas Electronics
Corporation website (http://www.renesas.com).
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About the Recommended Circuit for Connection 
between the Connector and the RX62G Group or RX63T Group (48-pin or 64-pin)
   1. Recommended circuit for connection between the connector and the RX62G Group 
       is same as that for the RX62T Group.
       Please refer to Figure 2.6 (P19) or Figure 2.10 (P24).
  2.  Recommended circuit for connection between the connector and the RX63T Group  (48-pin or 64-pin)
       is same as those for the RX630, RX631 and RX63N Groups except PC7.
       Since the RX63T Group  (48-pin or 64-pin) does not have PC7, it is not necessary to connect PC7.
       Please refer to Figure 2.7 (P20) or Figure 2.8 (P21).
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Notice

All information included in this document is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.

You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by
you or third parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. You should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the development of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errors in or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as
indicated below. You must check the quality grade of each Renesas Electronics product before using it in a particular
application. You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not be in any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is “Standard” unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.

“Specific™: Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life.

You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with
applicable laws and regulations.

This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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Section 1 Configuration of E1/E20 Emulator Manuals

Documentation for the E1/E20 emulator manual is in two parts: the E1/E20 Emulator User’s Manual and the E1/E20
Emulator Supplementary Document for the User’s Manual (this manual). Different versions of the latter correspond to
different sets of MCUs. Be sure to read both of the manuals before using the E1/E20 emulator (hereinafter referred to as
"the emulator").

(1) The E1/E20 emulator user’s manual has the following contents:
e Components of the emulators
e Emulator hardware specification
e Connection to the emulator and the host machine and user system
(2) The EL/E20 Emulator Supplementary Document for the User’s Manual has the following contents:
e Specifications of the emulators
e Individual functions of the emulator
e Instructions on how to use the emulator debugger
e For use in hardware design, an example of connection and the interface circuit required to connect the emulator.
e Notes on using the emulator
o Software specifications and so on for using RXxxx group microcomputers
e A tutorial on procedures from starting up the emulator to debugging operations
R20UT0399EJ0401 Rev.4.01 Page 7 of 210
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Section 2 Designing the User System

21 Connecting the Emulator with the User System

To connect the E1 or E20 emulator (hereinafter referred to as the emulator), a connector for the user system interface
cable*! must be mounted on the user system. When designing the user system, read this section of this manual and the
hardware manual for the MCUs.

Note: 1. When inserting or removing the user system interface cable from the connector section of the user system,

be sure to hold the connector cover at the head of the cable. Removal by pulling the cable portion instead of
grasping the cover causes breakage of the cable connection.

Table 2.1 shows the type numbers of the E1 and E20 emulators, the corresponding connector types, and whether or not
the external trace-output function is available.

Table2.1  Type Numbers, Trace Pin Functions, and Connector Types

Emulator Type Number Connector Communication External
Type interface Trace-Output

Functions
E1l ROEOOOO010KCEOO 14-pin type JTAG, FINE Not available
E20 ROEO00200KCTO00 14-pin type** JTAG, FINE Not available
E20 ROE000200KCTO00 38-pin type JTAG Available

Notes: 1.  38-pin to 14-pin conversion adapter is also required

There are two types of connector, one with 14 and the other with 38 pins, as described below. Use the connector that
corresponds to the aims of emulation. To use the external trace-output function, which is capable of obtaining large
amounts of trace data in realtime, the 38-pin type connector is required.

(1) 14-pin type (external trace-output function is not available)
This connector only supports basic functions using JTAG connection and FINE connection and do not employ the
external trace-output function intended for the acquisition of large amounts of trace data by the external trace-output
function. These connectors are general-purpose connectors with a pitch of 2.54 mm.

(2) 38-pin type (external trace-output function is available)
This connector supports basic functions that employ JTAG connection, and the external trace-output function for
acquiring large amounts of trace data in realtime. This connector is as compact as the 14-pin connectors.

R20UT0399EJ0401 Rev.4.01 Page 8 of 210
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2.2 Installing the Connector on the User System
Table 2.2 shows the recommended connectors for the E1 and E20 emulators.

Table 2.2 Recommended Connectors

Connector Type Number Manufacturer Specifications
14-pin connector  7614-6002 Sumitomo 3M Limited 14-pin straight type
(Japan)
2514-6002 3M Limited 14-pin straight type

(other countries)

38-pin connector  2-5767004-2 Tyco Electronics Japan G.K.  38-pin type

Notes: (1) If you are using the 14-pin connector, do not mount other components with a height exceeding 10 mm within
5 mm of the connector on the user system. Figures 2.1 and 2.2 show examples of the connection between a
user system interface cable of the 14-pin type and an E1, and an example of connection of the cable with the
14-pin connector to the E20 via the 38-pin to 14-pin conversion adapter.

14-pin user system interface cable

14-pin type connector
7614-6002 or
2514-6002

User system

%m@%

Pin 1

Figure 2.1 Connecting the User System Interface Cable to the 14-Pin Connector of the E1 Emulator
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38-pin user system interface cable

'

9.4 mm

38-pin to 14-pin
conversion adapter

! U | /1 4-pin type connector

9.4 mm

7614-6002 or

2514-6002
10 mm |_|

e

User system

External dimentions of the 38-pin to 14-pin
conversion adapter (top view)

Figure 2.2 Connecting the User System Interface Cable to the 14-Pin Connector of the E20 Emulator

(2) When designing the layout of a user board with a 38-pin connector, reduce cross-talk noise etc. by keeping
other signal lines out of the region where the connector is situated. As shown in Figure 2.3, an upper limit (5
mm) applies to the heights of other components mounted around the connector (labeled "Area with limit on

mounted components™) in the figure.

/

38-pin type connector

2-5767004-2 ——» | | |

38-pin user system interface cable

$

5mm

User system

15 mm
1 1
:i‘
1 1

[ : Area with limit on mounted components.

Connector (top view)

Figure 2.3 Connecting the User System Interface Cable to the 38-Pin Connector of the E20 Emulator
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CAUTION

An upper limit applies to the heights of components mounted around the connector
on the user system.

Type number: 7614-6002 or 2514-6002
(manufactured by 3M Limited)

The emulator is connected from this direction.

< -

5mm

© O
@ &

@ @
Q@
@ @
Q &
@ @

5mm

5 mm 5mm

I:l Area with limit on mounted components
(heights must be no greater than 10 mm)

Type number: 2-5767004-2
(manufactured by Tyco Electronics Japan G.K.)

The emulator is connected from this direction.

37 1

b

38 2

7.5mm 7.5 mm

30 mm

Areawith limit on mounted components
|:| theights must be no greater than S mm)
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2.3 Pin Assignments of the Connector on the User System
231 14-Pin Connector Specifications
Figure 2.4 shows the specifications of the 14-pin connector.

Tables 2.3 and 2.4 on the following pages show the pin assignments differing with each MCU group in JTAG
connection and FINE connection.

Pin 1 mark Connector

| | Connector (top view)

Pn2 0 O O O O O O<{Pinia
O 0 0 0 0

pn1 PO O+ Pin 13
I I
A <045
Pin 1 mark Unit: mm

Figure 2.4 Emulator Connector Specifications (14 Pin)

When writing to the RX610 Group MCUs and RX62T Group MCUs (112-pin
version) using the Flash Development Toolkit (called “FDT” hereafter), be
aware that the pin assignments of the 14-pin connector differ than otherwise.
For details on the FDT, refer to http://www.renesas.com/fdt.
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Table 2.3 14-Pin Connector Pin Assignments Differing with Each MCU Group in JTAG Connection

RX610, RX621, RX62N and RX630, RX631and RX63N

RX62T Groups Groups
Pin No.  Signal*'* Direction*®*  Signal*® Direction*®> Note
1 TCK Input TCK Input Communication clock
2 GND** — GND** — GND
3 TRST#*° Input TRST#* Input
4 (EMLE)*® 110 (EMLE)*® 110
5 TDO Output TDO Output
6 NC — NC — Not connected
7 (MD1)*° 110 (MD)*® 110 Operation mode
8 VCC - VCC - Power supply
9 T™MS Input T™MS Input
10 (MDO)*® 110 (PC7)*® 110 Operation mode
11 TDI Input TDI Input
12 GND** — GND** — GND
13 RES# 110 RES#* 110 User system reset
14 GND** — GND** — Checking connection to

user system

Notes: 1.

When writing to the RX610 Group MCUs and RX62T Group MCUs (112-pin version) using the
FDT, be aware that the pin assignments of the 14-pin connector differ than otherwise. For details
on the FDT, refer to http://www.renesas.com/fdt.

. These are the names of the MCU pins at the time the E1 or E20 is connected (i.e. during

debugging).

Input to or output from the user system.

Securely connect pins 2, 12, and 14 of the connector to GND on the user system. These pins are
used as electrical GND and for the E1 or E20 to monitor connection to the user system.

The symbol (#) means that the signal is active low.

The pins marked with () operate even if they are not connected to the E1 or E20. When the pins
are not connected to the E1 or E20, special circuits for the pins must be configured on the user
system.
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Table 2.4 14-Pin Connector Pin Assignments Differing with Each MCU Group in FINE Connection

RX630, RX631 and RX63N RX210 Group

Groups
Pin No.  Signal* Direction**  Signal** Direction** Note
1 FINEC*® Input NC Input Communication clock
2 GND*® — GND*® — GND
3 NC — NC —
4 (EMLE)*® 110 NC —
5 (TxD1)*® Output (TxD1)*® Output
6 NC — NC — Not connected
7 MD/FINED*® 110 MD/FINED* 110 Operation mode /
Communication data
8 VCC — VCC — Power supply
9 NC — NC —
10 (PCT)*® 110 (PCT)*® 110 Operation mode
11 (RxD1)*® Input (RxD1)*® Input
12 GND*® — GND*® — GND
13 RES#** 110 RES#** 110 User system reset
14 GND*® — GND*® — Checking connection to

user system

Notes: 1.

~

These are the names of the MCU pins at the time the E1 or E20 is connected (i.e. during
debugging).

Input to or output from the user system.

Securely connect pins 2, 12, and 14 of the connector to GND on the user system. These pins are
used as electrical GND and for the E1 or E20 to monitor connection to the user system.

The symbol (#) means that the signal is active low.

The pins marked with () operate even if they are not connected to the E1 or E20. When the pins
are not connected to the E1 or E20, special circuits for the pins must be configured on the user
system.

FINE interface is supported only for 2-wire system using FINEC and MD/FINED pins.
FINE interface is supported for 1-wire system using MD/FINED pin.

RxD1 and TxD1 signals are NOT required for debugging. These are only used for internal flash
programming with Renesas Flash Programmer.
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2.3.2 38-Pin Connector Specifications

Figure 2.5 shows the specifications of the 38-pin connector.
Tables 2.5 and 2.6 on the following pages show the pin assignments differing with each MCU group in JTAG

connection.
In FINE connection, use the 38-pin to 14-pin conversion adapter included with the E20 to connect the emulator to the

14-pin connector.

6.21

!: > Unit: mm
254

Connector (top view)

Figure 2.5 Emulator Connector Specifications (38-Pin)

The GND bus lead at the center of the 38-pin connector must be grounded.
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Table 2.5 38-Pin Connector Pin Assignments in JTAG Connection (for RX610, RX621, RX62N and RX62T

Groups)
Pin Signal*¥*  Direction*¥’* Note Pin Signal**  Direction¥*  Note
No. No.
1 NC — Not connected 2 (MDO)*3 110 Operation mode
3 (EMLE)*3 110 4 NC — Not connected
5 GND* - Checking 6 TRCLK Output
connection to
user system
7 NC — Not connected 8 (MDl)*3 /0 Operation mode
9 RES#*° 1/O User system 10 NC — Not connected
reset
11 TDO Output 12 VvCC — Power supply
13 NC — Not connected 14 VvCC — Power supply
15 TCK Input Communication 16 NC — Not connected
clock
17 TMS Input 18 NC — Not connected
19 TDI Input 20 NC — Not connected
21 TRST#* Input 22 NC - Not connected
23 NC — Not connected 24  TRDATA3 Output
25 NC — Not connected 26 TRDATA2 Output
27 NC - Not connected 28 TRDATA1 Output
29 NC — Not connected 30 TRDATAO  Output
31 NC — Not connected 32 TRSYNC Output
33 NC — Not connected 34 NC — Not connected
35 NC - Not connected 36 NC — Not connected
37 NC — Not connected 38 NC — Not connected

Notes: 1. These are the names of the MCU pins at the time the E1 or E20 is connected (i.e. during

debugging).

2. Input to or output from the user system.

3. The pins marked with () operate even if they are not connected to the E1 or E20. When the pins
are not connected to the E1 or E20, special circuits for the pins must be configured on the user

system.

4. Securely connect pin 5 and the GND bus lead of the connector to GND on the user system. These
are used as electrical GND and for the E1 or E20 to monitor connection to the user system.

5. The symbol (#) means that the signal is active low.

R20UTO399EJ0401 Rev.4.01
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Table 2.6 38-Pin Connector Pin Assignments in JTAG Connection (for RX630, RX631 and RX63N Groups)

Pin

Pin

. el . ion%2 . ol . ion#2
No. Signal Direction Note No. Signal Direction Note
1 NC - Not connected 2 (PC?)*3 110 Operation mode
3 (EMLE)*3 110 4 NC — Not connected
5 GND** — Checking 6 TRCLK Output
connection to
user system
7 NC — Not connected 8 (MD)*3 110 Operation mode
9 RES# 1/0 User system 10 NC — Not connected
reset
11  TDO Output 12 VCC — Power supply
13 NC - Not connected 14 VCC — Power supply
15 TCK Input Communication 16 NC — Not connected
clock
17  TMS Input 18 NC — Not connected
19 TDI Input 20 NC — Not connected
21 TRST#® Input 22 NC — Not connected
23 NC — Not connected 24  TRDATA3 Output
25 NC — Not connected 26 TRDATA2  Output
27 NC — Not connected 28 TRDATA1 Output
29 NC — Not connected 30 TRDATAO Output
31 NC — Not connected 32 TRSYNC Output
33 NC — Not connected 34 NC — Not connected
35 NC - Not connected 36 NC — Not connected
37 NC — Not connected 38 NC — Not connected

Notes: 1. These are the names of the MCU pins at the time the E1 or E20 is connected (i.e. during
debugging).
2. Input to or output from the user system.

3. The pins marked with () operate even if they are not connected to the E1 or E20. When the pins
are not connected to the E1 or E20, special circuits for the pins must be configured on the user

system.

4. Securely connect pin 5 and the GND bus lead of the connector to GND on the user system. These
are used as electrical GND and for the E1 or E20 to monitor connection to the user system.

5. The symbol (#) means that the signal is active low.
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2.4 Recommended Circuit between the Connector and the MCU
24.1 Recommended Circuit (14-Pin Connector)

This section shows recommended circuits for connection between the 14-pin connector and the MCU when the E1 or
E20 emulator is in use. For processing of signals, refer to section 2.4.3, Notes on Connection.

(1) JTAG Connection (RX610, RX621, RX62N, RX62T, RX630, RX631 and RX63N Groups)

Figure 2.6 shows a recommended circuit for connection between the 14-pin connector and the RX610, RX621,
RX62N or RX62T Group MCUs in JTAG connection. Figure 2.7 shows a recommended circuit for connection
between the 14-pin connector and the RX630, RX631 or RX63N Group MCUSs.

Notes: 1. Do not use adjacent resistors for pull-up of the TCK pin because they may affect or may be affected from
other pins.

2. Wiring patterns between the connector and the MCU must be as short as possible (within 50 mm is
recommended). Do not connect the signal lines between the connector and MCU to other signal lines.

3. Make the lengths of the signal lines for the JTAG pins (TCK, TMS, and TDI) as uniform as is possible
(keeping the variation within 20 mm is recommended).

4. As guard wiring, include wiring for the GND level around the wiring between the TCK pin of the connector
and the MCU.

5. The wiring run for the TDO pin must be the shortest.

6. For the handling of pins while the E1 or E20 emulator is not in use, refer to the hardware manual for the
MCU.

When writing to the RX610 Group MCUs and RX62T Group MCUs (112-pin
version) using the FDT, be aware that the pin assignments of the 14-pin
connector differ than otherwise. For details on the FDT, refer to
http://www.renesas.com/fdt.
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14-pin Vce  Vcee Vcc  Vcee
2.54-mm pitch 3
connector § §
vee |8
—
Tck H o TCK
—
TRST# |2 TRST#
DO P2 TDO
—
T™s |2 ™S
oI L I
13 P r—
RES# RES#
Pulled-down
at 4.7kQ to 10 kQ
Circuit for
R.ese.t D selection of the
circuit operating mode
Open-collector
- buffer+®
e
MD1 MD1*
No need
to be MDO 10 MDO*2
connected —
EMLE 4 EMLE*Z
2,12,14
- j%
Not 6
connected

Pulled-up at 4.7kQ to 10 kQ

A

r

MCU

Figure 2.6 Recommended Circuit for Connection between the 14-Pin Connector and the RX610, RX621,
RX62N or RX62T Group MCUs in JTAG Connection

Notes: 1. A 4.7-kQ to 10-kQ resistor can be used to pull the TRST# signal up. Note, however, that hot plug-
in will not be available if pulling-up is applied.

2. For processing of signals MDO, MD1, and EMLE, refer to section 2.4.3, Notes on Connection.
3. The output of the reset circuit of the user system must be open collector.
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14-pin Vec  Vce Vce
2.54-mm pitch b
connector § §
vee B
TcK H . TCK
TRST# [ TRST#"
oo Lo E
T™s |2 ™S
DI U TDI
—
RES# 13 RES#
Pulled-down
at 4.7kQ to 10 kQ
Circuit for
R_ese_t D selection of the
circuit operating mode
Open-collector
7 buffer* ]
MD MD*
No need
%
to be ug K9 PC7*
connected I —
EMLE 4 EMLE*?
2,12,14
GND
Not 6 ;
connected X

Pulled-up at 4.7kQ to 10 kQ

A

r

MCU

Figure 2.7 Recommended Circuit for Connection between the 14-Pin Connector and the RX630, RX631 or
RX63N Group MCUs in JTAG Connection

Notes: 1. A 4.7-kQ to 10-kQ resistor can be used to pull the TRST# signal up. Note, however, that hot plug-
in will not be available if pulling-up is applied.

2. For processing of signals MD, PC7, and EMLE, refer to section 2.4.3, Notes on Connection.

3. The output of the reset circuit of the user system must be open collector.

If the hot plug-in facility is to be used, connection to the emulator must be with
the TRST# and EMLE signals for the emulator at the low and high levels,
respectively, when power is supplied to the user system (at the time of a
system reset). Ensure that a ceramic capacitor (approx. 0.1 pF) is installed
between the RES# pin and GND and the TRST# signal is pulled down, and
include circuitry which can switch the EMLE signal to the high or low level.
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(2) FINE Connection (RX630, RX631, RX63N and RX210 Groups)
Figure 2.8 shows a recommended circuit for connection between the 14-pin connector and the RX630, RX631 or
RX63N Group MCUs in FINE connection. Figure 2.9 shows a recommended circuit for connection between the 14-
pin connector and the RX210 Group MCUs.

Notes: 1. Do not use adjacent resistors for pull-up of the FINE pin because they may affect or may be affected from
other pins.

2. Wiring patterns between the connector and the MCU must be as short as possible (within 50 mm is
recommended). Do not connect the signal lines between the connector and MCU to other signal lines.

3. The wiring run for the FINEC and MD/FINED pins must be the shortest.
4. For the handling of pins while the E1 or E20 emulator is not in use, refer to the hardware manual for the

MCU.
Pulled-up at 4.7kQ to 10 kQ
r A N
14-pin vee  Vec  Vee Vee _Vec Ve
2.54-mm pitch
connector
Pulled-up at 4.7kQ
vee 8 MCU
1
FINEC FINEC
]
MDIFINED - [MDFINED_|
5
RXD TxD1*®
no |1 (RO |
]
RESH [ [REst |
Reset Circuit for
. R selection of the
circuit : operating mode
Open-collector
*2
No need us |22 buffer pc7+t
to be
connected EMLE |4 . EMLE*
==
Pulled-down
B at 4.7kQ to 10 kQ
Not 3,6,9
connected —X

Figure 2.8 Recommended Circuit for Connection between the 14-Pin Connector and the RX630, RX631 or
RX63N Group MCUs in FINE Connection

Notes: 1. For processing of signals PC7 and EMLE, refer to section 2.4.3, Notes on Connection.
2. The output of the reset circuit of the user system must be open collector.

3. RxD1 and TxD1 signals are NOT required for debugging. These are only used for internal flash
programming with Renesas Flash Programmer.
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Pulled-up at 4.7kQ to 10 kQ
A
r N
. Vcce
14-pin lci Vcc Vcc  Vcee
2.54-mm pitch
connector
Pulled-up at 4.7kQ
vee B MCU
MD/FINED 7 MD/FINED
RxD |- TxD1*®
1 [oomi1s3 |
TxD RxD1*
.
RES# 13 RES#
Reset Circuit for
. . selection of the
Circuit operating mode
Open-collector
No need 10 buffer* —
to be UB PC7*
connected
2,12,14
GND
Not 1,3,4,6,9
connected —X

Figure 2.9 Recommended Circuit for Connection between the 14-Pin Connector and the RX210 Group MCUs

in FINE Connection

Notes: 1. For processing of signals PC7, refer to section 2.4.3, Notes on Connection.
2. The output of the reset circuit of the user system must be open collector.

3. RxD1 and TxD1 signals are NOT required for debugging. These are only used for internal flash
programming with Renesas Flash Programmer.
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2.4.2 Recommended Circuit (38-Pin Connector)

This section shows a recommended circuit for connection between the 38-pin connector and the MCU when the E1 or
E20 emulator is in use. For processing of signals, refer to section 2.4.3, Notes on Connection.

In FINE connection, use the 38-pin to 14-pin conversion adapter included with the E20 to connect the emulator to the
14-pin connector.

The GND bus lead at the center of the connector must be grounded.

(1) JTAG Connection (RX610, RX621, RX62N, RX62T, RX630, RX631 and RX63N Groups)

Figure 2.10 shows a recommended circuit for connection between the 38-pin connector and the RX610, RX621,
RX62N or RX62T Group MCUs in JTAG connection. Figure 2.11 shows a recommended circuit for connection
between the 38-pin connector and the RX630, RX631 or RX63N Group MCUs.

Notes: 1. Do not use adjacent resistors for pull-up of the TCK pin because they may affect or may be affected from
other pins.
2. Wiring patterns between the connector and the MCU must be as short as possible (within 50 mm is
recommended). Do not connect the signal lines between the connector and MCU to other signal lines.
3. Make the lengths of the signal lines for the JTAG pins (TCK, TMS, and TDI) as uniform as is possible
(keeping the variation within 20 mm is recommended).

4. As guard wiring, include wiring for the GND level around the wiring between the TCK pin of the connector
and the MCU.

5. The wiring run for the TDO pin must be the shortest.

6. The trace signals (TRCLK, TRSYNC, and TRDATAO to TRDATAS3) operate at high speed. Make the
lengths of these signal lines as uniform as is possible (keeping the variation within 10 mm is recommended).
Do not split these signal lines or place other signal lines in the vicinity of these lines. Also do not place any
devices that will produce noise over these lines.

7. As guard wiring, include wiring for the GND level around the wiring between the TRCLK pin of the
connector and the MCU.

8. For the handling of pins while the E1 or E20 emulator is not in use, refer to the hardware manual for the
MCU.
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Pulled-up at 4.7kQ to 10 kQ

Vcec  Vce Vcec  Vce Vee
38-pin , \
connector g é é % é § § % % % ? MCU
vee L1214
 —
TRCLK 2 TRCLK
—_—
TRSYNC 22 TRSYNC
—
TRDATAO 22 TRDATAO
,—l—
TRDATA1 |28 TRDATA1
—
TRDATA2 |28 TRDATA2
————
TRDATA3 |24 TRDATA3
TcK HS TCK
TRST# |21 TRST#"
00 1 N
™s HZ ™S
™ 8 I
9 T —
RES# RES#
Pulled-down
at 4.7kQ to 10 kQ
Circuit f
R.ese.t —D— seletltrt(i::; o?rthe
circuit operating mode
Open-collector
8 buffer*® YT a—
MD1 MD1*
No need 2 Y am—
to be MDO MDO0*2
connected 3
EMLE EMLE*?
GND P2
1, 4 7,10, 13, 16, 18, 20,
22, 23, 25, 27, 29, 31,
Not 33, 34, 35, 36, 37, 38
connected —X

Figure 2.10 Recommended Circuit for Connection between the 38-Pin Connector and the RX610, RX621,
RX62N or RX62T Group MCUs in JTAG Connection

Notes: 1. A 4.7-kQ to 10-kQ resistor can be used to pull the TRST# signal up. Note, however, that hot plug-
in will not be available if pulling-up is applied.

2. For processing of signals MDO, MD1, and EMLE, refer to section 2.4.3, Notes on Connection.
3. The output of the reset circuit of the user system must be open collector.
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38-pin
connector

VCC

TRCLK
TRSYNC
TRDATAO
TRDATA1
TRDATA2
TRDATA3

TCK
TRST#
TDO
T™MS

TDI

RES#

MD

No need
to be uB
connected

EMLE

GND

Not
connected

HEEsrr e

Pulled-up at 4.7kQ to 10 kQ

A

r
Vecc  Vce

Veec  Vce

MCU

[y rayam—
TRCLK

32

| Ekhades
———
TRSYNC

30

L= |
-

28

TRDATAO0

26

—_—
TRDATA1

—_——
TRDATA2

24

L/
e
TRDATA3

/" |

Pulled-down %
at4.7kQ to 10 kQ

Reset
circuit ’

Open-collector

buffer

Circuit for
selection of the
operating mode

2

3

5

1,4,

22,23,25,27,29,31,
33, 34, 35, 36, 37, 38

—X

7,10, 13, 16, 18, 20,

)

Figure 2.11 Recommended Circuit for Connection between the 38-Pin Connector and the RX630, RX631 or

RX63N Group MCUs in JTAG Connection

Notes: 1. A 4.7-kQ to 10-kQ resistor can be used to pull the TRST# signal up. Note, however, that hot plug-
in will not be available if pulling-up is applied.

2. For processing of signals MD, PC7, and EMLE, refer to section 2.4.3, Notes on Connection.
3. The output of the reset circuit of the user system must be open collector.

If the hot plug-in facility is to be used, connection to the emulator must be with
the TRST# and EMLE signals for the emulator at the low and high levels,
respectively, when power is supplied to the user system (at the time of a
system reset). Ensure that a ceramic capacitor (approx. 0.1 pF) is installed
between the RES# pin and GND and the TRST# signal is pulled down, and
include circuitry which can switch the EMLE signal to the high or low level.

R20UTO399EJ0401 Rev.4.01

Jul 01, 2011

RENESAS

Page 25 of 210




E1/E20 Emulator Section 2 Designing the User System

2.4.3 Notes on Connection

(1) About the RES# Pin

The emulator uses the RES# pin. If the user system includes a user logic reset circuit, the output signal from the
reset circuit must be connected to the RES# pin of the connector via an open-collector buffer as shown below. If
there is no reset circuit, on the other hand, the RES# pin of the connector must be directly connected to the RES#

pin of the MCU.

When you use hot plug-in, install a ceramic capacitor (approx. 0.1 uF) between the RES# pin and GND in order to
suppress a noise to the RES# pin that would occur when the emulator is connected.

[When hot plug-in is not used]

- When a reset circuit is included VCC

Open-collector

Connector buffer 4.7kQ to 10 kQ MCU
Reset
circuit
RES# RES#
- When a reset circuit is not included VCC
Connector 4.7kQ to 10 kQ MCuU
RES# RES#
[When hot plug-in is used]
- When a reset circuit is included vee
Open-collector
Connector buffer 4.7kQ to 10 kQ MCu
Reset
circuit
RES# _‘L RES#
j; 0.1uF
- When a reset circuit is not included VCC
Connector 4.7kQ to 10 kQ MCU
e
RES# RES#

l 0.1uF
3

Figure 2.12 Connection of the Reset Circuit (Example)
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(2) About the EMLE Pin
Connection of the EMLE pin to the connector is optional.
Be aware that the processing of the EMLE pin differs depending on the interface.

o JTAG interface
When the emulator is used with the JTAG interface and the emulator is connected, set the EMLE signal to the high
level. When using the MCU without the emulator, set the EMLE signal to the low level.
If hot plug-in is to be used, ensure that the user system includes circuitry for switching the level on the EMLE pin to
the high to low level, and turn the power on with the EMLE signal at the high level.
When the EMLE pins of the emulator and the MCU are connected, since the level on the EMLE pin controls the
emulator, the signal on the user system should be pulled down. When the EMLE pins of the emulator and the MCU
are not connected, set up circuitry on the user system to switch the level on the pin between the high and low levels.

[When connected to the E1 or E20 emulator]

- When hot plug-in is not used

Connector MCU

The E1 or E20 controls the EMLE pin on debugging.
EMLE % EMLE

4.7kQ to 10 kQ

- When hot plug-in is used
VCC

1kQ to3kQ
4.7kQ to 10 kQ
Connector MCU

EMLE
Set the switch to pull the level on the pin up or down
for debugging or stand-alone operation of the MCU,
respectively.
Note: 1. Connecting the pins is not necessary if the emulators do
not control the EMLE pin.

EMLE*

[When not connected to the E1 or E20 emulator]
vCC

4.7kQ to 10 kQ 1kQ to3kQ
Connector MCU

EMLE —X EMLE

Set the switch to pull the level on the pin up or down
for debugging or stand-alone operation of the MCU,
respectively.

Figure 2.13 Connection of the EMLE Pin to the E1 or E20 when Using the JTAG Interface
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e FINE interface

When the emulator is used with the FINE interface and when the emulator is connected, set the EMLE signal to the
low level. Equally, when using the MCU without the emulator, set the EMLE signal to the low level.

Pull the levels on the EMLE pin down at 4.7 kQ to 10 kQ.

[When connected to the E1 or E20 emulator]

Connector MCU
——
EMLE EMLE
4.7kQ to 10 kQ

[When not connected to the E1 or E20 emulator]

Connector MCU

EMLE | X

4.7kQ to 10 kQ

Figure 2.14 Connection of the EMLE Pin to the E1 or E20 when Using the FINE Interface
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(3) About the MODE Pin
When the MODE pins of the emulator and the MCU are connected, it is possible to debug without concern for
MODE pin switching on the target system because the emulator controls the mode pin.
When debugging the RX630, RX631, RX63N, and RX210 Group MCUs, the PC7 signal is fixed to either high or
low. Therefore, the PC7 pin cannot be used as a user port.

Be aware that processing on the target system differs depending on the condition of connections with the emulator
or how the on-chip flash memory is programmed.

Figures 2.16 through 2.18 show the connection diagrams of the MODE pin to the emulator differing with each MCU
group and interface.

e JTAG interface (RX610, RX621, RX62N and RX62T Groups)

[When the E1 or E20 emulator controls the MDO and MD1 pins]

Pull up or pull down the MDO and MD1 signals at 4.7 kQ to 10 kQ according to the operation mode of the MCU
used.

When programming the on-chip flash memory by using the FDT, set the FDT so a low-level signal will be output
from the MD1 pin.

[When the E1 or E20 emulator does not control the MDO or MD1 pins]

Pull up or pull down the MDO0 and MD1 signals at 4.7 kQ to 10 kQ according to the operation mode of the MCU
used.

When programming the on-chip flash memory by using the FDT, pull up the level on the MDO pin, and pull down
the level on the MD1 pin using switches.

When writing to the RX610 Group MCUs and RX62T Group MCUs (112-pin
version) using the FDT, be aware that the pin assignments of the 14-pin
connector differ than otherwise. For details on the FDT, refer to
http://www.renesas.com/fdt.
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[When the E1 or E20 emulator controls the MDO and MD1 pins]

MCU

Connector
Pull up or pull down at 4.7kQ to 10 kQ*'
MDO MDO
Pull up or pull down at 4.7kQ to 10 kQ*'
MD1 MD1

Note: 1. Pull up or pull down the pins according to the operation mode

of the MCU used.

[When the E1 or E20 emulator does not control the MDO and MD1 pins]

MCU

VCC VCC

4.7kQ to 10 kQ L 4.7kQ to
10 kQ

4.7kQ to

4.7kQ to
Connector 10 kQ 10kQ
MDO —x MDO

Mot [ w1

If the internal memory is to be programmed, use switches on the user system to
set the levels on the MDO and MD1 pins to select boot mode. Otherwise, set the
levels on the pins to place the MCU in the required operating mode.

Figure 2.15 Connection of the MODE Pin to the E1 or E20 with JTAG Interface (RX610, RX621, RX62N and

RX62T Groups)
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e JTAG interface (RX630, RX631 and RX63N Groups)

[When the E1 or E20 emulator controls the MD and PC7 pins]

When the emulator controls the MD and PC7 pins, it is possible to debug the user boot mode.

Process the MD and PC7 pins according to the operation mode of the MCU used. Pull up the MD signal at 4.7 kQ or
pull down the signal at 4.7 kQ to 10 kQ. Pull up the PC7 signal or pull down the signal at 4.7 kQ to 10 kQ.

When programming the on-chip flash memory by using the FDT, set the FDT so a high-level signal will be output
from the PC7 pin.

[When the E1 or E20 emulator does not control the MD or PC7 pins]

When the emulator does not control the MD or PC7 pins, it is not possible to debug the user boot mode.

Process the MD and PC7 pins according to the operation mode of the MCU used. Pull up the MD signal at 4.7 kQ or
pull down the signal at 4.7 kQ to 10 kQ. Pull up the PC7 signal or pull down the signal at 4.7 kQ to 10 kQ.

When programming the on-chip flash memory by using the FDT, pull down the MD signal, and pull up the PC7
signal using switches.

[When the E1 or E20 emulator controls the MD and PC7 pins]

Connector

MCU
Pull up at 4.7kQ or pull down at 4.7kQ to 10 kQ**
MD MD
Pull up or pull down at 4.7kQ to 10 kQ**
uB PC7
Note: 1. Pull up or pull down the pins according to the operation mode
of the MCU used.
[When the E1 or E20 emulator does not control the MD and PC7 pins]
VCC VCC
T L
4.7kQ to 4.7kQ
10 kQ
Connector  4.7kQ to 4'752 ktg MCU
10 kQ
MD —x MD
UB L« PC7

If the internal memory is to be programmed, use switches on the user system to
set the levels on the MDO and PC?7 pins to select boot mode. Otherwise, set the
levels on the pins to place the MCU in the required operating mode.

Figure 2.16 Connection of the MODE Pin to the E1 or E20 with JTAG Interface (RX630, RX631 and RX63N
Groups)
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o FINE interface (RX630, RX631, RX63N and RX210 Groups)

[When the E1 or E20 emulator controls the PC7 pin]

When the emulator controls the PC7 pin, it is possible to debug the user boot mode.

Pull up or pull down the PC7 signal at 4.7 kQ to 10 kQ according to the operation mode of the MCU used.
When using the FINE interface, make sure to connect the MD pins of the E1 or E20 and the MCU.

When programming the on-chip flash memory by using the FDT, set the FDT so a high-level signal will be output
from the PC7 pin.

[When the E1 or E20 emulator does not control the PC7 pin]

When the emulator does not control the PC7 pin, it is not possible to debug the user boot mode. When not
debugging the user boot mode, pull down the PC7 signal using a switch.

When using the FINE interface, make sure to connect the MD pins of the E1 or E20 and the MCU.
When programming the on-chip flash memory by using the FDT, pull up PC7 signal using a switch.

[When the E1 or E20 emulator controls the PC7 pin]

Connector MCU

Pull up or pull down at 4.7kQ to 10 kQ*'
UB PC7

Note: 1. Pull up or pull down the pins according to the operation
mode of the MCU used.

[When the E1 or E20 emulator does not control the PC7 pin]

VCC
4.7kQ to
Connector 4.7kQ to %
10 kQ (g 10ka MCU
UB—x PC7

If the internal memory is to be programmed, use switches on the user system to
set the levels on the PC7 pin to select boot mode. Otherwise, set the levels on the
pins to place the MCU in the required operating mode.

Figure 2.17 Connection of the MODE Pin to the E1 or E20 with FINE interface (RX630, RX631, RX63N, and
RX210 Groups)
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(4) About TCK, TDO, TMS and TDI Pins

In JTAG connection, the emulator uses the TCK, TDO, TMS, and TDI pins. Any functions that are multiplexed on
these pins are not available. Pull up the signals on these pins at 4.7 kQ to 10 kQ. The 4.7 kQ to 10 kQ pull-up
resistors are provided to protect the pins when the emulator is not connected.

Connector VvCC
MCU
TCK, 4.7kQ to 10 kQ
TDO,
TMS,
TDI

Figure 2.18 Connection of the TCK, TDO, TMS, and TDI Pins to the E1 or E20

(5) About the TRST# Pin
In JTAG connection, the emulator uses the TRST# pin. Any functions that are multiplexed on this pin are not
available. Pull down the TRST# signal at 4.7 kQ to 10 kQ. The TRST# pin can be pulled up. However, if the
TRST# pin is pulled up, hot plug-in will not be available.

Connector MCU
—
TRST# TRST#

4.7kQ to 10 kQ

Figure 2.19 Connection of the TRST# Pin to the E1 or E20

(6) About the FINEC and MD/FINED Pins

In FINE connection, the emulator uses the FINEC and MD/FINED pins. Any functions that are multiplexed on the
FINEC pin are not available. Pull up the MD/FINED signal at 4.7 kQ. Pull up the FINEC signal at 4.7 kQ to 10 kQ.

VCC vVCC
Connector 4.7kQ MCU
to 10 kQ 4.7kQ
FINEC FINEC
MD/FINED J MD/FINED

Figure 2.20 Connection of the FINEC and MD/FINED Pins to the E1 or E20
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(7) About the TRCLK, TRSYNC, and TRDATAOQ to TRDATAS3 Pins
The TRCLK, TRSYNC, and TRDATAOQ to TRDATAS3 pins are intended for the acquisition of large amounts of

trace data when the E20 is in use with a 38-pin connector. Since these signals operate at high speed, the signal lines

should be as close to uniform in length as is possible. Do not split the signal lines or place other signal lines in the
vicinity of these signals.

Connector vee MCU

TRCLK,
TRSYNC, 4.7kQ to 10 kQ
TRDATAO,
TRDATAA1, R —
TRDATAZ,
TRDATA3

Figure 2.21 Connection of the Trace Pins to the E20
(8) About GND

The pins of the connector marked "GND" must be at the same ground level as the Vss pin of the MCU.

(9) About VCC

Connect the Vcc pin of the connector to the power supply (Vcc) pin of the user system. The input voltage, Vcc, is
within the range of guaranteed operation for the MCU. The E1 is also capable of supplying power (current of up to
200 mA) to simple systems (e.g. for evaluation) that do not have their own power supplies.

Voltage supplied from this product depends on the quality of the USB power
supply of the host machine, and as such, precision is not guaranteed. When
writing a program that requires reliability with this product, do not use the
power supply function of this product. Supply power separately to the user
system according to the allowable voltage for MCU writing.

When writing a program for mass production processes, use the FDT.

For details on the FDT, refer to http://www.renesas.com/fdt.

A WARNING

When supplying power, ensure that there are no shorts between Vcc and
GND. Only connect the E1 or E20 after confirming that there are no
mismatches of alignment on the user system port connector. Incorrect

connection will result in the host machine, the emulator, and the user system
emitting smoke or catching fire.
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(10) Internal Circuits of the E1 Emulator

Figures 2.22 through 2.24 show the internal circuits of the E1 emulator differing with each MCU group in JTAG
connection and FINE connection.

e JTAG connection (RX610, RX621, RX62N, RX62T, RX630, RX631 and RX63N Groups)

User-side connector
100kQ x5

Powe_r-sgpply i vee
circuit | 8
(only for use in |
the mode to | 10kQ
supply power to i
L the user system) | ;
74LV§25 220 Noise filter TCK
1
74LVC125 % nRLis
220
TRST#
= | D * ST
L74LVCBT245 220
TDO
q . * °
74LV§25 4+ 220 Noise filter TMS
MA_] °
74LVC125 % Vol ier
220 Noise filter
> P . e
74LVC125 —+ NFL21SP 220 (EMLE)*1
D 4
@ {74LvC8T245 !
4 + 1100kQ x3
74LVC125 J 220 142
MD1)*"*
Emulator > i ( : !
control 74chsT2454
circuit
74LVC125 220 142
D —+ PR (MDO0) 10
ﬁmwemms—‘ 33V
4 1oom§
L 74LVC125 220
GND
Q 14
3.3V
4700
% DTC142EE
[ha
L |7aLvcsTaa 220 RES#
13
GND
oAWe: 2,12
Self-recovering
777 fuse
6

Figure 2.22 Internal Circuit of the E1 Emulator in JTAG Connection (RX600 Series)

Notes: 1. The signals marked with () operate even if they are not connected to the user system.

2. When using MCUs of RX630, RX631 and RX63N Groups, read “MD1” pin as “MD” pin, and
“MDOQ"pin as “PC7” pin.
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e FINE connection (RX630, RX631 and RX63N Groups)

100kQ x3

User-side connector

i

o We,

Powe_r-st_JppIy VCC
circuit ®
(only for use in
the mode to 10k
supply power to
the user system
74LV§25 @ 220 Noise filter FINEC
NFL21SP
33v
74LVC125 —? 220 (EMLE)*!
‘—MLVCBTZAS—‘
100kQ
74LVC125 220
’ MD/FINED
Emulator > ®
control @ {74LvceT24
circuit
74LVC125 220 1
PC7)*
?—74LVC8T245—$ 3.3V
Q 100kQ
74LVC125 220 GND
33V 4700
% DTC142EE
DTC142EE
L 7aLvcsT24 220 RES#
GND

oy

Self-recovering
fuse

8

10

14

Figure 2.23 Internal Circuit of the E1 Emulator in FINE Connection (RX630, RX631 and RX63N Groups)

Note: 1. The signals marked with () operate even if they are not connected to the user system.

R20UTO399EJ0401 Rev.4.01

Jul 01, 2011

RENESAS

Page 36 of 210




E1/E20 Emulator

Section 2 Designing the User System

e FINE connection (RX210 Group)
100kQ x2
Power-supply
circuit @ VCC 8
(only for use in
the mode to 10kQ
supply power to
L the user system) |
33V
74LVC125 —? 220
Emulator > ® MD/FINED -,
control @ —J74LvC8T245
circuit <
74LVC125 220 1
> ° (BCT)™ 149
?774LV08T245—$ 3.3V
4 100k0%
74LVC125 220
GND
Q 3.3V 14
470Q
% DTC142EE
[ha
DTC142EE|
74LVC8T245 220
4 RES# 13
% eo—CND s 4o
777 7;7- Self—rzf:gering 1‘ 3‘ 4‘ 5
6,9, 1

Figure 2.24 Internal Circuit of the E1 Emulator in FINE Connection (RX210 Group)

Note: 1. The signals marked with () operate even if they are not connected to the user system.

Page 37 of 210

R20UTO399EJ0401 Rev.4.01

Jul 01, 2011

RENESAS



E1/E20 Emulator Section 2 Designing the User System

(11) Internal Circuits of the E20 Emulator

Figures 2.25 through 2.27 show the internal circuits of the E20 emulator when connecting with JTAG interface and

FINE interface.

Also, Figure 2.26 shows the internal circuit of the E20 emulator (tracing circuit section).

e JTAG interface (RX610, RX621, RX62N, RX62T, RX630, RX631 and RX63N Groups)

100kQ x5

User-side connector

VCC

14
10kQ
74LVC125 Noise filter
TCK 15
74LVC125
— 2 ° TRST# 21
L74chaT245—+ 220
” ° ° TDO 1
74LVC125 Noise filter
2 TMS 17
74LVC125 r\?‘;;ez %ﬁ:r
s ° TDI 19
74LVC125 220 (EMLE)*'
3
@ 74LVC8T245 |
q 1100kQ x3
74LVC125 220 1 %2
Emulator > A (e 8
control @ 4LvCsT245
circuit
74LVC125 220 12
2 ® (MDO) 2
kuwcemxs—‘ 33V
< 1001«)%
L 74LVC125 220
GND
4 33V °
470Q
DTC142EE
DTC142EE
74LVC8T24 220 RES# 9
o GND | GND bus
7;7 ot ) lead
eli-recovering
fuse 1

Figure 2.25 Internal Circuits of the E20 Emulator when Connecting with JTAG Interface (RX600 Series)

Notes: 1. The signals marked with () operate even if they are not connected to the user system.
2. When using MCUs of RX630, RX631 and RX63N Groups, read “MD1" pin as “MD” pin, and

“MDQ”pin as “PC7” pin.
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User-side connector

on the user system
interface cable
10kQ x6
Power-supply vee 12
circuit VCC_REF
3.3V
FSNGSLVDS:&SP 220 Noise filter TRC LK
6
NFL18ST
ISN65LVDS33P 220 Noise filter
+ 4 ® TRDATA3 24
NFL18ST
ISN65LVDS33P! 220 Noise filter
+ + Py TRDATA2 26
NFL18ST
ISN65LVDS33P 220 Noise filter
Emulator <] ® TRDATA1 g
control NFL18ST
. . ISN65LVDS33P! 220 Noise filter
circuit ® TRDATAOQ 30
J NFL18ST
ISN65LVDS33P 220 Noise filter
5 TRSYNC 32
NFL18ST
220Q
% 4,7,10,12,13,
16,18,20,21,
22,23,25,27,
29,31,33t038,

Figure 2.26 Internal Circuits of the E20 Emulator when Connecting with JTAG Interface (RX600 Series)
(Tracing Circuit Section)
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e When Connecting with FINE interface (RX630, RX631 and RX63N Groups)

Emulator
control
circuit

100kQ x3

User-side connector

VCC 14
10kQ
74LVC125 ——@ 220 Noise filter
> FINEC 15
NFL21SP
33V
74LVC125 220 EMLE)**
S hd ( U
F?ALVCBTZAS—‘
100kQ
74LVC125 220
> , ® MD/FINED 8
‘774LVC8T245%
<
74LVC125 —A 220 (PC?)*l
L 2
3.3V
100k0%
@ 74LvC125 220
GND 5
33V 470Q
% DTC142EE
DTC142EE
74LVC8T245) 220
RES#
< ‘ 9
GND
oo CGND | pus lead
777 7;7_ Self-recovering
fuse 1,11, 17,
19,21

Figure 2.27 Internal Circuits of the E20 Emulator when Connecting with FINE Interface (RX630, RX631 and

RX63N Groups)

Note: 1. The signals marked with () operate even if they are not connected to the user system.
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(12) Notes on Designing the User System

The E1/E20 emulator does not support JTAG chain connections. When developing user systems, do not connect the
TDI and TDO signals of the device to the boundary scan loop, or separate them by using a switch.

Connector of the

" IC

TDO,

MCU
Emulator
] TDI
TDO ocD
Connector
[ ] TDI TDO TDI
TAP TAP

TDI

D0

TAP

Boundary scan loop

User system

TDI: Test data input
TDO: Test data output
TAP:Test access port

Figure 2.28 Notes on Designing the User System
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(13) About the Small Connector Conversion Adapter for the E1 Emulator

When you use the Small Connector Conversion Adapter for the E1 Emulator (ROEO00010CKZ11) that is separately
available from Renesas, be aware that the connector pin assignments differ from those of the E1 emulator’s standard
interface connector. The 14-pin connector pin assignments when the Small Connector Conversion Adapter for the

E1 Emulator is used are shown in Table 2.8.

Small Connector Conversion Adapter
for the E1 Emulator (ROE000010CKZ11)

User-system interface cable for
the E1 (ROE000010KCEOQ)
/—
A
-

CM@
CN2
14-pin connector on the user
Orientation key system (TFM-107-02-L-D (SMT) or
\ TFM-107-01-L-D (DIP): manufactured
Pin 1 Pin 13

by Samtec, Inc.)

/

User system

Figure 2.29 Usage of the Small Connector Conversion Adapter for the E1 Emulator

Table 2.7 Connector Pin Assignments when Small Connector Conversion Adapter for the E1 Emulator is Used

JTAG interface FINE interface

Pin No.  Signal*** Direction*® Signal*' *2 Direction*>  Note
1 GND** — GND** —
2 (MD1)*® + 110 (MD/FINED)*®*  1/0
3 VCC — VCC — Power supply
4 TCK Input FINEC*® Input
5 RES#< 110 RES#< 110 User system reset
7 (MDO)*® * 110 (PCT7)*® 110
TRST#* Input NC —
TDI Input (RxD1)**° Input
10 TDO Output (TxD1)**° Output
11 (EMLE)*® 110 (EMLE)*® 8 110
12 NC — NC — Not connected
13 T™S Input NC —
14 GND** — GND** —
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Notes: 1. When writing to the RX610 Group MCUs and RX62T Group MCUs (112-pin version) using the
FDT, be aware that the pin assignments of the 14-pin connector differ than otherwise. For details
on how to connect, refer to http://www.renesas.com/fdt.

2. These are the names of the MCU pins at the time the E1 or E20 is connected (i.e. during
debugging).
3. Input to or output from the user system.

4. Securely connect pins 1, 6, and 14 of the connector to GND on the user system. These pins are
used as electrical GND and for the E1 or E20 to monitor connection to the user system.

5. The symbol (#) means that the signal is active low.

6. The pins marked with () operate even if they are not connected to the E1 or E20. When the pins
are not connected to the E1 or E20 special circuits for the pins must be configured on the user
system.

7. When using MCUs of RX630, RX631 and RX63N Groups, read “MD1” pin as “MD” pin, and
“MDQ"pin as “PC7” pin.

8. When using MCUs of RX210 Group, there is no EMLE pin. Read it as “NC” (no connection).

9. When using MCUs of RX210 Group, there is no FINEC pin. Read it as “NC” (no connection).

10. RxD1 and TxD1 signals are NOT required for debugging. These are only used for internal flash
programming with Renesas Flash Programmer.
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Section 3 Preparations for Debugging

3.1 Operating Environment

Make sure to use this emulator in accordance with the operating environments of the host machine shown in Tables 3.1
and 3.2.

Table 3.1 Operating Environment (Windowse XP)

PC Environment

PC IBM PC/AT compatible.

0S Windowse XP 32-bit editions *'**

CPU Pentium 4 running at 1.6 GHz or more recommended.

Interface USB2.0 *

Memory 1 Gbyte plus 10 times the file size of the load module or larger recommended.

Pointing device Mouse or any other pointing device usable with the above OS that can be

such as mouse connected to the host machine.

CD drive Needed to install the emulator debugger or refer to the user’s manual.
Emulator debugger installation needs 600 MB or more free space. (In view of

Hard disk swap area, keep another free space which is more than twice the memory
capacity. (More than four times the memory capacity recommended.))

Display resolution 1024 x 768 or greater recommended.

Table 3.2 Operating Environment (Windows Vistae or Windowse 7)

PC Environment
PC IBM PC/AT compatible.
Windows Vistae 32-bit editions** **

0S Windowse 7 32/64-bit editions**

CPU Pentium 4 runnin_g at 3 GHz or
Core 2 Duo running at 1 GHz or more recommended.

Interface USB2.0**

2 Gbytes plus 10 times the file size of the load module or larger recommended (32-bit
editions).

Memory ) — .
3 Ghytes plus 10 times the file size of the load module or larger recommended (64-bit
editions).

Pointing device Mouse or any other pointing device usable with the above OS that can be

such as mouse connected to the host machine.

CD drive Needed to install the emulator debugger or refer to the user’'s manual.
Emulator debugger installation needs 600 MB or more free space. (In view of

Hard disk swap area, keep another free space which is more than twice the memory
capacity. (More than four times the memory capacity recommended.))

Display resolution 1024 x 768 or higher recommended.

Notes: 1. Windows and Windows Vista are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries. All other company or product names are
the property of their respective owners.

2. Operation with all combinations of host machine, USB device and USB hub is not guaranteed for
the USB interface.

The 64-bit editions of Windowse XP are not supported.

4. The 64-bit editions of Windows Vistae are not supported.

w
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3.2 Activating High-performance Embedded Workshop
To activate the High-performance Embedded Workshop, follow the procedure listed below.

(1) Connect the emulator to the host machine and the user system, then turn on the power for the emulator and the user
system.

(2) Select [Renesas -> High-performance Embedded Workshop -> High-performance Embedded Workshop] from
[Programs] in the [Start] menu.

The [Welcome!] dialog box is displayed.

Welcome!

| * Create a new project work space

Cancel
L

.,-/ | J Adminigtration...

=

j (" Browse to another project workspace

Figure 3.1 [Welcome!] Dialog Box

[Create a new project workspace] radio button: Creates a new workspace.
[Open a recent project workspace] radio button: Uses an existing workspace and displays the history of the

opened workspace.
[Browse to another project workspace] radio button:  Uses an existing workspace.
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3.3 Creating a New Workspace (with a Toolchain not in Use)

The procedures for creating a new project workspace differ according to whether or not a toolchain is in use. This
product does not include a toolchain. You can only use a toolchain in an environment where a C/C++ compiler package

has been installed. Follow the steps below to create a new workspace.

(1) In the [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is activated, select

[Create a new project workspace] radio button and click the [OK] button.

Welcome!

| + Create a new project workspace

r

=2
9

j " Browse o another project workspace

I|

Figure 3.2 [Welcome!] Dialog Box

(2) The Project Generator is started.

New Project Workspace

Projects l

Workzpace Mame:

Project Types
" Debugeer anly - R E1/E

Project Name:

Directary:
|O:¥W0rk8pace Browse...
CPU family:
IR =l
Tool chain:
< 2
Properties...
0K | Cancel

Figure 3.3 [New Project Workspace] Dialog Box

[Workspace Name]: Enter a new workspace name.

[Project Name]:
same as the workspace name.

[Directory]:

Enter a project name. You do not need to enter any name if you wish this to be the

Enter the directory in which you want the workspace to be created. Alternatively,

click on the [Browse] button and select a workspace directory from the dialog box.

[CPU family]:

Select the CPU family of the MCU you are using.
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Other list boxes are used for setting the toolchain; the fixed information is displayed when the toolchain has not been
installed. Click on the [OK] button.

(3) Select the target for debugging.

Setting the Target System for Debugzing

~ Tareets
E1/E20 5YSTEM
[CIRXGE00 E1/E20 SYSTEM

Tareet type : | All Tarests |
Targst GPU:  |AllGPUs ~|

<Back [ Mext> | Finish |  GCancel |

Figure 3.4 [Setting the Target System for Debugging] Dialog Box

Select the checkbox “RX E1/E20 SYSTEM,” which is the target platform for the RX family, and click the [Next]
button.

Note that the checkbox “RX600 E1/E20 SYSTEM” is provided for maintaining compatibility with the earlier versions.
Do not select it.
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(4) Set the configuration file name.

Configuration refers to a file in which information on the state of the High-performance Embedded Workshop for
use with target software rather than emulators is saved.

setting the Debugger Options

Tareet name :
R E1/E20 5%5

Caore :

I(Single core?

Confieuration name :

[Debue_ R E1_E20_SYSTEM

—Detail optionz :

Ttem | Value

I Thitial zes=ion

Next> | Finish |

Cancel

Figure 3.5 [Setting the Debugger Options] Dialog Box

If you have selected two or more target platforms, click on the [Next] button and then set a configuration name for

each of the selected target platforms.

When you have finished setting the configuration names, settings related to the emulator debugger have been

completed.

Click on the [Finish] button, and the [Summary] dialog box will be displayed.
Clicking on the [OK] button in this dialog box starts the High-performance Embedded Workshop.

(5) After starting the High-performance Embedded Workshop, connect the emulator.

R20UTO399EJ0401 Rev.4.01
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34 Creating a New Workspace (with a Toolchain in Use)
Follow the procedure below to create a new workspace.

(1) In the [Welcome!] dialog box, select the [Create a new project workspace] radio button and click on the [OK]
button.

Welcome!

| ¥ Create a new project workspace

Cancel
_.J | J Adrministration...

o}

j (" Browse to another project work space

Figure 3.6 [Welcome!] Dialog Box

(2) The Project Generator is started.

MNew Project Workspace

Projects ]

Praject Types Wiarkzpace Mame:

Application ||
Demonztration Project Mame:
I@ Empty Application |

G Library

7 Debugeer only - R E1/E20 5vg | Directory

|O:¥Work8pace Browze..

GPU family:

IR =l
Taool chain:

|F{enesas R Standard ﬂ

= |
Froperties..
0] .8 I Cancel
Figure 3.7 [New Project Workspace] Dialog Box
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[Workspace Name]: Enter a new workspace name.

[Project Name]: Enter a project name. You do not need to enter any name if you wish this to be the
same as the workspace name.

[Directory]: Enter the directory in which you want the workspace to be created. Alternatively,
click on the [Browse] button and select a workspace directory from the dialog box.

[CPU family]: Select the CPU family of the MCU you are using.

[Tool chain]: To use a toolchain, select the appropriate toolchain here. If you do not use any

toolchain, select [None].

After making these settings, click on the [OK] button.

(3) Set the CPU and options for the toolchain and make other necessary settings.

(4) Select the target for debugging.

Mew Project—8/10-Setting the Target System for Debusging

- Targets :

AE20 SYSTEM
[JR®E00 E1/E20 SYSTEM
[CIRXG00 Simulator

Tareet type : |F'-II Targetz :J
Tareet GPU:  |All GFLs |

<Back [ Mext> |  Finish | Cancel |

Figure 3.8 [New Project —8/10- Setting the Target System for Debugging] Dialog Box

Select the target platform you wish to use by placing a check mark in its checkbox and click on the [Next] button.
To use the debugger, select the checkbox “RX E1/E20 SYSTEM,” which is the target platform for the RX family.
Note that the checkbox “RX600 E1/E20 SYSTEM” is provided for maintaining compatibility with the earlier
versions. Do not select it.
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(5) Set the configuration file name.

New Project—9/10-Setting the Debuzger Options

|<Single corer _V_j

Configuration name :

| Debug_R E1_E20_SYSTEM

— Detail options

Item | Settine |

[ Ihitial sez=ion

Figure 3.9 [New Project —9/10- Setting the Debugger Options] Dialog Box

If you have selected two or more target platforms, click on the [Next] button and then set a configuration name for

each of the selected target platforms.
When you have finished setting the configuration names, settings related to the emulator debugger have been

completed.
Click on the [Finish] button, and the [Summary] dialog box will be displayed. Clicking on the [OK] button in this
dialog box starts the High-performance Embedded Workshop.

(6) After starting the High-performance Embedded Workshop, connect the emulator.
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35 Selecting an Existing Workspace
Follow the procedure below to open an existing workspace.

(1) In the [Welcome!] dialog box, select the [Browse to another project workspace] radio button and click on the [OK]
button.

Welcome!

| " Create a new project work space
Canicel

~

__,./ | J Adrministration. ..

]
j {* Browse o anather project workspace

-

Figure 3.10 [Welcome!] Dialog Box

(2) The [Open Workspace] dialog box is displayed.

Open Workspace

27 JADAFFRT: |Lf}W0rkSpace ﬂ = £ -

| Twtorial

7 BN | Select |
FrTLDFERT:  [HEW Wiorkspaces (% hus) | Cancel

Figure 3.11 [Open Workspace] Dialog Box

Specify the directory in which the workspaces was created, select the workspace file (extension “.hws”), and click
on the Select button.

(3) The High-performance Embedded Workshop will start, and its state will be restored to the state at the time the
selected workspace was saved.
If the emulator was connected at the time, the workspace is automatically connected to the emulator. If the emulator
was not connected but you want to connect it, refer to section 3.6, Connecting the Emulator.
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3.6 Connecting the Emulator

36.1 Connecting the Emulator

The following methods for connecting the emulator are available.

(a) Making the emulator settings in booting-up before connection

Choose [Debug Settings] from the [Debug] menu to open the [Debug Settings] dialog box. In this dialog box, you
can select the target for debugging, and register modules for downloading and a command chain for automatic
execution. When you select the target in the [Debug Settings] dialog box and then click on the [OK] button, the
emulator will be connected.

(b) Loading a session file

Connect the emulator by simply switching the session file to one in which the setting for the emulator use has been
registered.

3.6.2 Reconnecting the Emulator

While the emulator is disconnected, you can reconnect it in one of the ways described below.

e Choose [Connect] from the [Debug] menu.
e Click on the [Connect] toolbar button ([ )).
e Enter the connect command in the [Command Line] window.

3.7 Disconnecting the Emulator

3.7.1 Disconnecting the Emulator

To disconnect the emulator while it is active, do so in one of the ways described below.

. Choose [Disconnect] from the [Debug] menu.
. Click on the [Disconnect] toolbar button (¥]).
° Enter the disconnect command in the [Command Line] window.

3.8 Quitting the High-performance Embedded Workshop

Choosing [Exit] from the [File] menu closes the High-performance Embedded Workshop.
Before it closes, a message box will be displayed asking you whether you want to save the session. To save the session,
click on the [Yes] button.
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3.9 Making Debugging-Related Settings

Register download modules, set up automatic execution of command line batch files, and set download options, etc.

39.1 Specifying a Module for Downloading

Choose [Debug Settings] from the [Debug] menu to open the [Debug Settings] dialog box.

Debug Settings

| DefaultSession x| Tareet ]Options
@ Tutorial
Debug format:
|Elf/Dwarf2 x|
Download modules:
Filename Offzet Address | Format Add...
CifWork Space¥ Tutori.. 00000000 Elf#Dwwarf2
0K | Cancel

Figure 3.12 [Debug Settings] Dialog Box

In the [Target] drop-down list box, select the name of the product you want to connect.
In the [Debug format] drop-down list box, select the format of the load module you want to download. Then register a
module in the selected format in the [Download modules] list box.

Note: At this point in time, no programs have been downloaded yet. For details on how to download a program, refer
to section 5.2, Downloading a Program.
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3.9.2 Setting Up Automatic Execution of Command Line Batch Files

Click on the [Options] page of the dialog box.

Debug Settings EJ g|

|DefauItSession ﬂ Tareet Options l
I@ Totoral Command batch file load timine:
At target connection hd
Command line batch processing:
Add..

v Dizable batch file execution when downloading debug information

Iv Download modules after build

v Remove breakpoints on download

|~ Dizable memory access until after target connection command file execution

[” Limit disassembly memory access
[~ Do not perform automatic target connection
[~ Reset GPU after download module
[~ Digable memaory access by GUI when tareet iz executing

oK | Cancel

Figure 3.13 [Debug Settings] Dialog Box

Here, register a command chain to be automatically executed with the specified timing.
Select your desired timing from among the following four choices:
e When the emulator is connected ([At target connection])

o Immediately before downloading ([Before download of modules])
o Immediately after downloading ([After download of modules])
o Immediately after a reset (JAfter reset])

In the [Command batch file load timing] drop-down list box, select the timing with which you want a command chain to
be executed. Then add the command-batch files you wish to execute to the [Command Line Batch Processing] list box.
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3.10  Procedure for Launching the E1/E20 Emulator Debugger

This section covers how to start up the High-performance Embedded Workshop and check the connection of the
emulator and the MCU on the user system.
Here, use the workspace included as a tutorial for the product.

Take the following steps beforehand.
o Check that the power for the user system is off.

e Connect one end of the user-system interface cable to the user-side connector on the emulator and the other end to
the connector on the user system.
e Connect the emulator and host machine via the USB interface cable.

High-performance Embedded Waorkshop

+
Emulator debugoer

=(9)

User-systemn interface cable /
fwith the 14- or 38-pin connector)

[}

Host machine = LIser system

USB interface cable

E1 or E20 emulatar

Figure 3.14 Configuration for System Check

(1) Open the start menu and select [Programs -> Renesas -> High-performance Embedded Workshop -> High-
performance Embedded Workshop].

(3 accessories
ormance Embedded \ S [ High-performance Embedded Workshop Help

™Y Documents » (3 startup » S Muliple Install Manager High-performance Embed

e Internet Explorer @ Renesas Tools HomeP: -per mbec
% SoHEE * 3 outlock Express =
@ Search » [&] callwalker

W mapview
@ Help (% R Family Simulator Debugger Help
& oun
@ Shut Down...
Start || & =2 “
Figure 3.15 [Start] Menu
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(2) The [Welcome!] dialog box is displayed.

Welcome! E
i |
Create a new project work space
Cancel
N
__.-/ | J Sdrministration...
—
j f* Browse to anather project workspace:

Figure 3.16 [Welcome!] Dialog Box

To use a workspace for the tutorial, select the [Browse to another project workspace] radio button and click on the
[OK] button.

When the [Open Workspace] dialog box is opened, specify the following directory:
<Drive where the OS has been installed>: \WorkSpace\TutoriaN\E1E20\RXxxx\Tutorial_LittleEndian

Here, ‘xxx’ means the target product group.

After the directory has been specified, select the file “Tutorial.hws” and click on the [Select] button.

Open Workspace E]

e LDIBRTD: |12 Tutorial_LittleEndian ~| e @ ef E-
() Tutarial

G Tutarial hws

71 BN | Tutarial s Select |
774 ADFEERIT: |HE'I.I'u' Workspaces (% hwes) ﬂ Cancel

Figure 3.17 [Open Workspace] Dialog Box
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(3) The [Initial Settings] dialog box is displayed.

In this dialog box, make the target MCU-related settings and startup and communication settings.

After setting up each item, click the [OK] button.

For details about the [Initial Settings] dialog box, refer to section 4.3.1, [Initial Settings] Dialog Box.

For hot plug-in, refer to section 5.13, Hot Plug-in Function.

Initial Settings

Device ]Startup and Communication

i+ Debueging made
[~ Hot plug=in

-

Fower zupply

-
o

Communication

MCU eroup: 10 Group
Device: |REFE56108
Mode

Check the following and press OF buttor:
- the emulator iz not connected with the user system.
- the emulator serial Mo. iz displaved.

" Wiriting the on—chip flazh memory mode

Emulator
Serial Mo:

B0 0

ﬂ Befresh

oK | Cancel |

[~ Do not gshow this dialog box again.

Figure 3.18 [Initial Settings] Dialog Box ([Device] Page)

Note: The items shown in the [Initial Settings] dialog box vary with the MCU.
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The following two notes only apply to the E1 (because the E20 is not capable of supplying power to the user
system).
[When the Emulator is to Supply Power to the User System]

If you have not selected the [Power target from the emulator] checkbox and there is no external power supply for the
user system, the following dialog box appears.

Target

Fower on the user system and press OF.

Cancel |

Figure 3.19 Lack of Power Supply

Clicking on the [OK] button opens the [Power Supply] dialog box. Select the checkbox and then specify the power
supply voltage. Click on the [OK] button, and the emulator will start supplying power to the user system.

FPower Supply

[v Poveer Tareet from Emulator. (M&X 900m#a)

Yaoltage zelect
f« 33V -

Figure 3.20 [Power Supply] Dialog Box

[When an External Power Supply is Used to Supply Power to the User System]

If you have selected the [Power target from the emulator] checkbox and an external power supply is supplying
power to the user system, the following dialog box appears.

Target rg|

The power supply to a uzer system was detected. Pleaze remove the check for the power supply from the power supply setting.

Figure 3.21 External Power for the User System Dialog Box
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Clicking on the [OK] button opens the [Power Supply] dialog box. Deselect the [Power Target from
Emulator]checkbox and click on the [OK] button to stop the emulator supplying power to the user system.

FPower Supply

[ Poveer Tareet from Emulator. (MaX 900m#a)

Yaoltage zelect
{+ {

O | Cancel |

Figure 3.22 [Power Supply] Dialog Box

(4) Clicking on the [OK] button on the [Initial Settings] dialog box opens the [Connecting...] dialog box.

Trace Contral FPGA Version 14 A~
zer WO 328
IUSE Bus Power 479 W
Target Board COMMECTED
lUger IF Cable 38 pin cable

Setting of debugeing information.

Setting of JTAG clock.

Setting of JTAG clock.

JTHRG Clock 165 MHz
Connecting to MCL..

w
v Cloze the dialog box when the connection is completed.
Figure 3.23 [Connecting...] Dialog Box
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(5) When updating of the emulator firmware is required, the [Confirm Firmware] dialog box appears.
Clicking on the [OK] button starts updating of the emulator firmware. Once started, you cannot cancel the updating.

Gonfirm Firmware &l

It iz neceszary to download the emulatar firmware.
Do wou wish to download it now?

Current wersion:
PRI R

Expected werszion:
VARARA RS

Mo |

Figure 3.24 [Confirm Firmware] Dialog Box

The [Downloading] progress bar is displayed during the process of updating. Booting-up of the emulator resumes
after the firmware has been updated.

Do not dizconnect the USE until updating iz complete.
If vou are using the E20, do not turn the power off.

|
E0%

Figure 3.25 [Downloading] Progress Bar

CAUTION

The USB interface cable must not be disconnected until writing is
complete. Early disconnection may damage the emulator.
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(6) If an ID code has been set in the target MCU’s on-chip flash memory, the [ID Code verification] dialog box appears.
Enter the ID code and click on the [OK] button.

ID CGode verification El

Pleaze input the ID code being written in the flash memary.

ID Code: |

Ihput Mode
(* Hex : Specify ID code by hexadecimal 32 digits.

" ASCT : Specify ID code by ASCI character within 16 letters.

QF | Cancel |

Figure 3.26 [ID Code verification] Dialog Box

(7) The [Configuration Properties] dialog box appears.

Settings related to emulator operation and debugging are made in this dialog box. After setting up each item, click
the [OK] button.

For details about the [Configuration Properties] dialog box, refer to section 4.3.2, [Configuration Properties] Dialog
Box.

Internal flash memory overnrite ] External flazh memory

Tl L Svztem

Gonfiguration Properties E
|
l

Dperating mode

Mode: |

Endiar: |

L] L

EXTAL Frequency: [12 5000 hiHz

External memory areaz

firea | Endian | BUS 'Width |

Whiting internal flazh memory by the emulator debueger

v Allow to chanee the clock zource on writing internal
flagh memory.

iark, BAM ztart address
(0400 bytes uged): 13000

oF | Cancel |

[ Do not show this dialoe box again.

Figure 3.27 [Configuration Properties] Dialog Box ([MCU] Page)

Note: The items shown in the [Configuration Properties] dialog box vary with the MCU.
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(8) When "Connected" is displayed in the [Output] window of the High-performance Embedded Workshop, the
emulator initiation is completed.

If any other message is displayed in the [Output] window, see Table 3.3.

x|
I

&7 =

Mormal

Connect ed

i Build }-.Dehug I.-'-r.I Find in Files 1 I.}'-.I Find in Files 2 ."'"'. Macro ;'".ITESt .}'u

Note:

Figure 3.28 [Output] Window

When the user program has already been downloaded to the flash memory, source-level debugging is not

possible because there is no debugging information on the user program after the emulator has been activated.
To perform source-level debugging, download a load-module file that includes debugging information after the
emulator has been activated.

Table 3.3 Error Messages in the [Output] Window

Error Message

Description

The version of LEVELO is not
corresponding to the debugger.

To use the emulator, the current debugger software needs to
be updated. Download the updated version from our website.

The device ID code does not
match the one for the selected
device. Please check the device
name.

The MCU name selected in the [Initial Settings] dialog box
does not match the actual MCU in use. Check the MCU name
again.

The power voltage has exceeded
5.9V. Please check the user
system setting.

The voltage being supplied to the user system may be greater
than the defined limit. Check the user-system settings.

A JTAG communication error.
Please retry with reducing the
JTAG clock.

Check the followings:

- The connection of the user-system interface cable may be
incorrect.

- The connection of the MCU pins may be incorrect.
- The JTAG frequency may be too high or low.

Failed to communicate with the
mcu because its source clock of
serial communication is changed.
Please retry with the baud rate
reduced.

Check the followings:

- The connection of the user-system interface cable may be
incorrect.

- The connection of the MCU pins may be incorrect.
- The FINE baud rate may be too high or low.
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Section 4 Software Specifications

4.1 Specifications of the E1 and E20 Emulators

Table 4.1 lists specifications of the E1 and E20 emulators that apply when you’re using the RX610, RX621, RX62N,
RX62T, RX630, RX631, or RX63N Group. Table 4.2 lists specifications of the E1 and E20 emulators that apply when
you’re using the RX210 Group.

Note that the number of events you can set, as well as the set conditions for the on-chip break, trace and performance
functions vary with the target MCU. Functional specifications differing with each MCU series are summarized in Table
4.3.

Table 4.1 Specifications of the E1 and E20 Emulators for the RX610, RX621, RX62N, RX62T, RX630, RX631
and RX63N Groups

Item El E20

Target MCUs RX Family, RX600 Series «
RX610, RX621, RX62N, RX62T,
RX630, RX631 and RX63N Groups

Target operation Single chip mode, on-chip ROM enabled extended «
mode*! mode, on-chip ROM disabled extended mode, and
user boot mode
S/W break Maximum of 256 points “—
Events Number of events*? Execution address: 8 points <«
(access by the DMAC Data access: 4 points
or DTC is not Number of passes*®>  Maximum of 256 “—
detectable)
On-chip breakpoints Pre-PC break*? Maximum of 8 points «
Combination of OR, AND (cumulative), or <«
events* sequential
Other Trace full break «—
Trace Internal trace e Internal trace
(access by the DMAC  (acquisition of information on branches and data (acquisition of information on
or DTC is not access for up to 256 branches or cycles) branches and data access for up to
traceable) 256 branches or cycles)

e External trace output
(branch information on approx. 2M
jumps or cycles and data access
information acquired)
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Table 4.1 Specifications of the E1 and E20 Emulators for the RX610, RX621, RX62N, RX62T, RX630, RX631

and RX63N Groups (cont)

Iltem El E20
Performance Numbers of cycles for execution for up to two sections <«
measurement or number of times executed
(32-bit counter x 2 or 64-bit counter x 1)
Realtime RAM monitor None 4 Kbytes (1 Kbyte x 4 blocks)

(access by the DMAC
or DTC cannot be

Displays a history of data access
through reading and writing

monitored)

Debug console Displays printf output in an output window «—
User interface 14-pin connector 38-pin connector or 14-pin connector**
Interface with host USB2.0 (full speed or high speed)*5 “—
machine

Connection to the user Connection by the provided user-system interface “—
system cable

Power supply forthe  No need (the host machine supplies power through «—
emulator the USB)

Power supply 3.3V or5.0V can be supplied to the user system None
function*® (with current up to 200 mA)

Downloading to Available «

external flash memory

Hot plug-in*’ *® Available «
Communication JTAG, FINE “«—
interface*® *'°

Notes: 1. The RX62T Group supports only the single-chip mode.

2.

3.
4.

Events are common for on-chip breakpoints and tracing. A given event cannot be used in more
than one capacity at the same time.

Number of passes can be specified for any single event.

If the external trace-output and realtime RAM monitoring functions are not in use, the 14-pin
connector can be used to connect the E20 emulator. In this case, the 38-pin to 14-pin conversion
adapter is required.

Connection to the host machine via USB1.1 is also possible.

Do not use the power-supply function of the E1 emulator when it is being used to write a program
that requires reliability. Separately supply power to the user system in accord with the
specifications of the MCU. When writing a program for mass production processes, use the FDT.
To use the hot plug-in function with the E1 emulator, please purchase the separately available
hot-plug adapter (ROEOO0010ACBOQO0).

The hot plug-in function via FINE interface is not supported.

The usable interface differs with each target MCU. For details about the interface, refer to the
hardware manual for the MCU you're using. Note that the RX610, RX621, RX62N, and RX62T
Groups cannot use the FINE interface.

10. FINE interface is supported only for 2-wire system using FINEC and MD/FINED pins.
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Table 4.2 Specifications of the E1 and E20 Emulators for the RX210 Group

Item E1l E20
Target MCUs RX Family, RX600 Series «
RX210 Group

Target operation mode Single chip mode, on-chip ROM enabled extended mode, on-chip  «
ROM disabled extended mode, and user boot mode

S/W break Maximum of 256 points «—

Events Number of events** Execution address: 4 points «—

(access by the DMAC or DTC is not Data access: 2 points

detectable) Number of passes None “«

On-chip breakpoints Pre-PC break** Maximum of 4 points <«
Combination of events*®  OR, AND (cumulative), or sequential «
Other Trace full break «

Trace Internal trace <«

(access by the DMAC or DTC is not  (acquisition of information on branches and data access

traceable) for up to 64 branches or cycles)

Performance measurement Numbers of cycles for execution for one section «
(24-bit counter x 1)

Realtime RAM monitor (access by ~ None «—

the DMAC or DTC cannot be

monitored)

Debug console Displays printf output in an output window «

User interface 14-pin connector «

Interface with host machine USB2.0 (full speed or high speed)*2 «—

Connection to the user system Connection by the provided user-system interface cable «—

Power supply for the emulator No need (the host machine supplies power through the USB) «—

Power supply function*® 3.3V or5.0V can be supplied to the user system None
(with current up to 200 mA)

Downloading to external flash Available «

memory

Hot plug-in None «—

Communication interface*® FINE «—

Notes: 1. Events are common for on-chip breakpoints and tracing. A given event cannot be used in more

than one capacity at the same time.

2. Connection to the host machine via USB1.1 is also possible.

3. Do not use the power-supply function of the E1 emulator when it is being used to write a program
that requires reliability. Separately supply power to the user system in accord with the
specifications of the MCU. When writing a program for mass production processes, use the FDT.

4. The 38-pin to 14-pin conversion adapter is required to use the E20 emulator.

5. FINE interface is supported for 1-wire system using MD/FINED pin.
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Table 4.3 List of Functional Specifications by Target MCU

Function item

RX600 Series MCUs

RX200 Series MCUs

Event
Detection Target CPU bus only “—
Execution No. of points set 8 points 4 points
address
Data access No. of points set 4 points 2 points
Detection Address condition specification: Address condition specification:
condition Address mask, Compare condition, Address mask, Compare condition,

Address range (1 point only)

Data condition specification:
Read/Write, Access size, Data mask,
Compare condition

Data condition specification:
Read/Write, Access size, Data
mask, Compare condition

during program execution

Pass count condition Available (1 point only) None
Combination Condition OR, AND (cumulative), or Sequential «
of events No. of points set  OR, AND (cumulative): OR, AND (cumulative):
Maximum of 8 points Maximum of 6 points
Sequential: Sequential:
7 steps (forward direction) + reset 3 steps (forward direction) + reset
point point
Trace
Detection Target CPU bus only «
Display mode BUS, DIS, SRC (mixed display possible)  «
External trace  Trace capacity Selectable from 1, 2, 4, 8, 16 and 32 None
Mbytes
Trace full break Available None
Trace operation Get trace, stop temporarily or restart None

Internal trace Trace capacity

Maximum of 256 branches

Maximum of 64 branches

Trace full break Available Available
Trace operation None None
Trace mode Fill until full, Fill until stop <«

Trace output

CPU execution priority, Trace output
priority, Do not output (internal trace
buffer used)

Do not output (internal trace buffer
used)

Trace type Branch, Branch + Data, Data Branch(Src), Branch,
Branch(Src) + Time, Data,
Data + Time
Trace data Condition Combinatorial [OR] of data access “—
extraction events
Advanced setting Access extraction setting None
Exception, FPU, Bit operation,
Logical operation, Arithmetical
operation, String operation, Stack
operation, Data transfer
Start condition Start trace acquisition by event «—
combination [OR /AND (cumulative) /
sequential]
Stop condition Terminate trace acquisition by event «—

combination [OR]
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Table 4.3 List of Functional Specifications by Target MCU (cont)

Function item

RX600 Series MCUs

RX200 Series MCUs

Performance

Counter clock

ICLK

<«—

Counter channels

2 channels (32 bit) or 1 channel (64 bit)

1 channel (24 bit)

Measurement item

Execution cycle,

Execution cycle (supervisor mode),
Exception and interrupt cycle,
Exception cycle, Interrupt cycle,
Execution count,

Exception and interrupt count,
Exception count, Interrupt count,
Event match count

Execution cycle

Display cycles as time span Available “—
Measure performance only once Available «
Add events from function Available <«
information

64-bit counter Available None
Start condition Start performance by event combination <«

(OR)
Stop condition Start performance by event combination <«

(OR)
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4.2 Differences between the MCU and the Emulator

(1) When the emulator system is initiated, it initializes the general registers and part of the control registers as shown in
Table 4.4. The initial values of the MCU are undefined.

Table 4.4 Register Initial Values at Emulator Link Up

Register Emulator at Link Up
RO (SP) 00000000h

R1 to R15 00000000h

USP 00000000h

ISP 00000000h

PSW 00000000h

PC Value of the SP in the power-on reset vector table
INTB 00000000h

BPSW 00000000h

FINTV 00000000h

FPSW* 00000100h

Acc™ 00000000h

Notes: 1. Bits 15to 0 in the ACC register are always read as 0. Attempts at writing to those bits will be ignored.
2. The RX210 Group MCUs do not have the floating point status word (FPSW).

Notes: If register values are changed in the [Register] window, it is immediately before the user program starts running
that the changes are actually reflected in the registers. The same applies when the REGISTER_SET command is
used to change register values.

If, after register values are changed in the [Register] window or with the REGISTER_SET command, the CPU
is reset without executing the user program even once, the changed register values have no effect.

(2) Low-Power States

When the emulator is used, release from power-down modes can be accomplished by a source for release or by
pressing the [STOP] button, causing a break to occur.

(3) Reset Signals

If, while the user program remains halted, a reset is asserted by means of a pin reset, the reset signal is masked off
during a JTAG connection. Note, however, that during a FINE connection, it is not masked and the MCU is reset.

Note: Do not break the user program when the RES#, or WAIT# signal is being low. A TIMEOUT error will
occur. If the WAIT# signal is fixed to low during break, a TIMEOUT error will occur at memory access.

(4) Direct Memory Access Controller (DMAC)

The DMAC operates even during breaks in execution. Therefore, when a data transfer request is generated, the
DMAC executes DMA transfer. Also, refer to section 7.19.2, DMAC and DTC.

(5) Using WDT
Counting by the watchdog timer is suspended during breaks in execution. When execution of the user program is
restarted, the counting is also resumed.
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(6) Contention between Clock Generator Circuit-Related Register Modifications and Debug Functions

Do not change the values of clock generator circuit-related registers while the user program is under execution. For
details about the clock generator circuit-related registers, refer to the hardware manual for the MCU you’re using.

(7) Occupancy of User Pins
Due to the following pin functions being multiplexed with pin functions for a user port, the user port is not available
to the user during debugging. See the user manual for the MCU regarding multiplexing of pins for user ports.
e TRST#
e TCK
e TMS
e TDI
e TDO
e FINEC

Note that the RX621and RX62N Group MCUs have such a characteristic that when its TDO-assigned pin is set for
open-drain output, the pin becomes an open-drain output even though it is used as TDO. Therefore, do not set P26
for open-drain output during debugging.

When the E20 emulator is connected to the user system via the 38-pin connector, the following pins cannot be used.
The pins can be used for their user-port functions when the 38-pin to 14-pin conversion adapter is in use.

e TRCLK

e TRSYNC

e TRDATA[3:0]

(8) Notes on Maskable Interrupts

e Even if a user program is not being executed (including when run-time debugging is being performed), timers
and other peripherals do not stop running. If a maskable interrupt is requested when the user program is not
being executed (including when runtime debugging is being performed), the maskable interrupt request cannot
be accepted, because the emulator disables interrupts. The interrupt request is accepted immediately after the
user program execution is started.

o Take note that when the user program is not being executed (including when run-time debugging is being
performed), a peripheral /O interruption is not accepted.
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4.3 Setting up the Debugger

On booting-up the emulator, the [Initial Settings] and [Configuration Properties] dialog boxes will open. Here, select the
general options associated with the emulator. Note that the target MCU to be debugged, etc. can only be set once each
time the emulator is booted-up.

431 [Initial Settings] Dialog Box

This dialog box is used to set the target MCU. The settings remain valid the next time the emulator is booted up (except
for the hot plug-in and the power-supply setting).

This dialog box can be re-opened by selecting [Setup -> Emulator -> Device setting] after the emulator has been booted
up. Note, however, that settings cannot be changed after booting-up.

(1) Making Settings Related to the Emulator and the Target MCUs

On the [Device] page of the [Initial Settings] dialog box, specify the target MCU to be emulated and the emulation
mode.

Initial Settings ﬁl

Device lStartup and Communication ]

MGLI Eroup: 10 [:irl:ll_l;l
Dexvice: | RGFE6108 =
Mode

(« Debueging mode
[~ Hot plug=in )
Check the following and press OF button:
= the emulatar is not connected with the uzer system.
- the emulatar zerial Mo, iz dizplayved.

" Wiiting the an—chip flazh memary made
[

Power supply

m
fo "

Communication

E mulatar

Serial Mo; | B2 KKK ~|  Befresh

Ok I Cancel |

[ Do not zhow thiz dialog box again.

Figure 4.1 [Initial Settings] Dialog Box ([Device] Page)

Note: The items shown in the [Initial Settings] dialog box vary with the MCU.

The target MCU you have set here cannot be changed after the emulator is booted up.
To change the target MCU, you need to cancel the process of booting-up and then reboot the emulator.
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(a) Selecting the Target MCU

Select the target MCU you want to emulate. First choose the target group from the [MCU group] pulldown menu
and then the type name of the target MCU from the [Device] pulldown menu.
Note that the target MCUs you can select in the E1/E20 emulator debugger for the RX family are listed below.

Table 4.5 List of Target MCUs

MCU group Device name Communication interface
RX210 Group R5F52105, R5F52106, R5F52107, R5F52108 FINE
RX610 Group R5F56104, R5F56106, R5F56107, R5F56108 JTAG

RX621 Group R5F56216, R5F56217, R5F56218 JTAG
RX62N Group R5F562N7, R5F562N8 JTAG
RX62T Group R5F562T6, R5F562T7, R5F562TA JTAG
RX630 Group  R5F56307, R5F56308, 5F5630D, R5F5630E  JTAG, FINE
RX631 Group R5F5631A, R5F5631B JTAG, FINE
RX63N Group R5F563NA, R5F563NB JTAG, FINE

(b) Selecting a Mode of Operation

Select the emulation mode from the options below.
[Debugging mode] or [Writing the on-chip flash memory mode].

[Debugging mode]
Select this mode to use the emulator as a debugger.

After a program has been downloaded, you cannot disconnect the emulator and operate the user system as a
stand-alone unit. Writing of ID codes (intended to prohibit reading of the on-chip flash memory) to the on-chip
flash memory is not possible in this mode.

o Select hot plug-in.

When the [Hot plug-in] checkbox is checked, it is possible to start debugging from the middle of user program
execution. For details about hot plug-in, refer to section 5.13, Hot Plug-in Function.

[Writing the on-chip flash memory mode]
Select this mode to use the emulator as a flash-memory programmer.

Using the emulator for debugging is not possible in this mode. After a program has been downloaded, an 1D
code (intended to prohibit reading of the on-chip flash memory) is written to the on-chip flash memory.

Note that the checksum shows a value derived by adding up in bytes the whole data in three divided areas.
e Data flash area
e User boot area
e Program ROM area
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(c) Selecting Whether or Not to Supply Power from the Emulator

Specify the method for supplying the power from the E1 emulator to the user system. To supply the power from
the E1 emulator to the user system, check the [Power target from the emulator. (MAX 200mA)] checkbox and
then select [3.3V] or [5.0V].

Note that the selectable power supply voltages vary with each target MCU. For details about the operating
voltage of your MCU, refer to the hardware manual supplied with it.

Note also that this option is not selectable for the E20 because it isn’t capable of supplying power to the user
system.

Voltage supplied from this product depends on the quality of the USB power
supply of the host machine, and as such, precision is not guaranteed. When
writing a program that requires reliability with this product, do not use the
power supply function of this product. Supply power separately to the user
system according to the allowable voltage for MCU writing.

When writing a program for mass production processes, use the FDT.

For details on the FDT, refer to http://www.renesas.com/fdt.

(d) Setting up Communications
You can select another target emulator for connection via USB.

The [Emulator Serial No.] list box shows unique identifying information on the emulator connected via USB.
Clicking on the [Refresh] button updates the information.
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(2)  Selecting the mode pin setting

In [Startup and Communication] page of the [Initial Settings] dialog box, make settings of the operation mode for the
target MCU you have selected, and the communication interface.

Initial Settines X
Device Startup and Communication ]
Operating Mode
Mode Pin Settine: sinele—chip mode
Beeizter Setting: |Sing|e—chip mode j
Endiarn: | J
Communication
v JTAG Clock: 165 | MHz
o I
’T‘ Cancel |
[~ Do nat show this dialog box again.

Figure 4.2 [Initial Settings] Dialog Box ([Startup and Communication] Page)

The settings you have made here cannot be changed after the emulator is booted up.
To change the communication information, you need to cancel the process of booting-up and then reboot the emulator.

(a) Selecting the Mode Pin Setting

Select the operation mode based on mode pins from the options below. Be sure to select one that matches the pin
state of your system. The selectable option differs with each target MCU.
[Single-chip mode], [User boot mode]

(b) Selecting the Register Setting

Select the option mode based on register settings from the options below. Be sure to select one that matches the
operation mode that is set in the user program after startup. The selectable option differs with each target MCU.
[Single-chip mode], [On-chip ROM enabled extended mode], [On-chip ROM disabled extended mode]

(c) Selecting the Endian

Select the endian from the options below. Note that if the target MCU you selected is a type that has the MDE
pin, the options are grayed out and a remark “Depends on the user system” is displayed.
[Little endian], [Big endian]
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(d) Selecting the Interface
Select the communication interface from the options below. Be sure to select one that matches your user system.
The selectable option differs with each target MCU. Refer to Table 4.5, List of Target MCUSs.
[JTAG Clock], [FINE Baud Rate]

[JTAG Clock]

If the radio button for the JTAG clock is checked, it is possible to set the JTAG communication speed " between
the emulator and the user system. Select one from the options below (unit: MHz).

[16.5], [12.38], [6.188], [3.094], [1.547]

Note: Depending on the wired length of the JTAG signal and how it is wired on the user system, communication at
the selected frequency of the JTAG clock may not be performed. Reducing this frequency may help to solve
the problem.

[FINE Baud Rate]

If the radio button for the FINE baud rate is checked, it is possible to set the FINE communication speed N
between the emulator and the user system. Select one from the options below (unit: bps).

[2000000], [750000], [500000], [250000]

Note: Depending on the wired length of the FINE signal and how it is wired on the user system, communication at
the selected baud rate may not be performed. Reducing this baud rate may help to solve the problem.
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432 [Configuration Properties] Dialog Box

This dialog box is used to make settings related to the emulator and debugging functions. The settings remain valid the
next time the emulator is booted up.

This dialog box can be re-opened by selecting [Setup -> Emulator -> System] after the emulator has been booted up.
Settings for certain options in this dialog box can be changed after booting-up.

Those that can be changed are active while those that cannot are inactive (grayed out), but with their settings displayed.

(1) Setting Up the Emulator and Debugging Functions

On the [MCU] page of the [Configuration Properties] dialog box, make settings associated with the target MCU.
The [Configuration Properties] dialog box appears after the [Initial Settings] dialog box.

Gonfizuration Properties &l
Internal flash memory overwrite ] External flash memory ]
MGU ] System |

Operating mode

Miode: | J
Endian: | J
EXTAL Frequency: 128000 MHz

External memaory areas

firea | Endian | BUS Wwidth |

Witing internal flazsh memory by the emulator debugeer

v Allow to change the clock source on writing internal
flazh memaory.

‘Wiork, BAM start address
(0400 bytes used) |2000

[o]4 | Cancel |

[ Do not show this dialog box again.

Figure 4.3 [Configuration Properties] Dialog Box ([MCU] Page)

Note: The items shown in the [Configuration Properties] dialog box vary with the MCU.

(a) Displaying the Operation Mode
An operation mode for the register setting you’ve selected on the [Startup and Communication] page of the
[Initial Settings] dialog box is displayed.

(b) Displaying the Endian
Information on the endian setting you’ve selected on the [Startup and Communication] page of the [Initial
Settings] dialog box is displayed.
Note that if the target MCU you selected is a type that has the MDE pin, the emulator reads out the user system’s
pin state and displays the retrieved information on endian setting.
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(c) Selecting the EXTAL Frequency
Specify the frequency of the clock source for supply to the target MCU.
The range of input values is 0.0001 to 99.9999. If any value exceeding this range is input, an error message is
displayed.
Note that fractions of the input value below the 5th decimal point are truncated.
Also, if you use only the internal clock oscillation, there is no need to input the EXTAL frequency. In this case,
uncheck the [EXTAL frequency] checkbox. Note that if the selected target MCU has no internal clock
oscillations installed, this checkbox is not displayed.

Cperating mode

fode: | J
Endiar: | J
ERTAL Frequency: 125000 MHz

Figure 4.4 Setting the Operating Mode of the MCU

(d) Selecting the External Memory Areas
Select the endian and bus width for external memory areas.
This setting is possible when the operation mode you selected by register setting is the on-chip ROM enabled
extended mode or on-chip ROM disabled extended mode.
Double-clicking on a row for which settings are to be changed opens the [External Area] dialog box shown
below.

e For the endian setting, select one from the following options:
[Same endian as the MCU] or [Different endian from the MCU]
o For the bus width setting, select one from the following options:
RX610 and RX210 Group MCUSs: [8 bit] or [16 bit]
RX621, RX62N, RX630, RX631 and RX63N Group MCUs: [8 bit], [16 bit], or [32 bit]

Note that the external memory area differ with each target MCU. For details about the external area of your MCU,
refer to the hardware manual supplied with it.

External memory areas

&... | Endian |
C51 Same endian as the MCLU
G52 Same endian as the MCLU
G533 Same endian as the MCLU

External Area

G54 Same endian az the MGCU
G55 Same endian az the MGU
NRA Same endian Aas the WG

Endiar: same endian as the MCL

ooo o oo oo |m

Bus Width: 8 bit |

Figure 4.5 Setting the External Area
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(e) Enabling Clock Manipulation
Clock manipulation from the emulator is enabled when you rewrite the internal flash memory.
If, when this checkbox is checked, the clock setting at the time of internal flash memory rewriting is outside the
operation-guaranteed range of the target MCU, the emulator changes clock settings to within the operation-
guaranteed range as it performs rewriting.
Be aware, however, that if this checkbox is unchecked, the internal flash memory may not be rewritten normally,
depending on clock settings.

(f) Specifying the Address of Working RAM

Specify the first address of the working RAM area for use by the debugger.

The specified amount of bytes in use beginning with the specified location address of the working RAM is used by
the emulator-debugger firmware. Although the user program can also use this area (because memory data in this
area will be saved in the host machine and then restored), do not specify any address in this area as the origin or
destination of a transfer by the DMA or DTC.

ititing internal flazh memory by the emulator debugeer

v Bllow to chanege the clock source on writing internal
flazh memory.

Wiork, BAM start address
(0400 bytes used): 13000

Figure 4.6 [Allow to change the clock source on writing internal flash memory] Checkbox
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(2) Setting Up the System

On the [System] page of the [Configuration Properties] dialog box, specify the configuration of the emulator system as

a whole.

Configuration Properties

MCU

Switching function

" Realtime BEAM monitor

Debue function

RO,

L FLaSH.

Internal flash memory overwrite ]

r Debugeing the program re—writing the internal PROGRAM

Debugeing the program re—writing the internal DATA

X

External flazh memaory ]
Svstem

o |

[ Do not show thizs dialog box again.

Cancel |

Figure 4.7 [Configuration Properties] Dialog Box ([System] Page)

(a) Selecting an Exclusive Function

Tracing and realtime RAM monitoring are mutually exclusive. Select either of the two functions.

The [Trace conditions] checkbox is selected by default.

Note that when you're using the E1 emulator, you cannot select the realtime RAM monitor function. (The checkbox

is grayed out.)

(b) Using the Debug Function

e Debugging the program re-writing the internal PROGRAM ROM
Check this checkbox when you debug the program that rewrites the internal program ROM area.

e Debugging the program re-writing the internal DATA FLASH
Check this checkbox when you debug the program that rewrites the internal data flash area.
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(3) Setting for Overwriting Blocks of the Flash ROM

The [Internal flash memory overwrite] page of the [Configuration Properties] dialog box allows you to specify
whether or not flash ROM should be overwritten.

Even after startup, you can open this dialog box and change the setting by selecting [Setup -> Emulator -> System].

Configuration Properties E|
Mz ] Svatem ]
Internal flazh memory overnrite l External flash memory ]

Start Address End Address

Delete

#idd address ranges which are over—written oh downloading. If the
download data does not overlap, the criginal values of the specified
area are kept, and the values of not-specified area are just erazed.

0] % | Cancel |

[ Do not show this dialoe box azain.

Figure 4.8 [Configuration Properties] Dialog Box ([Internal flash memory overwrite] Page)

Specify the address range of the internal flash memory for registration.

Up to 4 ranges can be specified.

If the specified area has no data to download, the original values before download are kept.

If the non-specified area has no data to download, it retains the initial values of the flash memory.

(a) Registering the Overwriting Range in the Internal Flash Memory
Clicking the [Add...] button opens the [Address Range] dialog box. Enter the range and click the [OK] button.
Information of the specified range is displayed in the list.
The address range you have entered is automatically expanded to the block boundary and reflected in the list.

Furthermore, if you’ve set the operation mode to “User boot mode” on the [Startup and Communication] page of the
[Initial Settings] dialog box, you can register the user boot area also.

(b) Deleting the Overwriting Range in the Internal Flash Memory

Select the information of the overwriting range that you wish to delete from the list and click the [Delete] button.
You also can use the Delete key, instead of the [Delete] button, to delete the information.
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(c) Changing the Range in the Internal Flash Memory

Select the information of the overwriting range on the list and double-click on it. The [Address Range] dialog box
will be displayed.

In the [Address Range] dialog box, you can change the settings of the start address and the end address.

Address Range

Start address: |

End address: |

0] 4 I Cancel

Figure 4.9 [Address Range] Dialog Box
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(4) Registering Information on the External Flash Memory

The [External flash memory] page of the [Configuration Properties] dialog box allows you to register information on
external flash memory (that is, flash memory connected to the external-bus address space of the MCU). This
registration is necessary when you wish to download a program to external flash memory.

Gonfiguration Properties &l
MG L | System |
Internal flash memory ovenarite i bExternal flazh memory

Flazh memory

Address USD File USD File Path
7000000 - 7FFFFFF  ExFlazh UsD  Cé¥WorkSpace¥UsSD¥ExF

oK | Cancel |

[~ Da not show this dialog box again.

Figure 4.10 [Configuration Properties] Dialog Box ([External flash memory] Page)

External flash memory is not recognized until its USD file (which defines how the external flash memory is connected
to the user system, etc.) is added to the [External flash memory] page of the [Configuration Properties] dialog box.

Up to four USD files can be added.

To create USD files, use the External Flash Definition Editor. For details on how to create USD files, refer to the user’s
manual for the External Flash Definition Editor, which is available at http://www.renesas.com/efe.

() Registering Information on External Flash Memory
The [Add...] button on the [External flash memory] page is enabled when you’ve selected [On-chip ROM enabled
extended mode] or [On-chip ROM disabled extended mode] for the operation mode on the [Startup and
Communication] page of the [Initial Settings] dialog box.
Clicking on the [Add...] button opens a dialog box in which you can select USD files. When a USD file is selected,
information from the file is displayed in the flash memory list in the [Flash memory] section of the [External flash
memory] page.

(b) Deleting Information on the External Flash Memory

From the flash memory list, select the external flash memory information that you wish to delete and click on the
[Remove] button.
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(c) Making Detailed Settings for the External Flash Memory
From the flash memory list, select the external flash memory information for which you want to make detail setting,
and then click the [Detail...] button. The [External flash memory detail setting] dialog box is displayed. Double-
clicking on the selected memory, instead of the [Detail...] button, also brings up this dialog box.
The [External flash memory detail setting] dialog box allows you to specify whether or not individual sectors
(blocks) of external flash memory should be overwritten.

External flash memory detail setting §|
Qveryrite Address Downlo...
[ 07000000 - OF00FFFF Enabled
[#%&- 15 07010000 - OF03FFFF Enabled

O16-31 07090000 - OF18FFFF Enabled

Area
fddress: | 7000000 - | 700FFFF
[ Owverwrite

[ Digable download Set

| Write after all zectors are erazed.

If enabled, download time will be longer.

ok | Cancel |

Figure 4.11 [External flash memory overwrite] Dialog Box

Settings for all sectors defined in the selected external flash memory information are automatically shown in the list.
When a checkbox is selected, the sector will be overwritten (merged) when the user program is downloaded.

To alter the setting for one sector, enter the new first and last address in the [Address] edit box and click on [Set]. If
[Overwrite] is selected, the selected sector will be overwritten without erasure when the user program is
downloaded. The [Download] column of the list is marked as “Enabled.”

Also, if [Disable download] is checked, no data is downloaded to the sector you’ve set. The [Download] column of
the list is marked as “Disabled.”

If [Write after all sectors are erased.] is selected, all sectors will be erased when the user program is downloaded.
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Section 5 Emulator Functions

This section describes the emulator functions.
For the usage of each function, refer to section 6, Tutorial.

51 Overview

Table 5.1 gives a functional overview of the emulator.

Table 5.1 Emulator Functions

ltem Function

User program execution e
[ ]

Executes a program with the operating frequency within a range guaranteed by the MCU.
Reset emulation

Step functions:

Single stepping (one step: one instruction)

Source-level step (one step: one-line source)

Step over (a break did not occur in a subroutine)

Source-level step over (a break did not occur in a subroutine)

Step out (when the PC points to a location within a subroutine, execution continues until
it returns to the calling function)

[Go to Cursor]
[Reset Go]
[Free Go]

Shows the reason for the most recent break

Reset .

Issues a reset from the High-performance Embedded Workshop to the MCU during
break.

Tracing*? .

Internal trace (using the trace buffer in the MCU)

External trace output:
Trace-output priority mode (not in realtime)
CPU-execution priority mode (in realtime but some of the acquired data may be lost)

Type of trace data:
Branch (origin and destination) or data access

Searching
Filtering

Shows trace data as bus information, disassembled code, or source code

Break*? .

S/W break

On-chip break:

Pre-PC break

Event break (OR, cumulative AND, sequential, or number of passes)
Trace full break (break to occur when the trace buffer becomes full)

Forced break

Performance .
measurement*>

Uses a counter in the MCU to measure the number of cycles that passes during point-to-
point execution.
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Table 5.1 Emulator Functions (cont)

Iltem Function

Memory access*? ¢ Downloading to RAM
¢ Downloading to the on-chip flash memory
¢ Downloading to external flash memory*1
e Single-line assembly
e Disassembly
e Reading of memory
e Writing to memory
e Automatic updating of a display of selected variables during user program execution

e Fill
e Search
e Move

e Saving and loading data in memory

¢ Verifying data in memory

e Showing variables

¢ Realtime RAM monitoring

e Automatic updating of data in memory

General/control register Reads or writes the general-purpose/control registers.
access

Internal I/O register Reads or writes the internal 1/O registers.*1
access

Source-level debugging Various source-level debugging functions

Command line Supports command input.
Batch processing is enabled when a file is created by arranging commands in input order.

Help Describes the usage of each function or command syntax input from the command line
window.
Hot plug-in Supports the method for connecting the E1/E20 to the program under execution, allowing

for debugging to start from the middle of program execution.

Notes: 1. The [IO] window displays the contents of registers defined in [xxxx.io]. You can edit the file to add or delete
registers to the set for display in the [IO] window.
For the contents to be included in [xxxx.io], refer to reference 6, 1/0 File Format, in the High-performance
Embedded Workshop User's Manual.
The following directory contains [xxxx.io] (xxxx means the name of the MCU group).
<High-performance Embedded Workshop folder>:
\Tools\Renesas\DebugComp\Platform\E1E20\E20RX\IOFiles

2. Depending on the target MCU, some of the debug functions cannot be used or may differ in functional

specifications.

5.2 Downloading a Program

Download the load module to be debugged.

To download a program, choose [Download] from the [Debug] menu and select a desired load module or right-click on
a load module under [Download modules] of the [Workspace] window and then choose [Download] from the popup
menu. Alternatively, double-click on the name of the load module.

Note: Before a program can be downloaded, you must have it registered as a load module in the High-performance
Embedded Workshop.
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5.3 Opening a Source File

53.1 Viewing the Source Code

Select your source file and click the [Open] button to make the High-performance Embedded Workshop open the file in
the integrated editor. It is also possible to display your source files by double-clicking on them in the [Workspace]

window.

«# Tutorial.c

FEE

COX

Line: Source A 0. 5. Source

Bl

g% FFFFB77T oid main{vaid)

34 |FFFFE7?? while (13{

gg FFFFE77C 2] tutorial (J;
37 1

38

ig FFFFA7ERE oid tutarial (void)
41 long allol;

47 long j;

43 int i;

jg struct Sample far #p_sam;

46 |FFFFE784 p_san= mal loci (struct Sampleld;

ig FFFFB795 initip_sam);

43 |FFFF879E for{ i=0; i<10; i++ 3]
50 |[FFFFa7AA j = rand();

51 |FFFFE7E3 ifli <00

50 FFFFETEA i= i

53 }

04 [FFFFTC2 | | o> alill= J;

56 |FFFFS7DE sort (al;

57 |FFFFA7E change (al;

4 |

Figure 5.1 [Editor] Window
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The columns listed below are to the left of the [Source] column.

The first column ([Source Address] column): Address information
The second column ([On-Chip Breakpoint] column):  On-chip breakpoint information
The third column  ([S/W Breakpoint] column): PC, bookmark, and breakpoint information

[Source Address] column

When a program is downloaded, an address for the current source file is displayed on the [Source Address] column.
These addresses are helpful when setting the PC value or breakpoints.

[On-Chip Breakpoint] column
The [On-Chip Breakpoint] column displays the following item:

®: |ndicates the address condition for an on-chip break.
The number of address conditions that can be set for on-chip breakpoints is the same as the overall number of
events, which varies with the MCU.
Double-clicking on the [On-Chip Breakpoint] column produces a bitmap symbol as shown above in the
corresponding line.

[S/W Breakpoint] column
The [S/W Breakpoint] column displays the following items:
3: Bookmark
& PC breakpoint

% : Program counter (PC)

S To switch off a column in all source files
(1) Right-click on the [Source] window or select the [Edit] menu.

(2) Click the [Define Column Format...] menu item.
(3) The [Global Editor Column States] dialog box is displayed.

(4) A checkbox indicates whether the column is enabled or not. If it is checked, the column is enabled. If the
checkbox is gray, the column is enabled in some files and disabled in others. Deselect the checkbox of a column
you want to switch off.

(5) Click on the [OK] button for the new column settings to take effect.

Global Editor Golumn States EJ§|
[w]Dizagzembly Address A |
MLabel Cancel
[w]Line
[w]Obj code

[w]On—-chip Break points
[w]On-chip Break points - A5M

[w]5.W Breakpoints v
L ¥

Figure 5.2 [Global Editor Column States] Dialog Box
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S To switch off a column in one source file
(1) Open the source file which contains the column you want to remove and right-click on the [Editor] window to
open a popup menu.
(2) Click on the [Columns] menu item to display a cascaded menu item. The columns are displayed in this popup
menu. If a column is enabled, it has a tick mark next to its name. Clicking on the entry will toggle whether the
column is displayed or not.

5.3.2 Viewing the Assembly-Language Code

Click the [Disassembly] toolbar button at the top of the window when a source file is opened to show the assembly-
language code that corresponds to the current source file.

If you do not have a source file, but want to view code in the assembly-language level, either choose [View ->
Disassembly...] or click on the [Disassembly] toolbar button ).

The [Disassembly] window opens at the current PC location and shows [Address] and [Code] (optional) which show the
disassembled mnemonics (with labels when available).

Selecting the [Mixed display] toolbar button ( ) displays both the source and the code. The following shows an
example in this case.

«# Tutorial.c — Dizassembly

=& &
Line 0. 5. Dizazzem.. | Obj code Label ixed
] ali] = i; j
o |FFFFE702  |EFDS ov.L RO,RS -
FFFFa7CG4  |EDOEQR oL SCHIROD.R14
FFFFETCT  (malt oL 2BHLROT.RI
FFFFE73  |FEZEST oL R1,[R14,R5]
FFFFa7CG  |EDOECR oL SCHIROD.R14
FFFFR7CF  |BZ1E woD #IH.R14
FFFFE701 |EYOEQE oL R14,2CHIRO]
FFFFB704 |EDOEOE . 2CHIRO].R14
FFFFR707  |B1AE HP HOAH,RT4
. FFFFE709 |29 BLT.? OFFFFa7AAH
56 sort (a);
FFFFE7OE |EFM oL ROLR1
FFFFE700 |DS0AFEFF BSH.4 sort
57 changela);
FFFFEVET |EFO& oL RO RS o
FFFFEVEZ |EFS1 L R5,R1
- FFFFA7ER |O528FFFF BSR4 _change
59 p_sam->s0=a[0];
FFFFB7ES |ECOS oW . L ,RA
FFFFE7ER |EDOEOC oL 30H[RO],R14
FFFFE7EE |E3ES oL RE,[R14]
£ posam-»s1=al1]; =
4| | >

Figure 5.3 [Disassembly] Window
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533 Modifying the Assembly-Language Code

You can modify the assembly-language code by double-clicking on the instruction that you want to change. The
[Assembler] dialog box will be opened.

Asszembler

Address  Code
FFFFETCF 621E

- Cancel
Mnemaornic:

Figure 5.4 [Assembler] Dialog Box

The address, machine code, and disassembled instruction are displayed. Enter the new instruction or edit the current
instruction in the [Mnemonic] field. Pressing the [Enter] key will assemble the instruction into memory and move on to
the next instruction. Clicking on the [OK] button will assemble the instruction into memory and close the dialog box.
Clicking on the [Cancel] button or pressing the [Esc] key will close the dialog box.

Note: The assembly-language display is disassembled from the machine code on the actual memory. If the memory
contents are changed, the dialog box (and the [Disassembly] window) will show the new assembly-language
code, but the display content of the [Editor] window will not be changed. This is the same even if the source file
contains assembly code.

54 Memory Access Functions

The emulator has the following memory access functions.

54.1 Memory Read/Write Function

e [Memory] window:

The memory contents are displayed in the window.

Only the amount specified when the [Memory] window is opened can be read.

Since there is no cache in the emulator, read cycles are always generated.

If the memory is written in the [Memory] window, read cycles in the range displayed in the [Memory] window will
occur for updating the window.

When the [Memory] window is not to be updated, select [Lock Refresh] from the popup menu opened by right-clicking
in the window.

e me command:
A command line function that reads or writes the specified amount of memory at the specified address.
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(1) User Program Downloading Function

A load module registered in the workspace can be downloaded. Such module can be selected from [Download Module]
in the [Debug] menu. Downloading is also possible by a popup menu that is opened by right-clicking on the mouse at
the load module in the workspace. The user program is downloaded to the RAM or flash memory.

This function also downloads information required for source-level debugging such as debugging information.

(2) Memory Data Uploading Function

The specified amount of memory from the specified address can be saved in a file. Select [Save] from the popup menu
in the [Memory] window.

(3) Memory Data Downloading Function
The memory contents saved in a file can be downloaded. Select [Load] from the popup menu in the [Memory] window.

(4) Displaying Variables
The contents of a selected variable in the user program are displayed.

(5) Realtime RAM Monitoring

With some MCUs, contents of memory can be monitored while the user program is running. For details on the
specifications of individual MCUs, refer to the online help.

(6) Automatic Updating of Data in Memory

The display of data in memory in the [Memory] window can be automatically updated while the user program is
running. The interval for updating the display is also specifiable.

(7) Other Memory Operation Functions
Other functions are as follows:

o  Memory fill

e Memory move

e Memory copy

e Memory save

o Memory verify

e Memory search

e Internal I/O display

e Displaying label and variable names and their contents

For details, refer to the online help.
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55 Break Functions

The E1/E20 emulator has three kinds of break functions: a forced break, a S/W break, and an on-chip break function.

5.5.1 Forced Break

The forced break function is used to forcibly cause a break in execution of the user program.

55.2 S/W (Software) Break

The first instruction at a specified address is replaced with a special instruction (intended for debugging) that leads to a
break in execution.

Setting a S/W breakpoint leads to replacement of the first instruction following the specified address by the special
instruction and so involves writing to memory. Similarly, removing a S/W breakpoint involves writing to memory
because the special instruction must now be replaced with the original instruction.

To set a S/W breakpoint, double-click on the [S/W Breakpoint] column in the [Editor] or [Disassembly] window of the
High-performance Embedded Workshop.

55.3 On-Chip Break

The on-chip break function consists of three kinds of break: Pre-PC break, Event break (based on events, such as
instruction-fetch event or operand access event), and Trace full break.

For the RX600 Series MCUSs, on-chip breaks based on instruction-fetch events can be set for 8 points, and those based
on operand access events for 4 points, allowing you to set event-combination breaks [OR and AND (cumulative)] for up
to 8 points.

For the RX200 Series MCUSs, on-chip breaks based on instruction-fetch events can be set for 4 points, and those based
on operand access events for 2 points, allowing you to set event-combination breaks [OR and AND (cumulative)] for up
to 6 points.

For the usage of on-chip break function, refer to section 5.7.1, Setting On-Chip Break Points.

(1) Pre-PC Break

Once a specified instruction-fetch event is encountered, a break occurs before the instruction at that address is
executed. Pre-PC breakpoints can even be set while the user program is running.

To set a pre-PC breakpoint, double-click on the [On-Chip Breakpoint] column in the [Editor] or [Disassembly]
window of the High-performance Embedded Workshop. For details on the [On-Chip Breakpoint] column, refer to
section 5.2, Downloading a Program.

It is also possible to set pre-PC breakpoints via the [On-Chip Break] dialog box.

(2) Event Break

Several events can be used in combination. Instruction-fetch and data access (using operand-access events) are
selectable for event conditions. The event combination can be [OR], [AND (cumulative)], [Sequential], or [Pass
Count]. Event breakpoints can also be set while the user program is running.

It is also possible to set event breakpoints via the [On-Chip Break] dialog box.
Note that the RX200 Series MCUs do not support on-chip breaks based on number of passes.

(3) Trace Full Break

A break occurs when the trace buffer becomes full. Related settings cannot be changed while the user program is
running.
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Table 5.2 shows the list of break functions.

Table 5.2 Break Functions

Number of Points

Programming Can a Breakpoint be Set

RX 600 Series RX 200 Series Break of Flash While the Program is
Type of Break MCUs MCUs Condition Memory Running?
S/W break 256 <« Address Yes No
Pre-PC break 8 4 Address No Yes
Event break 8 4 Address No Yes
(instruction fetch)
Event break 4 2 Data access No Yes
(data access)
Trace full break — Trace buffer No No

full

5.6 Event Functions
5.6.1 Using Events

An event refers to a combination of phenomena that occur during program execution.

An event you have set can be used as a condition for the break, trace or performance-analysis function.

The number of events set and the setting conditions differ with each MCU. For functional specifications, refer to Table
4.3, “List of Functional Specifications by Target MCU.”

Events you create can be registered for reuse at a later time.

(a) Types of Events
Events are of the following types.

Table 5.3 Event Types

Execution address The emulator detects execution of the instruction at the specified address by the
CPU.

When an execution-address event is used for a pre-PC break, the event
condition is satisfied immediately before execution of the instruction at the
specified address. When an event is specified in any other way, the event
condition is satisfied after the instruction at the specified address has been
executed.

Data access The emulator detects access to a specified address or specified address range.

(b) Event Combinations
The following types of combination can be specified for two or more events.

Table 5.4 Types of Event Combination

OR The condition is met when any one of the specified events occurs.

AND (cumulative) The condition is met when all of the specified events occur regardless of the

timing.
Sequential The condition is met when the specified events occur in a specified order.
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5.6.2 Adding Events

Events are added in any of the following ways.

e Through the [On-Chip Break], [Trace conditions], or [Performance] dialog box

e By setting on-chip breakpoints in the [On-Chip Breakpoint] column of the [Editor] window (for on-chip break
only)

e By dragging and dropping from another window

e From the command line

(a) Add an Event through the [On-Chip Break], [Trace conditions], or [Performance] Dialog Box
The following is an example of adding an event through the [On-Chip Break] dialog box.

1. Select [View -> Event -> On-chip Break] to open the [On-Chip Break] dialog box. Selecting an event
combination on the [On-Chip Break] page opens the corresponding page where detailed settings can be made.
We use an [OR] condition in this example, so select the [Event Break] checkbox and then the [OR] tab in the
[On-Chip Break] dialog box.

For details on the event types on the other tabbed page ([Before PC], [AND], and [Sequential]), refer to section
5.7.1 Setting On-Chip Break Points.
Click on the [Add] button or double-click on the line where the new event is to be added.

Event | Tvpe | Contents | Counk | C.l Comments

add... ] Delete | Enable ‘ Dizable |

Figure 5.5 [On-Chip Break] Dialog Box
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2. The [Event] dialog box shown below will be displayed. Set details of the event condition in this dialog box.
Then click on the [OK] button.

Event §|

Event Type: |Executiu:un address ﬂ
Event lCDmment]

Address Condition

address: |_main ﬂ

[ Specify the path count condition ko this event

o4 | Cancel

Figure 5.6 Adding an Event

If the target MCU is one of the RX600 Series, you can set the condition for the number of event passes (1 to 256).
Select the [Specify the pass count condition to this event] checkbox to include the number of event passes as part of the
condition.
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The [Pass Count] page will be added. Specify a number of times and click on [OK].

Event §|

Event Type: |Executiu:un address j
Event Pass Count lCDmment ]

Counk candition (1-256)

L Lirnes

v Specify the path count condition to this event!

Ik | Cancel

Figure 5.7 Specifying a Number of Times

3. Anevent will be added at the specified position.

on-Chip Break] Before PC OR l

Event | Tvpe | Cantents | Count | C.| Caomments
EvDl PC  [Address] _main

Figure 5.8 Added Event

4. If you create an event that would make the total number of events exceed the limit, an error message is
displayed. In this case, the event you have attempted to add is invalid.

R20UT0399EJ0401 Rev.4.01 Page 95 of 210
Jul 01, 2011 RENESAS



E1/E20 Emulator Section 5 Emulator Functions

(b) Adding an Event from the [On-chip Break points] Column of the [Editor] Window

[Adding an on-chip breakpoints]

1. Double-click on the [On-chip Break points] column of the [Editor] window.

This sets execution of the instruction at the corresponding address as the condition for an on-chip breakpoint, i.e.
an execution-address condition.

Bald

Line | Source A..| 0. 5. Source

27 |FFFFESET S{ort(long xa) Z‘

28 long ti
30 int i, J, ks gap:

32 |FFFFBREC | @ gap = 5

33 |FFFFB5F1 while( zap > 0 )1

34 |FFFFB5FE for( k=03 k<gap; k++){

35 |FFFF860C fort izk+gap; i<10; i=i+gap J{ J

36 (FFFFEe20 far{izi-gap; i>=k; Jj=i-gap){
37 |FFFFBE33 g_IntBuf = j;

38 |FFFFBE40 iftalilyalitzap]){

39 |FFFFBESF t =alils

A0 |FFFFEREC alil = ali+zapl;

41 |FFFFBEB? . ali+zap] = t;

43 else
44 break;

45 ol -
< | »

Figure 5.9 [Editor] Window

Note: If you have edited the contents of the [On-Chip Break] dialog box but not clicked on the [Apply] button (i.e. the
settings have not been activated yet and [*] is displayed after the title in the title bar), you cannot set an on-chip
breakpoint from the [On-chip Break points] column of the [Editor] window.
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(c) Adding events by dragging and dropping

[Dragging and dropping a variable or function name in the [Editor] window]

1. By dragging and dropping a variable name into the [Event] column of the [On-Chip Break] dialog box, you can
set access to that variable as an event to be detected, i.e. a data-access condition.

At this time, the size of the variable is automatically set as a condition of the data access event.
Only global or static variables taking up 1, 2, or 4 bytes can be registered for event detection. Static variables in
functions cannot be registered.

When a pre-PC breakpoint has been set (on the [Before PC] tabbed page), however, dragging and dropping of a
variable name is not possible because the only event type selectable for a pre-PC break is “execution address”.

2. By dragging and dropping a function name into the [Event] column of the [On-Chip Break] dialog box, you can
set execution of the instruction at the address where that function starts as an event to be detected, i.e. an
execution-address condition.

- [B]x]|

Line Source f..

0. 5. Source

27 |FFFFESET

32 |FFFFBAED
33 |FFFFBAF1
34 |FFFFE5FE
35 |FFFFEE0C
36 |FFFFEEZ20
37 |FFFFBE33

{Eorfllong +a)

long

M On—Chip Break *

int i, j. R on-Chip Break] Before PC  OR l
gap = &3
5 Event | T Content: Count | €.
whilel zap > 0 3 vect | Type | Contents [t [
for{ k=0; k<gap: k+ MeAevor  PC [Address] _sort - #

for( i=k+gap; i4
for(i=i-zap
g_IntBuf

Figure 5.10 Dragging and Dropping into the [On-Chip Break] Dialog Box

[Dragging and dropping an address range in the [Memory] window]

With the RX600 Series MCUSs, select an address range in the [Memory] window and drag and drop it into the [Event]
column of the [On-Chip Break] dialog box. In this way, you can set access to an address in the selected address range as
a data access event to be detected, i.e. a data access condition.

When a pre-PC breakpoint has been set (on the [Before PC] tabbed page), however, dragging and dropping of an
address range is not possible because the only event type selectable for a pre-PC break is “execution address”.

[Dragging and dropping a label in the [Label] window]

Select a label in the [Label] window and drag and drop it into the [Event] column of the [On-Chip Break] dialog box. In
this way, you can set execution of the instruction at the label as an event to be detected, i.e. an execution-address

condition.
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5.6.3 Removing Events

The following way of removing events is available.

e Deleting an event from the [On-Chip Break], [Trace conditions], or [Performance] dialog box

(a) Deleting an Event Through the [On-Chip Break], [Trace conditions], or [Performance] Dialog Box

The following is an example of removing an event through the [On-Chip Break] dialog box.
1. Toremove one point, select the line you want to remove in the [Event] list on the [OR] page of the [On-Chip
Break] dialog box and then click on the [Delete] button (or use the keys Ctrl + Del instead of clicking on the

button).

The selected event will be removed from the [Event] list.

I On—Chip Break

EoX

on-Chip Ereak] Before PC OR l

Evvent | Tvpe |C|:|ntents

|C|:|unt | hannel |C|:|mments

E¥Ol PC  [Address] _main =
Ev0Z  PC [Address] _nit - 1
Ev03 PC [Address] tutorial - 2

< | =
add. .. | Enable | Dizable |
P 3 P )
Event used O O Free O 4 Reqistered events. ..
Save... | Load... | Close

Figure 5.11 Removing an Event
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2. To remove multiple events, hold down the Shift or the Ctrl key while you select lines you want to remove in the
[Event] list in the [On-Chip Break] dialog box and then click on the [Delete] button (or use the keys Ctrl + Del

instead of clicking on the button).
The selected events will be removed from the [Event] list.

B On—Chip Break

on-Chip Break] Before PC  OR

|

E)oX]

E'venk | Tvpe |C|:untents

|C|:n.|nt | Channel |C|:|mments

mlEvDz  PC [Address] ini
TlEV03  PC [Address] tu

3

E¥Ol PC  [Address] _main

E

korial

| Dizable |

add. .. ' Delete Enable

PC: 3 PC: S
Event used o Free O 4

Save, .. | Load... |

Reqistered events. .

Close

Figure 5.12 Removing Multiple Events
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564 Registering Events

“Registering an event” refers to placing an event in the list of registered events.
A registered event can be reused at a later time.
Select one of the following ways to register an event. Up to 256 events can be registered.

e Through the [On-Chip Break], [Trace conditions], or [Performance] dialog box
e By dragging and dropping from the [On-Chip Break], [Trace conditions], or [Performance] dialog box
e Through the [Registered Events] dialog box

(a) Registering Events Through the [On-Chip Break], [Trace conditions], or [Performance] Dialog Box
The following is an example of registering an event through the [On-Chip Break] dialog box.
1. Click on the [Add] button on the [OR] page of the [On-Chip Break] dialog box. The [Event] dialog box will

appear.
I On—Chip Break
Event | Tvpe |C|:|ntents |C|:|unt | hannel |C|:|mments
< *
add. .. Delete | Enable | Dizable |
Event used Poi% Free E;.:ﬁ.i Reqistered events. ..
Save... | Load... | Close
Figure 5.13 [On-Chip Break] Dialog Box
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Open the [Comment] page and select the [Add this event to the list] checkbox.

An explanatory comment for the event can be attached.

You can check the [Registered Events] dialog box to see the contents of registered events and comments.
Click on the [OK] button.

Event §|

Event Type: |Executiu:un address j

Event Comment l

Execution of main funckion
Cornrment

[v add this event ta the list

[ specify the path count condition to this event

Ik | Cancel

Figure 5.14 Registering an Event
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2. The event is added at the specified position and registered in the [Registered Events] dialog box at the same

time.

B On-—Chip Break

on-Chip Breakl Before PC OR

Event I Twpe I Conkents

| Cl Zhannel | Comments |

[Flevor  Po

[Address] _main - n

Execution of main function

M Reziztered Events

Twpe | Contents

| Count I Comments |

[Address] _main

Execution of main Funckion

Figure 5.15 Registered Events

To open the [Registered Events] dialog box, click on the [Registered events...] button at the bottom of the [On-

Chip Break] dialog box.

B On—Chip Break

n-Chip Break I Before PC OR

Event | Tvpe | Conkents

| Cl Zhannel | Comments |

EvOl PC

[Address] _main -

add... Delete | Enable | Disable |

Execution of main Funckion

PC:i 1 PC:
Event used O 0 Free O 4

( Registered events. .. |

Save.., | Load. .. |

apply I Close I

Figure 5.16 Opening the [Registered Events] Dialog Box
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(b) Registering Events by Dragging and Dropping

An event you have created in the [On-Chip Break] dialog box can be registered in the [Registered Events] dialog
box by dragging and dropping it into the list.

- On—Chip Break

on-Chip Ereak! Before PC OR

Excecution of main funckion

Figure 5.17 Dragging and Dropping into the [Registered Events] Dialog Box

(c) Registering an Event in the [Registered Events] Dialog Box
Click on the [Add] button to open the [Event] dialog box, in which you can create events.
Any event you create here is added to the [Registered Events] dialog box.

M Recistered Events

Tvpe | _onkents | _ount | omrments |

Duplicate Add... | Delete Al
| —

|
Save... | Load... | Close |
|

Figure 5.18 [Registered Events] Dialog Box
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5.6.5 Removing a Registered Event

To remove an event that has been registered, click on the [Registered events...] button at the bottom of the [On-Chip
Break] dialog box. The [Registered Events] dialog box opens.

B On—Chip Break o5&

on-Chip Break] Before PC - OR l

Ewent | Type |C0ntents |C| Channel | Camments |
[MIEV0l  PC [Address] _main - ] Execution of main Function

Add... Delete | Enable | Disable |

PCi 1 PC: 7 .
Event usad o0& O Free O 4 Reqistered events...

Save... | Load...

Figure 5.19 Opening the [Registered Events] Dialog Box

To remove one event, select the line you want to remove in the [Registered Events] dialog box and click on the [Delete]
button (or use the keys Ctrl + Del instead of clicking on the button).

The selected event will be removed from the [Registered Events] dialog box.

To remove all events, click on the [Delete All] button.

I Registered Events

Type | Contents | Count | Camments |
[Address] _init

PiC [Address] _tutorial

P [Address] _sort

P [Address] _main

Duplicate| add. .. [-Delete | Delete F\IIH

Save,.. Load... Close |

Figure 5.20 Removing an Event
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5.6.6 Creating Events for Each Instance of Usage or Reusing Events

The following two approaches are available for setting events in the [On-Chip Break], [Trace conditions], or
[Performance] dialog box.

One is to create events in the dialog box each time they are to be used. The other is to choose a condition from the
[Registered Events] dialog box and drag and drop it into the [Event] list in the [On-Chip Break], [Trace conditions], or
[Performance] dialog box.

Here, we refer to the former as creating events per usage and the latter as reusing events.

o Creating events per usage

Select this method if you intend to use a specific condition only once.

The event you have created is used without ever being registered.

Once the event is no longer in use (i.e., it has been changed or deleted), its setting is nonexistent.

Any event created by a simple operation such as double-clicking in the [Event] column of the [Editor] window
constitutes an event created per usage.

e Reusing events

Any event registered in the [Registered Events] dialog box can be reused by dragging and dropping it into the [Event]
list in the [On-Chip Break], [Trace conditions], or [Performance] dialog box.

on-Chip Break ] Before PC OR l

Event | Type |Cu:untent5 |C| Channel | Comments
[PlEvol  PC  [Address] _main - 0 Excecution of main funckion

| Counk | Camments
Execution of main funckion

Figure 5.21 Reusing an Event

(a) Dragging and dropping an event into multiple dialog boxes
An event in the [Registered Events] dialog box can be dragged and dropped into multiple dialog boxes.

If a condition of an event is altered after the event has been dragged and dropped, the alteration is not reflected in
the setting of the original event in the [Registered Events] dialog box.

(b) Registering duplicates in the [Registered Events] dialog box
Even duplicate events that have the same conditions can be registered in the [Registered Events] dialog box.
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5.6.7 Activating Events

To activate the settings for events that you have created, click on the [Apply] button.
Settings you make do not become effective until you click on the [Apply] button.

[*] after the title on the title bar of the [On-Chip Break], [Trace conditions], or [Performance] dialog box indicates that
some setting is being edited. While you are editing an event, you cannot change the settings via the [Event] column of
the [Editor] window or the command line.

B On—Ghip Break * M=

on-Chip Break l Before PC OR l

Event | Type |Cu:untents |C| Channel | Comrments

EvOl PC  [Address] _main - Excecution of main Funckion

< | =
add. .. | Delete | Enable | Disable |
PCi 1 PC: 7 .
Event used 08 0 Free O 4 Registered events. .. |
Save... | Load... | ' Apply Close |

Figure 5.22 Applying the Settings
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5.7 On-Chip Breakpoints

An on-chip break causes the user program to stop running when a specific event is detected.

57.1 Setting On-Chip Breakpoints

() Setting an On-Chip Breakpoint
For an on-chip breakpoint, you can set a pre-PC break condition, event combination (OR, AND (cumulative), or
sequential) and other conditions.
You can specify all or only one from among the pre-PC break condition, event combination (OR, AND
(cumulative), or sequential) and other conditions.

Program execution

\

Pre-PC break

Event combinations
OR

AND (cumulative) > On-chip breakpoint
Sequential encountered
Other conditions ->
2
Break

Figure 5.23 On-Chip Break in Outline
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To set an on-chip breakpoint, open the [On-Chip Break] dialog box by selecting [View -> Event -> On-Chip Break].

(b) Setting a Pre-PC Breakpoint
[Before PC Break] is always enabled.
If you wish to disable [Before PC Break], delete or disable the registered event.
The break in execution will be immediately before execution of the instruction at the specified address.

condition and combination setking
Before PC Break,

Event in use : 1 Dretail | —_—

[ Ewvent Break

| =l
Eventinuse : 0 |

Cther

Total: 1 events

[ Trace Full Break — |----------- '

Figure 5.24 [On-Chip Break] Dialog Box (Pre-PC Break)

Clicking on the [Detail] button for [Before PC Break] opens the [Before PC] page.
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Clicking on the [Add] button on the [Before PC] page opens the [Event] dialog box, in which you can specify events
for use as pre-PC breakpoints (i.e. execution-address conditions). It is also possible to specify a label as an event.
The only event type selectable for a pre-PC break is “execution address”.

O hip Break

On-Chip Break ] Before PC OR

Event | Type |C0ntents

| C| Channel I Comments

|

Add... Delete | Enab

fich

PC: 0 P 8
Event used ofn TEE a4

Sawve... | Load...

Address Condition

Event Type: |Execution address -

Ewent l Cornment ]

Address: |

ey

| 5 Catcel

Select Label

Filter: ||
Label # /l Address
_Aldata ¥ 000m40c
_Getmem FFFF8A3C
_INITSCT FFFF39F2
_rnext aooo1414
_sbrk size FFFF&100
brk 00001408
_ETEL FFFFE128
_change FFFFE70D
_DTBL FFFFE104
_Dummye FFFF2A55
_Ewcep_fccess FFFFaA4D
_Excep_FloatingPoint FFFF2451
_Excep_SuperVizorlhet  FFFF3A4B
_Excep_Undetfinednzt FFFFEA4F
_Expep_ERE FFFFaAST
findmem FFFF3E0C
_Fixed_Vectors FFFFFFDO
_free FFFFa24C =
& _CharBuf nooonoo
& IntBuf 00o01404
_heap_area aooo1o04
_init FFFFa5AG
_main FFFFET7Y
_malloz FFFFa958
_MonMazkablelnterrupt  FFFF3A53 b

Figure 5.25 Setting Pre-PC Break Conditions

[*] after the title in the title bar of the [On-Chip Break] dialog box indicates that the settings have not been activated
yet. When you click on the [Apply] button to activate the settings, [*] in the title bar will disappear.
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(c) Setting an Event Break
You can select [OR], [AND (simultaneous)], or [Sequential].
To enable an event break, select the checkbox to the left of [Event Break].
To disable an event break, remove the checkmark from the checkbox to the left of the [Event Break].
[Event Break] is disabled by default (the checkbox to the left of [Event Break] is not selected).

condition and combination setting
Before PC Break,

Event in use : 1 Detail | |[=——
[v Ewvent Break

oR |
Event inuse : 1 Dretail

Cther

Tatal : 2 events

[ Trace Full Break — |----------- '

Figure 5.26 [On-Chip Break] Dialog Box (Event Break)

Table 5.5 List of Event Break Items

Type Description
OR When any one of the set events occurs, the break condition is met.
AND (cumulative) When all of the set events occur regardless of the timing, the break

condition is met.

Sequential When the set events occur in a specified order, the break condition is met.
RX600 Series MCUs:
7 steps (forward direction) + reset point (R)*l
RX200 Series MCUs:

3 steps (forward direction) + reset point (R) i

Note: 1. Reset point (R): When the event that is set at a reset point occurs, all of the events that
have occurred until that time are cleared.

The events shown in the list for each condition can be deleted by the keys Ctrl + Del.

Clicking on the [Detail] button for [Event Break] opens the page that corresponds to the selected condition (e.g. the
[OR] page when [OR] has been selected).
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Clicking on the [Add] button on the page opens the [Event] dialog box, in which you can specify events for use as
event breakpoints (i.e. execution-address or data-access conditions). It is also possible to specify a label as an event.

On-Chip Break ] Before PC DR ]

Evert | Type |C0ntents |C| Channel | Comments

Ewvent Type:
Event l Comment ]

Address Condition

Address: | j

Condition

* Mot specify

" Mask: ’7 Compare:l—_l

add... ] Delete - Range:| J

End Address: J

|

P
Ewent used oa: o Fred

o
Data Condition
Save... | Load...
Read,write: |Read,|'Write j
Access Size: |Nu:|t Specify j

Compare Condition

Compared Data; |

I Compare:

[ Specify the path count condition ko this event

OF | Cancel

Figure 5.27 Setting Event Break Conditions

[*] after the title in the title bar of the [On-Chip Break] dialog box indicates that the settings have not been activated
yet. When you click on the [Apply] button to activate the settings, [*] in the title bar will disappear.

(d) Setting Other Conditions
Specify whether you want the following condition to be used as a breakpoint.
e Trace full break

R20UT0399EJ0401 Rev.4.01 Page 111 of 210
Jul 01, 2011 RENESAS



E1/E20 Emulator Section 5 Emulator Functions

57.2 Saving/Loading On-Chip Break Settings

(a) Saving On-Chip Break Settings
Click on the [Save] button of the [On-Chip Break] dialog box. The [Save As] dialog box will be displayed.

Specify the name of the file where you want the on-chip break settings to be saved. The file-name extension is
".hev". If this is omitted, the extension ".hev" is automatically appended.

(b) Loading On-Chip Break Settings
Click on the [Load] button of the [On-Chip Break] dialog box.
The [Open] dialog box will be displayed.
Specify the name of the file you want to load.
When you load a file, the previous on-chip break settings are discarded and the new settings appear in the dialog
box.
Click on the [Apply] button of the [On-Chip Break] dialog box to activate the new on-chip break settings you have
loaded.
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5.8 Trace Functions

The E1/E20 emulator has two kinds of trace functions available to use: an internal trace and an external trace, as shown
in Table 5.6.

Table 5.6 Trace Functions

Function Internal Trace External Output Trace
Branch trace Supported Supported
Data trace Supported Supported

Table 5.7 shows the products that the external output trace function can be used.

Table 5.7 Name of the Product and External Output Trace Function

Name of the Product (Type Number) External Output Trace Function
E1 (ROEO00010KCEOO) Not supported
E20 (ROE000200KCTO00) Supported

Internal trace or external output trace can be set in the [Trace conditions] dialog box in the [Trace] window.

(1) Internal Trace Function

The internal trace function uses the trace buffer in the MCU.

Instruction-fetch and operand-access events can be used to acquire CPU-bus trace data on branches and data access.
For the RX600 Series MCUSs, it is possible to obtain source/destination address information and data access information
for up to 256 jumps or cycles.

For the RX200 Series MCUSs, it is possible to obtain source/destination address information and data access information
for up to 64 jumps or cycles. However, before data access information can be obtained, it is necessary that address
conditions be set by the trace extraction function.

The trace results thus obtained can be displayed at the bus, disassembly or C source level in the trace window.

For functional specifications, refer to Table 4.3, “List of Functional Specifications by Target MCU.”

(2) External Trace-Output Function

The E20 includes a facility for acquiring trace data through the trace pins of MCUSs. The E20 is capable of recording
large amounts of trace data output in this way. Note, however, that the external trace-output function is only available
when the E20 is connected to the 38-pin connector on the user board. The same types of trace data can be acquired
through the external trace-output function as through the internal trace function, the only difference being that the
maximum amount of trace data becomes 2-M branches or cycles.

There are two modes for external trace output: trace-output priority (full tracing) and CPU-execution priority (realtime
trace).

(a) Trace-Output Priority Mode (Full Tracing)

All trace data will be output; none will be lost.

If the amount of trace data for input to the trace circuit starts to exceed the output capacity, the emulator forcibly
suspends the CPU and bus so that no further data are input to the circuit. After all trace data that have been
processed in the MCU are output, the emulator restarts the CPU and bus.

For this reason, operation in the trace-output priority mode is not necessarily realtime.
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(b) CPU-Execution Priority Mode (Realtime Trace Mode)

Trace data will be output in realtime.
If the amount of trace data input to the trace circuit starts to exceed the output capacity, some data will be discarded
because realtime operation is given priority.

58.1 Viewing Trace Information

Tracing means the acquisition of bus information per cycle and storage of this information in trace memory during user
program execution.

You can use tracing to track the flow of application execution or to search for and examine the points where problems
arise.

5.8.2 Acquiring Trace Information

In cases where no trace acquisition conditions are set, the default behavior of the emulator debugger is to acquire
information on all bus cycles unconditionally (trace mode = [Fill until stop]).

In "fill until stop" mode, the emulator starts trace acquisition as soon as the user program starts running. When the user
program stops, the emulator stops tracing.

The acquired trace information is displayed in the [Trace] window.

# Trace EX]

=V
Ranee: -00137222, 00000000 File: |Chcle: 00000032 |Address: FFFFETAE
Cycle Label Address Source Address | Dest ination | Data Size | R EUS Master | Type BC! Channel | TineStamp {Count ) -
-00000032 [ ——— [ —— SR oPU DESTIRATION E
e i s i cRU BOND 1 =
-00000030  _rand FFFF2905 FFFFaADE s ELE cPU DESTINATION - -
-00000023 FFFFE7AE FFFFRTAE  =mmmm-o- —— cRU DESTINATION 2
e i A cPU -
00000027 _rand FFFF2905 i T — il cPU DESTINATION -
-00000025 FFFFE7AE FFFFRTAE  =mmmm-o- spr &= cPU DESTINATION -
e i —— - cPU -
-00000024  _rand FFFF2905 FFFFaADE EE cPU DESTINATION -
-00000023 FFFFS7AE FFFFETAE e cRU DESTINATION - =
mmmnnz2 e o . cPU -
00000021 _rand FRFFA306 FRFFBA06 wm e cPU DESTINATION - z
~00000020 FFFFATAE FFFFATAE S cPU DESTTNATION - -
e . cPU -
00000015 _rand FRFF8906 FFFFB906 O cPU DESTINATION - -
10000017 FFFFBTAE FFFFOTME v — - cPU DESTINATION -
weoonts e S cPU -
00000015 _rand FRFF8906 i J— " cPU DESTINATION .
00000014 FFFFBTAE FFFFOTME v S cPU DESTINATION -
weoonts e S cPU = -
00000012 _rand FRFFBIDS e FFFFOO0E v B i DESTINATION - 3
Figure 5.28 [Trace] Window
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The following items are displayed (in bus display mode).

Table 5.8 Items Shown in the [Trace] Window

Column Description

Cycle Number of the cycle within trace memory. By default, the number of the last cycle to have been
acquired is 0, and earlier cycles are assigned progressively lower numbers in sequence, i.e. -1, -2, etc.

Label Label corresponding to the address (displayed only when a label has been set)

Address Address value. If there is no corresponding address, the entry is blank.

Source Source address of a branch. If the cycle does not include such a value, the entry is “—".

Address

Destination Destination address of a branch. If the cycle does not include such a value, the entry is “—".
Address

Data Byte, word, or longword data displayed as hexadecimal values.

If there was no access over the data bus in the given cycle, the entry is “—" or blank.
Size Unit of access.

BYTE: Byte

WORD: Word

LONG: Longword
If there is no size value for the given cycle, the entry is “—".

R/W Data bus state.
W: Writing (indicated by brick red)
R: Reading (indicated by green)
Cases where data on the bus were produced by neither writing nor reading are indicated by black.
If there is no R/W value for the given cycle, the entry is “—".

BUS Master  Bus master that triggered tracing.
CPU: CPU access
If there is no bus master for the given cycle, the entry is “—".

Type Type of trace information acquired.
BCND: Conditional branch
BRANCH: Branch source
DESTINATION: Branch destination
BRANCH/DESTINATION: Branch source and destination
MEMORY: Operand access
STANDBY: Standby information
LOST: The corresponding trace information was lost.
If there is no type value for the given cycle, the entry is “—".
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Table 5.8 Items Shown in the [Trace] Window (cont)

Column Description

BCN Whether or not the condition for execution of a conditional branch instruction was satisfied.
1: The condition was satisfied.
0: The condition was not satisfied.
Each line can show the information on up to 15 branches.
If there is no BCN value for the given cycle, the entry is “—.

Branch Type Reserved area. The entry is “—".

Channel Indicates an event match that occurred due to operand access.
None: No operand access or the operand access did not match an event condition.
0: Event match on channel 0
1: Event match on channel 1
2: Event match on channel 2
3: Event match on channel 3
If there is no channel value for the given cycle, the entry is “—".

Time Stamp  Displays TimeStamp.

(Count) For the RX600 Series MCUSs, it is displayed in decimal, from 0 up to 19 bits.
For the RX200 Series MCUs, it is displayed in decimal, from 0 up to 23 bits.
Overflows cannot be detected.
The TimeStamp value of traces differ in count sources with each MCU.

[RX610, RX621, RX62N, RX62T Group MCUs]
If EXTAL x 8 <100 MHz

TimeStamp count frequency = EXTAL x 8
If EXTAL x 8 > 100 MHz

TimeStamp count frequency = EXTAL x 4

[RX630, RX631, RX63N Group MCUs]
When using EXTAL: ICLK (performance counters used)
When not using EXTAL:  Selected clock source x 1

[RX210 Group MCUs]
ICLK (performance counters used)

Columns of the [Trace] window can be hidden if you do not require them.

To hide a column, right-click in the header column and select the column you want to hide from the popup menu.
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5.8.3 Results of Tracing

The [Trace] window shows the results of tracing.
Trace results can be shown in one of the following display modes: bus, disassembly, source, or mixed.
The display can be switched by changing the selection of [Display Mode] in the popup menu of the [Trace] window.

(a) Bus Display Mode
Select [Display -> BUS] in the popup menu.
Per-cycle bus information is shown. The contents vary with the MCU and emulator system in use. A mixed display

of bus, disassembly, source, and data-access information is also possible.

=V
IRange' 0037229, 00000000 ] File: [Grle_—oooo00az | Bddress FEFFETAE]

Lycle Label Address ource Address | Uestination | Data ize R/ Bl Haster | Type EL] Channel | Tinetamp (Count ) ~
-nnnnnnaz2 FFFFBIAE  -------- FFFFE74E  -------- == = CFU DESTINATION -
RULTTITTER] I I I Nttt et - - CFU ECHD " -
-00000030) |_rand FFFFB306 FFFFE90E  -------- - - CPU DESTINATION -
-00000029 FFFF874E FFFFA74E  -------- 2 = CFRU DESTINATION B
RUINTITTEE] Y I I Rttt mnn = CFU ECND 3
-oooooo2?| |_rand FFFF830E FFFFE90E  -------- ---- CFU DESTINATION -
-0nnnnnzg FFFFR74E FFFFE74E  -------- SRS CFU DESTINATION -
RUITTITITEEL] I I I Rttt Lt sons CFU ECHD 2
-oooooozd] |_rand FFFFB306 FFFFE9DE  -------- ST CPU DESTINATION E
-00000023 FFFF874E FFFFA74E  -------- e CPU DESTINATION e
RUINTITTEE] I I I Rttt I ---- CRU ECND -
-oooooo2 1 |_rand FFFF830E FFFFE90E  -------- o CFU DESTINATION E
-0000nn20 FFFF87AE FFFF47AE  -------- mns CFRU DESTINATION 3
RULTITITITIRE:] I I I Nttt - CFU ECHD -
-noonon1s) |_rand FFFFBIDE FFFFRADE  -------- SR CFU DESTINATION E
-0oonont? FFFF874E FFFFA74E  -------- e CFRU DESTINATION =
RUUNTITIIET] I I I N et N = CFU ECND E
-oooooo1s| |_rand FFFF830E FFFFE90E  -------- e CFU DESTINATION E
RUIIINE FFFF87AE FFFF47AE  -------- ---- CFRU DESTINATION -
RULTITITTIRE:] I I I Nttt 2 CFU ECHD E
-noooooizf |_rand FFFFBIDE ~ -------- FFFFRADE ~ -------- SRR CFU DESTINATION = -

Figure 5.29 [Trace] Window in Bus Display Mode

1. Cycle number. Double-clicking on this area opens a further dialog box in which you can change the first cycle to be

shown in the [Trace] window.

Label for the information on the address bus.
Bus information

Range of trace information that has been acquired
Cycle number of the first line

Address of the first line

o s wD
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(b) Disassembly Display Mode
Select [Display -> DIS] in the popup menu.
Executed machine instructions are shown. A mixed display of disassembly, source, and data-access information is

also possible.

v
Range: -00137229, 00000000 File: Cycle: -00000032 Address: FFFFE7AE
Lycle Label Address Ubject Code |fInstruction ~
-nnooonaz FFFFB7&E EF1E MOV L R1.RT4
-nongona2 FFFFa7ED E7OENA MOV, L R14,28H[R0]
-0o0ona2 FFFFA7E3 EDOENA MOV, L 28HIR0].R14
-0o0gona2 FFFFA7E6 BI0E ChP H0H,R14
-onooonaz FFFFB7BS 2804 BGE.B OFFFFE7C2H
-onooonat FFFFB7C2 EF05 MOV L RO.RA
-00000031 FFFF87C4 EDOEOB MOV, L ZCHIRODLR14
-00000031 FFFFG7C? Ahe1 MOV, L 28H[R0T,R1
-00000031 FFFFa7C3 FEZES1 MOV, L RI, [R14,R5]
-00000021 FFFF87CC EDOEOB MOV, L 2CHIRO],R14
-nnnoonan FFFFBICF E21E A00 H1H.R14
-onooonst FFFFBDN E?0ENB MOV L R14,2CHIR0]
-00000031 FFFF8704 EDOENB MOV, L ZCHIROD,R14
-00000031 FFFFa7D07 B1AE ChP H04H.R14
-00000031 FFFFa704 2401 ELT.B OFFFF87AAH
-0o0000a1 FFFFa744 0620200 ESR. & _rand
-nnoooozn § | _rand FFFFBADE FB3214140000 | JMOY.L $00001414H, R3
-00000030 FFFF830C EC35 MOV, L [R31.RS
-00000030 FFFF3DE T4156D4ECE4T | HUL H41C64E5DH, RS
-00000030 FFFFB9E4 72553930 ADD 130349H,R5, RS
-00000030 FFFFE3ER E236 HOv.L RS [R2] v
—t 1 1

Figure 5.30 [Trace] Window in Disassembly Display Mode

1. Cycle number. Double-clicking on this area opens a further dialog box in which you can change the first cycle to be
shown in the [Trace] window.

2. Label corresponding to the address of the instruction.
Address of the instruction. Double-clicking on this area opens a further dialog box in which you can search for a

desired address.

4. Object code for the instruction
5. Instruction
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(c) Source Display Mode
Select [Display -> SRC] in the popup menu.
You can check the flow of execution by stepping forwards and backwards through the source code from the current
trace cycle.
The result is displayed in the window when tracing stops and cleared when tracing resumes.

5 6 7

=V bt B
Range: 00127220, 00000000 [File: Tutorial o] Byl —ooooo0s2] [ddress: FrrravaE]

(IIEE] FFFFE74E
noonsn FFFF87 44
0051 FFFFE7ES =
000052 FFFFE7BA = =0

000053 i

000054 FFFFB7C2 E alil = iz
000056 i

000056 FFFF870B = sortfal;
000057 FFFFB7E] = chanze(a):
000058

000063 FFFFB7ES 5 p_san->30=a[0];
000080 FFFFE7FO = p_sam-rsl=a1];
0000&] FFFFA7F8 = p_san->s2=al2]s

000062 | | FEFFaG00 = p_sam->si=al3];
000063 | | FEFFRG03 = p_sam-rs4=ald]:
000084 | | FFFFE&T0 E] p_sam->s6=al6]:

000065 FFFF818 = p_san->si=a 8]
0000EE FFFF820 = p_san->s7=al7]s
0000E7 FFFFa222 = p_san->s8=a[8];

000088 FFFFE830 2 p_san->38=a[8];
000083 FFFFE238 E freeip_san); w

Figure 5.31 [Trace] Window in Source Display Mode

Line number in the current source file.

Address corresponding to the line of source code. Double-clicking on this area opens a further dialog box in which
you can search for a desired address.

3. ">>"indicates the instruction corresponding to the cycle currently being referred to and "-" indicates that an address
corresponds to the line.

Source code

Name of the current source file

Currently referenced cycle

Address of the cycle currently being referred to

N o g ok
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(d) Mixed Display Modes
Two or all of the modes can be selected at the same time, providing mixed displays of bus, disassembly, and source
information.

After choosing [Display Mode -> BUS] from the popup menu, select [Display Mode -> DIS]. This produces a
mixed display of bus and disassembly modes.

In the same way, you can produce mixed displays of bus—source, disassembly—source, or bus—disassembly—source.

To revert to bus mode after viewing a bus—disassembly mixed display, reselect [Display Mode -> DIS] from the
popup menu.

=V

Range: -00137229, 00000000 |File: Cycle: -00000037 | Address: FFFFETCT

Cycle Labe| Address Source Address | Destiration | Data Size R BUS Master | Type ECH Eranch Type | Channel | TimeStamp {Caunt} ~
FFFFE7L? HOv.L HIROT,R1 |
FFFFE7LD HOv.L R1, [R14,R5]
FFFFETLE HOY.L 2CH[RO],R14
FFFFRTCF ALD #1H.R14
FFFFETD1 MOV.L R14,20H[RO]
FFFFE7D4 MOV.L 2CHRO],R14
FFFFE707 CHP finAH.F14
FFFFE70d ELT.E OFFFFE7AAH
FFFFETAL ESR. 4 _rand

-00000030  _rand FFFF8306  -------- FFFFBI0E  ------—- - CPU DESTINATION ------- --------- -
FFFFE30E  _rand HOY.L 00001414H, R3
FFFFRADC MOV.L [Ra].RE
FFFFEADE ML {141CE4ERDH, RE
FFFFEIE4 A0 {f3038H, RS, RS
FFFFE3ER HOv.L RA, [R3]
FFFFB9EA SHLR 1118, R5,R1
FFFFEIED AN I7FFFH.R1
FFFFEIF1 RTS

-000000239 FFFF87AE  -------- FFFFB7AE  -------- 2Eadi S CPU DESTINATION ------- -=------- =
FFFFRTAE MOV.L RT,
FFFF7ED HOY.L R14,28H[R0] ~

Figure 5.32 [Trace] Window for a Bus-Disassembly Mixed Display
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5.8.4 Popup Menu Options

Right-clicking in the [Trace] window opens a popup menu containing the options listed below. Most of these options

are also available as toolbar buttons.

Table 5.9 Popup Menu Options

Menu Option Description
Display Mode BUS Shows bus information.

DIS Shows disassembly information.

SRC Shows source information.

Trace Step Forward Steps forward through the source code from the current cycle
(only usable in source mode)

Step Backward Steps back through the source code from the current cycle
(only usable in source mode)

Come Forward Runs a program in the forward direction until a specified cursor position
is reached (only usable in source mode)

Come Backward Runs a program in the reverse direction until a specified cursor position
is reached (only usable in source mode)

Stop*1 Only usable when trace data are being acquired during user program
execution. This option stops tracing and updates the display of trace
information (and is not usable in the internal trace mode).

Restart*! Restarts trace acquisition. It works only when trace acquisition has
been halted temporarily during the user program execution.

Not usable in the internal trace mode.
Find Find... Opens the [Find] dialog box, which is used to search for specific trace
data.

Find Previous Searches for a preceding cycle that matches the pattern specified for
[Find].

Find Next Searches for a subsequent cycle that matches the pattern specified for
[Find].

Auto Filter Enables or disables automatic filtering
Acquisition... Opens the [Trace conditions] dialog box, in which you can set trace conditions.
Layout... Opens the [Layout] dialog box, in which you can select whether each of the columns should be

shown or hidden.
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Table 5.9 Popup Menu Options (cont)

Menu Option

Description

File Edit Source

Opens the current source file in the [Editor] window.

Display Source

Select a source file you want to view in source display mode. A file
selection dialog box will be opened.

Save

Saves trace data in a file. You can select binary or text as the format in
which the data will be saved. When you select binary format, data for all
cycles are saved. When you select text format, the contents of the
[Trace] window are saved. In text format, you can also save data for a
specified range of cycles.

Furthermore, trace data can be saved in tab-separated format (if bus,
disassembly and source information coexist as in a mixed mode
display, the bus display is tab-separated and disassembly and source
displays are space separated).

Load

Loads trace data that have been saved. Only files saved in binary
format can be loaded.

Toolbar display Shows or hides the toolbar.

Customize Used to customize toolbar buttons.
toolbar

Allow Docking Docks the window.

Hide Hides the window.

Note: 1. Since the RX200 Series MCUs support only internal traces, this option menu cannot be used.
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5.8.5 Setting Trace Conditions

Since the size of the trace buffer is limited, the oldest trace data is overwritten with new data after the buffer has
become full.

You can set trace conditions to restrict the acquired trace information to that which is useful, thus more effectively
using the trace buffer.

To set trace conditions, use the [Trace conditions] dialog box that is displayed when you choose [Acquisition] from the
popup menu of the [Trace] window.

Note that the trace capacity and the trace conditions you can set differ with each MCU. Refer to Table 4.3, “List of
Functional Specifications by Target MCU.”

(a) Selecting the Trace Mode
Start by selecting the trace mode.

Trace Setking

EP
Trace Mode: | Fill until Skap

Trace Output:  |CPU execution

Trace Type:  |Branch

Lol LefLef L |

Trace Capacity: |1M Byte

Advanced. ..

I

Figure 5.33 [Trace conditions] Dialog box

The following four types of trace condition can be set in the [Trace Setting] section.

Table 5.10 Trace Conditions

Parameter Description
Trace Mode Select the trace mode.
Fill until stop The acquisition of trace data continues until the program stops or an event selected to stop
tracing occurs.
Fill until full The acquisition of trace data stops when the trace buffer becomes full.
Trace Output*1 Select the trace-output mode.

CPU execution ~ CPU execution is given priority. Some trace data may be lost.

Trace output Tracing is given priority. CPU execution stops for the output of trace data, so this affects the
realtime operation.
Do not output The trace buffer in the MCU will be used (i.e. no trace data are output).
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Table 5.10 Trace Conditions (cont)

Parameter Description
Trace Type Select the type of trace data.
Branch [RX600 Series MCUs]

Branch + Data
Data

Branch(Src)
Branch(Src) + Time
Data + Time

Branch

Traces source and destination address information on branch
processes that occurred during program execution.

Branch + Data

Branch and data-access information is acquired.

Data

Traces data information on events that occurred during
program execution.

[RX200 Series MCUs]

Branch Traces source and destination address information on branch
processes that occurred during program execution.

Data*? Traces data information on events that occurred during
program execution.

Branch(Src) Traces only the source address information on branch

processes that occurred during program execution.

Branch(Src) +
Time

Traces source address information and timestamp on branch
processes that occurred during program execution.

Data + Time*?

Traces data information and timestamp on events that
occurred during program execution.

Trace Capacity*®

Select the capacity of the trace buffer.

1,2,4,8,16,0r32
Mbyte

1,2, 4,8, 16, or 32 Mbytes

Notes: 1. For the RX200 Series MCUSs, this parameter is grayed out and a remark “Do not output” is displayed.
2. For the RX200 Series MCUs, only the data accesses that you set in trace extraction conditions can be traced.
3. For the RX200 Series MCUs, this parameter is grayed out.

Clicking on the [Advanced...] button on the [Trace] page opens the [Advanced Setting] dialog box, in which items to
be shown in the [Trace] window can be selected. Select the checkboxes for the types of information that you wish to

view in the [Trace] window.

Advanced Setting

Displayed trace information

3

[1Time starnp
[“Ichannel number

Data Access information

[wData transfer
[w]Stack operation
[w]String operation

[wlLogical aperation
[wIBit operation
MIFPL
[WIException

[w]arithmetical operation

Cancel |

Figure 5.34 [Advanced Settings] Dialog box
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(b) Setting Trace Conditions

You can set the conditions for starting and stopping trace acquisition, as well as the condition for extracting
information from the trace acquisition. When no trace conditions are set, program execution is traced from when it
started till when it stops.

condition and combination setting
Trace Stark Poink (5P

{* Go programm ¢~ Start
e condition: J 4

Eventinuse: 0

Trace Stop Point (EP)

{* Break program " Stop condition: R
Eventinuse: O

Recording Condition

* Al data " Capture condition:  OR

Eventinuse: 0

Figure 5.35 [Trace conditions] Dialog box
Trace conditions are of the three types described in the table below.

Table 5.11 Types of Trace Conditions

Iltem Description
Trace Start The trigger to start trace acquisition can be specified by a combination of events.
Point (SP) If no trace acquisition start conditions are set, trace acquisition starts at the same time the
program starts.
OR The trace acquisition start condition is met when any of the set events
occurs.
AND (cumulative) The trace acquisition start condition is met when all of the set events

occur irrespective of the time base.

Sequential The trace acquisition start condition is met when the set events occur in
a specified order.

RX600 Series MCUs:

7 steps (forward direction) + reset point (R)**
RX200 Series MCUs:

3 steps (forward direction) + reset point (R) **

Trace Stop The trigger to stop trace acquisition can be specified by an event (“OR” only).

Point (EP) If no trace acquisition stop conditions are set, trace acquisition stops at the same time the

program stops.

Recording The trigger to extract trace information can be specified by an event (“OR” only).
Condition**

Notes: 1. Reset point (R): When the event that is set at a reset point occurs, all of the events that have occurred up to
that time are cleared.

2. For the RX200 Series MCUs, this is grayed out when trace condition (OR) is specified.
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The selected trace mode (“fill until stop” or “fill until full’) and whether or not trace conditions have been set
determine the period of tracing. The differences are shown below.

Mo trace points Atrace-start point Atrace-stop point Trace-start and
areset g set iz set stop points are set
Fill urtil [Eillartil Fill until FRISERE Fill urtil PRINSSRE Fill until [Eillartil

stop full stop full stop full stop full

Execution starts

Trace-start point is encountered

Trace-stop point is encounterd

v

E xecution stops

Figure 5.36 Differences between Trace Modes and Trace Condition Settings

(c) Saving/Loading Trace Settings
1. Saving trace settings
Click on the [Save] button of the [Trace conditions] dialog box. The [Save] dialog box will be displayed.
Specify the name of the file where you want the trace settings to be saved. The file-name extension is ".tev". If
this is omitted, the extension ".tev" is automatically appended.
2. Loading trace settings

Click on the [Load] button of the [Trace conditions] dialog box. The [Load] dialog box will be displayed.
Specify the name of the file you want to load.

When you load a file, the previous trace settings are discarded and the new settings appear in the dialog box.

Click on the [Apply] button of the [Trace conditions] dialog box to activate the new trace settings you have
loaded.

R20UT0399EJ0401 Rev.4.01 Page 126 of 210
Jul 01, 2011 RENESAS



E1/E20 Emulator Section 5 Emulator Functions

5.8.6 Saving Trace Information in Files

To save trace information in a file, choose [File -> Save] from the popup menu or click on the [Save] toolbar button
(). The trace information displayed in the [Trace] window is saved in a binary or text format.

(a) Saving in the Binary Format
To save trace information in the binary format, choose [Trace Data File: Memory Image (*.rtt)] in the [Save As
Type] list box of the dialog box that is displayed when you choose [File -> Save] from the popup menu.
When information is saved in the binary format, information for all cycles is saved. This type of file can be loaded
back into the [Trace] window.

(b) Saving in the Text Format
To save trace information in the text format, choose [Text Files: Save Only (*.txt)] in the [Save As Type] list box of
the dialog box that is displayed when you choose [File -> Save] from the popup menu.
When information is saved in the text format, saving of information for a range of cycles can be specified. This type
of file can only be saved and cannot be loaded back into the [Trace] window.

5.8.7 Loading Trace Information from Files

To load trace information from a file, choose [File -> Load] from the popup menu or click on the [Load] toolbar button
). Specify a trace information file that was saved in the binary format. The current results of tracing are overwritten.
Before loading a file saved in the binary format, switch to the trace mode in which the saved trace information was
acquired. This switching should be performed in the [Trace conditions] dialog box that is displayed when you choose
[Acquisition] from the popup menu of the [Trace] window.

Trace information files saved in the text format cannot be loaded back into the [Trace] window.

5.8.8 Temporarily Stopping Trace Acquisition

To temporarily stop the acquisition of trace information during user program execution, choose [Trace -> Stop] from
the popup menu of the [Trace] window or click on the [Stop] toolbar button (]El).

Trace acquisition will be stopped, with the trace display updated. Use this function when you only want to stop
acquisition and check the trace information but not to stop program execution.

5.8.9 Restarting Trace Acquisition

If you want to restart trace acquisition after it has temporarily been stopped during user program execution, choose
[Trace -> Restart] from the popup menu of the [Trace] window or click on the [Restart] toolbar button (E|).
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5.9 Measuring Performance

59.1 Measuring Performance

The performance measurement facility of the emulator is capable of measuring the total times execution takes and the
number of passes for each of up to two specified sections of the user program, and of showing the time and number of
cycles taken by execution.

The performance-measurement counter in the MCU is used to measure performance in overall execution (i.e. from [Go]
to [Stop]) or between a start event and an end event. It is also possible to restart performance measurement while the
user program is running. Instruction-fetch events, data-access events, and combination of both are specifiable as the
start event and end event.

Since this facility uses the emulator’s performance measurement circuit to measure the execution time, it does not
impede execution of the user program.

Performance measurement conditions cannot be manipulated during program execution.

For the RX600 Series MCUSs, select one of the following 11 items as the target for measurement: [Not use], [Execution
cycle], [Execution cycle (supervisor mode)], [Exception and interrupt cycle], [Exception cycle], [Interrupt cycle],
[Execution count], [Exception and interrupt count], [Exception count], [Interrupt count], and [Event match count].

You can also choose whether two 32-bit counters (ch. 0 and ch. 1) should be used separately or handled in combination
as a 64-bit counter.

For the RX200 Series MCUs, measurement is possible for only elapsed cycles, with a 24-bit counter x 1 ch supported.
For functional specifications, refer to Table 4.3, “List of Functional Specifications by Target MCU.”

59.2 Viewing the Results of Performance Measurement

Results of measurement are displayed in the [Performance Analysis] window.

To open the [Performance Analysis] window, choose [View -> Performance -> Performance Analysis] or click on the
[Performance Analysis] toolbar button (. The [Select Performance Analysis Type] dialog box appears. Click on the
[OK] button.

select Performance Analyvsis Type

Performance Analysis: Perfarmance

Cancel

Figure 5.37 [Select Performance Analysis Type] Dialog Box
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The [Performance Analysis] window appears.
Right-click on the window and select [Set] from the popup menu to open the [Performance] dialog box, in which you
can select events for use and set other conditions for performance measurement.

After setting performance-measurement conditions in the [Performance] dialog box, click on the [OK] button to execute
the user program. When execution stops, the [Performance Analysis] window will show the execution time and number
of cycles taken by code satisfying the conditions you have set.

Any unnecessary columns in the [Performance Analysis] window can be hidden.

To hide any column, right-click in the header column and select the column you want to hide from the popup menu.

To view any hidden column, reselect that column from the popup menu again.

#* Performance Analysis

;
No | Condition Tite (him:3.ws.us.n3) Count [Decimal)
Not use T IRt T T T, T -
Z Not use LTIt T T T -
Figure 5.38 [Performance Analysis] Window
R20UT0399EJ0401 Rev.4.01 Page 129 of 210

Jul 01, 2011 RENESAS




E1/E20 Emulator Section 5 Emulator Functions

The columns in the [Performance Analysis] window are listed below.
Table 5.12 Columns in the [Performance Analysis] Window

Column

Description

No

Number set up in the [Performance] dialog box.
[RX600 Series MCUs]

Displays 1 and 2 when a 32-hit counter is used for each of two ranges or 1 when the two 32-hit
counters are handled as a 64-bit counter for measurement of performance in a single address
range.

[RX200 Series MCUs]
Displays only 1 with a 24-bit counter.

Condition

Target for measurement selected in the [Performance] dialog box.

[RX600 Series MCUs]

e Notin use: [Not use]

e Number of cycles that have elapsed: [Execution cycle]

o Number of cycles that have elapsed in supervisor mode: [Execution cycle (supervisor mode)]

e Number of cycles of processing for interrupts or other exceptions: [Exception and interrupt
cycle]

o Number of cycles of processing for exceptions: [Exception cycle]

o Number of cycles of processing for interrupts: [Interrupt cycle]

e Number of valid instructions issued: [Execution count]

o Number of interrupts and other exceptions accepted: [Exception and interrupt count]

o Number of exceptions accepted: [Exception count]

e Number of interrupts accepted: [Interrupt count]

e Number of event-condition matches: [Event match count]

[RX200 Series MCUs]

e Number of cycles that have elapsed: [Execution cycle]

Time

(h:m:s.ms.us.ns)

Cumulative total of measured execution times.
[RX600 Series MCUs]

e When the target for measurement is [Execution cycle], [Execution cycle (supervisor mode)],
[Exception and interrupt cycle], [Exception cycle], or [Interrupt cycle]:
Displays count in terms of time. Cumulative time calculated from the frequency specified by the
user and the value in the [Count] column.
Note that if the calculated value is 65,536 hours or more, this is displayed as
0hOmMOsOmMsOusOns.

e When the target for measurement is [Execution count], [Exception and interrupt count],
[Exception count], [Interrupt count], or [Event match count]:
Displays "---:---1--.-- ===, ==- -=-",
[RX200 Series MCUs]

¢ Displays count in terms of time.
Cumulative time calculated from the frequency specified by the user and the value in the
[Count] column.
Note that if the calculated value is 65,536 hours or more, this is displayed as
0hOmO0sOmsOusOns.

Count(Decimal)

Decimal value indicating the number of times measurement for the section has proceeded. When
the counter has overflowed, "overflow" is displayed.
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5.9.3

Setting Performance Measurement Conditions

In the [Performance Analysis] window, select the line of a section number to use for the condition and choose [Set]

from the popup menu.

The [Performance] dialog box will be displayed.

I Performance

1

&dd event From Function information

l2 |
Caondition: |Executian cycle j
Caunk Start Event [CR]
Ewent | Tvpe | Contents | Counk | C.l C..| | Add...
[Aevot  PC [Address] _sort a Delste
Browse, .,
Count Stop Event [OR]
Eventk | Twpe | Conkents | Counk | C.l C..| Add...
[Fevwoz pc [address] FFFFS70C 1 Delete
Browse, .,

File name: |sart.c

j Browse, |

Function namme: |sc|rt

[

Add to startfstop esvent |

[ Display the cycle as time span, [MHz]

[ Measure the perfarmance only once.

PC: 2 PCi 6
Event used o0& 0 Free O 4

Save... | Load...

[ Use &4 bit counter

Reqistered events. ..
Close

Figure 5.39 [Performance] Dialog Box

[*] after the title in the title bar of the [Performance] dialog box indicates that the settings have not been activated yet.

When you click on the [Apply] button to activate the settings, [*] in the title bar will disappear.
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(a) Setting Measurement Conditions

For the RX600 Series MCUs, measurement of performance in up to two address ranges is possible by using a 32-bit
counter for each range.

Alternatively, the two 32-bit counters can be handled as a 64-bit counter for measurement of performance in one
address range. When the 64-bit counter for a single range is selected, the settings for the other range become invalid.

For the RX200 Series MCUs, measurement is possible in only 1 section using a 24-bit counter.
Select one measurement mode for one range.
Events are used to define these ranges.

Table 5.13 Measurement Modes

Target for Measurement Description

None: [Not use] Measurement is disabled.

Number of cycles: Between two events

[Execution cycle]

[Execution cycle (supervisor Count Start Event [OR]

mode)] Event | Type | Cantents | court | 2] Add...
[Exception and interrupt cycle] Blevot  po [Address] sort ) i g
[Exception cycle]

[Interrupt cycle] Browse. ..
Number of times specified Count Stop Event [OR]

processing is performed: Event | Type | Contents | court | o) add...
[Execution count] Blevoz  pc [Address] FFFFEFOC - 1 e
[Exception and interrupt count] | —
[Exception count] Browse. ..

[Interrupt count]

Figure 5.40 Between Two Events

Measurement is performed between the start event and the end event.

Specifically, the number of cycles or number of times in the range between
the start event and the end event is measured.

Measurement of the number of cycles starts when the start event occurs and
is suspended when the end event occurs.

The number of times is measured as the number of passes between the start
event and end event that specify the range.

[Count Start Event]: One or multiple events can be set. If no events are set,
measurement starts with execution of the program.

[Count Stop Event]: One or multiple events can be set. If no events are set,
measurement stops with execution of the program.
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Table 5.13 Measurement Modes (cont)

Target for Measurement Description

Number of times the event
has occurred:
[Event match count]

Number of times the event has occurred

Select Event

I E
Condition: |Event rnatch counk ~|
( Details for event match ]
Count Start Event [OR]
Evvent | Type | Conkents | Count J C.| C..l | Add...
[FlEvor  PC [Address] _PowerOh... 0 Delete
[Flevos  PC [Address] _sork 2 —_—
Browse. ..
Caunt Stop Event [OR]
Event | Tyvpe | Cankents | Caunt J C.| C..l Add...
[Flevoz  PC  [Address] FFFFE045 - 1 e
[Flevo4  Pc [Address] FFFFE70C 3 _—
Browse. ..

Event | Tvpe |Contents

] Count | C.| Comments |

Oevor  pPC

[Address] _PowerQn. ..
[Address] FFFFE045

[Address] _sort
[Address] FFFFE70C

-

E

0

=]

Cancel |

Save... | Load...

Apply Close

Figure 5.41 Number of Times the Event Has Occurred

The number of times a specific event has occurred is measured between the

start event and the end event.

[Count Start Event]: One or multiple events can be set.

[Count Stop Event]: One or multiple events can be set.

The event-match counting conditions must be selected from among events
specified as trace, on-chip break, or performance-measurement conditions.

Click on the [Details for event match] button to open the [Select Event] dialog

box and specify the event for which

the number of times is to be measured.
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Table 5.13 Measurement Modes (cont)

Target for Measurement

Description

Number of times the event
has occurred:
[Event match count]

Events specified in event-match count measurements are placed in a shared state.
The events in a shared state cannot have their enable or disable settings changed.

Some of such events may be placed out of the shared state by an event-related
operation, becoming an independent event for event-match count measurements.

To remove an independent event used in event-match count measurements,
uncheck the specified event’s checkbox in the [Select Event] dialog box and be sure
to change its settings in the [Performance] dialog box to update its state.

The specified event goes out of the screen at the same time its checkbox is
unchecked above.

Note that cancellations thereafter are unaccepted.

The [Select Event] dialog box may have multiple events with the same name
displayed in it.

Note: To measure the execution time of a function, use [Between two events]. Specify execution of the instruction at
the first address of the function as the start event and execution of the instruction at the exit point of the function
(point corresponding to the line containing the function’s return statement) as the end event. If there is more
than one exit point, set a fetch condition that covers each of them as the end event.
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(b) Measurement Item

Table 5.14 shows the items selectable for measurement through the performance measurement function. The
selected name is displayed under [Condition] in the [Performance Analysis] window.

Table 5.14 Measurement List Item

Condition

Selected Item

Not use

No item for performance analysis has been set.

Execution cycle

The number of cycles (ICLK) elapsing within the specified interval has been set
as the item for measurement.

Execution cycle (supervisor mode)

The number of cycles (ICLK) of execution in supervisor mode has been set as the
item for measurement.

Exception and interrupt cycle

The number of cycles (ICLK) for the execution of interrupt processing and other
exception processing has been set as the item for measurement.

Exception cycle

The number of cycles (ICLK) for the execution of exception processing has been
set as the item for measurement.

Interrupt cycle

The number of cycles (ICLK) for the execution of interrupt processing has been
set as the item for measurement.

Execution count

The number of instruction for which execution is completed has been set as the
item for measurement.

Exception and interrupt count

The number of accepted interrupts and other exceptions has been set as the item
for measurement.

Exception count

The number of accepted exceptions has been set as the item for measurement.

Interrupt count

The number of accepted interrupts has been set as the item for measurement.

Event match count

The number of times the event condition is matched has been set as the item for
measurement.

The exception and interrupt cycle on the performance measurement have the following exception event of the MCU.

[Exception]

e Undefined instruction exception
e  Privileged instruction exception

o  Floating-point exceptions

e Unconditional trap (INT instruction BRK instruction)

[Interrupt]

e Non-maskable interrupt
e Interrupts (maskable)

e Reset
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(c) Adding Events from Data on Functions**
The start and end events can be selected from data on functions in a source file. Click on the [Browse] button and
select a source file. Then select a function and click on the [Add to start/stop event] button. The first and last
addresses of the specified function will then be executed as the start and end events.

Note: 1. The start and end events are the first and last addresses of the specified function. Measurement does not
proceed correctly if the last address is not the exit (generally an RTS instruction) of the function. When the
location where the function ends does not correspond to the exit from the function, manually specify the exit
as the end event.

(d) Displaying Time Information
If “cycle” is selected for [Condition] as the measurement item in the [Performance] dialog box and the [Display the
cycle as time span] checkbox is checked, the time information calculated from the frequency you input in the
frequency edit box and the count value resulting from performance measurements is displayed.
The range of input values is 0.0001 to 999.999. If any value exceeding this range is input, an error message is
displayed.
Note that input values are effective in up to 6 digits, so that when the integer part consists of 2 digits or less,
fractions below 4 decimal places are truncated, and that if the integer part consists of 3 digits, fractions below 3
decimal places are truncated.

@isplay the cycle as time span. |IZI.IIIIIIIIII [MHz]
[ Measure the performance only once,

Figure 5.42 Displaying Time Information

594 Starting Performance Measurement

When the user program is run, performance measurement is automatically started according to the conditions set on
performance measurement.

When the user program is halted, the results of measurement are displayed in the [Performance Analysis] window.
When execution of the user program is halted and then restarted without changing the conditions of measurement, the
newly measured times are added to the previous values.

To perform the measurements afresh, clear the results of measurement by selecting [Clear Data] from the popup menu
before running the program.

Also, if the [Measure the performance only once] checkbox is checked, the measured time of re-executions is not added
to the previous measured time, and measurement results are displayed separately for each execution performed.

5.9.5 Clearing Performance-Measurement Conditions

Select the measurement condition you want to clear in the [Performance Analysis] window and then choose [Set] from
the popup menu to display the [Performance] dialog box. In the [Performance] dialog box, disable the condition you
want to clear.

M Performance

to ]z |

Condition: |N|:|t use ﬂ

Figure 5.43 Clearing Performance-Measurement Conditions
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5.9.6 Clearing Results of Performance Measurement

In the [Performance Analysis] window, select the section corresponding to the results you want to clear and then choose
[Clear Data] from the popup menu. The results of measurement for the selected section will be cleared.
To clear all results of measurement, choose [Clear All Data] from the popup menu.

5.9.7 Maximum Number of Rounds of Performance Measurement

For the RX600 Series MCUSs, two 32-bit counters are used for performance measurement. While the 32-bit counters are
in use for measurements in two address ranges, the maximum number of rounds for measurement is 4,294,967,295.
When the counters are handled as a 64-bit counter, on the other hand, the maximum number of rounds for measurement
is 18,446,744,073,709,551,615.

For the RX200 Series MCUSs, a 24-bit counter is used for performance measurement. The maximum number of rounds
for measurement is 16,777,215.

If the counters overflow during measurement, “overflow” appears in the [Performance Analysis] window.

To handle the counters as a single 64-bit counter, select the [Use 64-bit counter] checkbox in the [Performance] dialog
box.

5.9.8 Saving/Loading Performance-Measurement Settings

(a) Saving Performance-Measurement Settings
Click on the [Save] button of the [Performance] dialog box. The [Save As] dialog box will be displayed.

Specify the name of the file where you want the performance-measurement settings to be saved. The file-name
extension is ".pev". If this is omitted, the extension ".pev" is automatically appended.

(b) Loading Performance-Measurement Settings
Click on the [Load] button of the [Performance] dialog box. The [Open] dialog box will be displayed. Specify the
name of the file you want to load.
When you load a file, the previous performance-measurement settings are discarded and the new settings appear in
the dialog box.
Click on the [Apply] button of the [Performance] dialog box to activate the new performance-measurement settings
you have loaded.
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5.10  Viewing Memory Data in Real Time
5.10.1 RAM Monitoring

Use the [RAM Monitor] window to monitor data in memory while the user program is running.

The RAM monitoring function permits recording and inspection of the data in an area of memory for which monitoring
has been assigned and the states of access in real time without obstructing execution of the user program.

The [RAM Monitor] window shows the access states (read, written, data lost, or error detection) in different colors.
RAM monitoring is only available with the E20 because this facility utilizes the external trace-output function.

To enable RAM monitoring, select [Realtime RAM monitor] under [Switching function] in the [Configuration
Properties] dialog box.

Configuration Properties

Internal flazh memory overwrite ] External flash memaory ]
ML Syztem

Smitching function
" Trace conditions
s Healtime BEAM monitor

Figure 5.44 [Configuration Properties] Dialog Box

However, some trace functions are not usable while [Realtime RAM Monitor] is selected. The following table shows
the restrictions on the trace functions.

Table 5.15 Restrictions on Trace Functions

Function Restriction
Events Events are only specifiable for [Extract]. Events for [Trace
Start] and [Trace Stop] are not selectable.
[Trace Mode] The selection is fixed to [Fill until stop].
[Trace Type] The selection is fixed to [Data].
[Trace Capacity] The selection is fixed to [1 MB].
[Displayed trace information] in the [Time stamp], [Stack pointer], and [Channel number] are not
[Advanced Setting] dialog box selectable.
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5.10.2  Allocating Blocks for RAM Monitoring

Monitoring of up to 4096 bytes of RAM is possible.

This can be a desired contiguous address range or up to four blocks of 1024 bytes.

During monitoring of the selected blocks of RAM, trace data on all access to memory are output and some trace data
may be lost. To minimize the range to be monitored, you can use events to extract trace data for output. For details,
refer to section 5.10.5, Preventing Loss of Data.

Blocks for RAM monitoring are allocated via the [RAM Monitor Area Setting] dialog box.

Select [View -> CPU -> RAM Monitor] to open the [RAM Monitor] window. Clicking on the [RAM monitor area
setting] toolbar button opens the [RAM Monitor Area Setting] dialog box.

RAM Monitor Area Setting

BEAM Maonitar Settine: fdd...

Modify...
Delete

Delete All
Load..

Save..

3 of 4 blocks (0xC00 bytes) are available.

< 1block = D400 bytes >

Figure 5.45 [RAM Monitor Area Setting] Dialog Box
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(a) Adding Blocks for RAM Monitoring

Clicking on [Add] opens a dialog box in which you can specify a range of addresses to indicate a block for RAM
monitoring.

Each block is 1024 bytes in size. Even if you specify a range that is smaller than 1024 bytes, the emulator allocates
the 1024-byte space beginning from the specified address.

If the specified range of addresses is greater than 1024 bytes, on the other hand, the emulator automatically allocates
two or more blocks as required.

Note that if this process is executed during user program execution, the realtime capability of the RAM monitor is
lost because a memory read cycle occurs.

(b) Modifying the Addresses of Blocks
Select the block that you wish to modify and click on [Modify].
This opens a dialog box in which you can modify the addresses that indicate the block.

Note that if this process is executed during user program execution, the realtime capability of the RAM monitor is
lost because a memory read cycle occurs.

(c) Deleting Blocks
Select the block that you wish to delete and click on [Delete].
To delete all blocks listed in the [RAM Monitor Area Setting] dialog box, click on [Delete All].

(d) Saving the Settings of Memory for RAM Monitoring
Clicking on [Save] opens the [Save As] dialog box.
Specify the name of the file where you wish the settings to be saved.
The filename extension is ".rbi", and this is automatically appended even if it was omitted in the dialog box.

(e) Loading the Settings of RAM-Monitoring Blocks
Clicking on [Load] opens the [Open] dialog box.
Specify the name of the file.
When a new file is loaded, the previous settings for RAM monitoring are discarded.
Clicking on [Apply] activates the new settings that have been loaded.
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5.10.3  Viewing RAM Monitoring Information

To open the [RAM Monitor] window, select [View -> CPU -> RAM Monitor] or click on the [CPU] toolbar button
(&)

«* RamMonitor [000016B0]

t EBEDxXXE p mmmzm 65040 8 2 mdBH I £ 2

[ &00ms] Label H O+ 43 +4 +9 +4 4B +£  +F | ASCII FS
annn1ego 3
Q0001620 —
00001600

Q00016ED

nnnn1eaFn

anan17oon

oo

anon1veon By EZ 00 00 BE B1 OO0 00 BF 27 00 00 BF 27 00 0O

aooo173o 0% 00 00 00O 08 14 00 00 47 87 FF FF 3D 80 FF FF ...........

nnnn174n a4 D1 4C 9F o8& 23 Y1 OFY OFA DB 01 BE AR O1E 0D RO ..... fa....

00001750 18 D0 FF FA CO C4 F3 &B E3 FF CI 47 BF EF EO OC ........... bt

Figure 5.46 [RAM Monitor] Window

Access states are indicated by different background colors according to the access attribute as listed below.

The access attributes "read" and "written" indicate the last access to each memory location.

The contents of the [RAM Monitor] window are acquired from bus access by the CPU. Therefore, changes made to
memory areas that are not readable or writable by the user program (e.g. by another device reading from and writing to
external memory) or by the DTC or DMA are not reflected in the [RAM Monitor] window.

If the data displayed in blocks for RAM monitoring are not in 1-byte units of length, the memory access attribute for the
data may differ from byte to byte. If access attributes for a single datum differ in this way, the datum is enclosed in
parentheses when displayed in the window. The background color in this case indicates the access attribute for the first
byte of that data.

(0001) E4BF 84BA 399F 68AD
The display updating interval may be longer than the specified interval due to operating conditions (those listed below).
e Performance of and load on the host machine

e Communications interface
o Window size (memory display range) and the number of windows being displayed

Table 5.16 Access Attribute and Background Color

Access Attribute Background Color
Read Green
Written Red
When error detected Uninitialized memory Yellow
(Not-write-accessed area was accessed for read)
Unreferenced memory Sky blue
(Write-accessed area was not accessed for read)
No access White
No access since some data were lost Gray
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(a) Setting the Update Interval for RAM Monitoring
Choose [Update Interval Setting] from the popup menu of the [RAM Monitor] window, or click on the tool bar
button (% ). The [Update Interval Setting] dialog box shown below will appear.

Update Interval Setting @

Interval (10 - 10000msec : 10msec unit):

lﬁ mEes
2k | Cancel |

Figure 5.47 [Update Interval Setting] Dialog Box

A separate update interval can be specified per [RAM Monitor] window. The initial value is 100 ms.

(b) Setting uninitialized area detection

Selecting [Uninitialization Detection Setting...] from the popup menu of the [RAM monitor] window or clicking on
the toolbar button ( J= ) brings up the [Uninitialized area detection] dialog box.

If a memory area registered for uninitialized area detection in this dialog box is accessed for read while it has not
been write-accessed, the area is determined to be “uninitialized” and highlighted in yellow for error output. Also, if
a registered memory area is not accessed for read even once after it has been write-accessed, the area is determined
to be “unreferenced” and highlighted in sky blue for error output.

The memory areas registered for uninitialized area detection are also displayed as “Uninitialization” in the registered
list of the [RAM Monitor Area Setting] dialog box.

Note that no areas can be set for uninitialized area detection while the user program is under execution.

Uninitialized area detection

Address areas:

Mo. | Start Address - End Address | Label Add..
0001 - 00000400 - 0000041 F

Modify .
Delete
Delete Al
Load..

Save..

o]

Cancel

If addres= areas are added, the trace output mode i= chaneed into
“Trace output”. If all address areas are deleted, the trace output mode is
changed into “GPU execution”.

Figure 5.48 [Uninitialized area detection] Dialog Box
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e Adding an error detection area
To register a new error detection area, click the [Add...] button.
The [Uninitialized area detection condition] dialog box is displayed.
Register an area for which you want errors detected by specifying a section name, data name or an address
range.

Uninitialized area detection condition

X
" Zection | =l
=

" Data Mame |

Start Address: |DDDDDDDD ﬂ

End Address: 00000000 |
ITI Cancel |

Figure 5.49 [Uninitialized area detection condition] Dialog Box

e Altering an error detection area
Select a registered error detection area and click on the [Modify...] button.
The [Uninitialized area detection condition] dialog box appears.

e Deleting an error detection area
Select a registered error detection area and click on the [Delete] button.
To delete all of the registered error detection areas, click the [Delete All] button.

e Loading the set content of an error detection area
Click on the [Load...] button of the [Uninitialized area detection] dialog box.
The [Open] dialog box appears.
Specify a file name that you want to load.
When this file is loaded, previous settings of an error detection area are destroyed and the area has its settings
reset with the loaded content.

e Saving the set content of an error detection area
Click the [Save...] button of the [Uninitialized area detection] dialog box.
The [Save as] dialog box appears.
Specify a file name to which you wan to save. The file name extension is “.uni.” If it is omitted, the extension
“.uni” is added.
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(c) Displaying Error Detection
Select [Error Detection Display] from the popup menu of the [RamMonitor] window or click the toolbar button
([7])- The detection ranges that you registered in the [Uninitialized area detection] dialog box are displayed in

extracted form in the [Ram Monitor] window. At this time, the access types, read or write, are not displayed.

«# RamMonitor [000003E0]

+ EBREDO®®E oz 6 WAl 8 2 aedddh el a
[ 109ms] Label 40 +1 42 3 +4 45 +E 47 48 43 44 +B 4+C 4D +E  4F | ASCII ~
000003ED
000003F0
00000400 00 00 00 00 DO 00 OO 04 OO0 00 00 00 0O 00 00 00 .eeevvwcmecnnnn
00000410 00 00 00 00 DO 00 OO 00D OO 00 00 00 00 00 00 00 .eveenewcmecnnns
00000420 00 1E 11 11 22 22 33 93 44 44 BR BE BB BB 7Y 7V ....7Y3ODDUUTfww
00000430 88 898 99 93 A% A BB BB CC CC DD DD EE EE FF FF .vivevieucncnens
00000440
00000450
00000460 v

Figure 5.50 [Ram Monitor] Window (Error Detection Display)

(d) Clearing Error Detection Information
Selecting [Error Detection Clear] from the popup menu of the [RamMonitor] window or clicking the toolbar button
(¥@) clears information on all of the detected uninitialized memory and unreferenced memory in the RAM monitor
area.
If this process is executed during user program execution, the realtime capability of the RAM monitor is lost
because a memory read cycle occurs.

(e) Clearing RAM monitoring access history
Choose [Access Data Clear] from the popup menu of the [RAM Monitor] window or click on the tool bar button

(E). The history of all access to the RAM monitoring area will be cleared.
If this process is executed during user program execution, the realtime capability of the RAM monitor is lost
because a memory read cycle occurs.

5.10.4 When Some Trace Data are Lost

If some trace data are lost, the information shown in the [RAM Monitor] window does not match the actual data in
memory. The emulator cannot identify which part is missing.

When data are missing, the whole area that is displayable in the window is grayed-out (this indicates that some data
have been lost). Display subsequently resumes when data are again output without loss.

If data loss occurs within a period that is shorter than the interval for updating of the [RAM Monitor] window, the
window may constantly be grayed out. In this case, refer to section 5.10.5, Preventing Loss of Data.
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5.10.5 Preventing Loss of Data

The two ways of preventing loss of data accessed during RAM monitoring are described below.

(a) Trace-Output Priority Mode
Select [View -> Event -> Trace Conditions] to open the [Trace conditions] dialog box and select [Trace output]
(trace-output priority mode) for [Trace Output]. None of the data will be lost during RAM monitoring, but operation
in the [Trace output] mode is not necessarily realtime because the emulator gives priority to the output of trace data
and thus may temporarily suspend the CPU.

(b) Extraction of Trace Data
With the settings made in section 5.10.2, Allocating Blocks for RAM Monitoring, trace data on all access to
memory are output. For this reason, when data from any location are lost (even if the location is not included in a
block specified for RAM monitoring), the [RAM Monitor] window will indicate the loss.
To reduce the possibility of data loss, use events to extract trace data for output because this can minimize the range
to be monitored. Note that a range of data that does not fit in the monitor range of the [RAM Monitor] window is
displayed in gray.
While the realtime characteristic of operation is not affected, the range of RAM monitoring is smaller. No further
measures for prevention are available, however, if data access to the specified range is still so frequent that data are
being lost.
Conditions for the extraction of trace data can be set in the [Trace conditions] dialog box that is opened by selecting
[View -> Event -> Trace Conditions]. An example is given on the following page.

Example:

To monitor data in the range from 0x1700 to 0x171F, add the range from 0x1400 to Ox17FF as a block for RAM
monitoring by the method described in section 5.10.2, Allocating Blocks for RAM Monitoring. Then specify the
extraction of trace data so that only trace data for the range from 0x1700 to 0x171F will be output.

(1) Select the [Capture condition] radio button in the [Trace conditions] dialog box.

M Trace conditions *

Trace | Trace Recard (OR) ]

condition and combination setting
Trace Stark Poink (5P

(= ' J

Event inuse : 0

Trace Skop Paink (EP)

{+ i QR

Eventinuse: 0

oR Detail

Eventinuse : O

Recording Condition
" all data

Figure 5.51 Extraction of Trace Data
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(2) Open the [Trace Record (OR)] tabbed page and click on the [Add...] button. The [Event] dialog box appears.
Make the setting shown below and click on the [OK] button, then click on the [Apply] button to activate the new
setting.

Trace Trace Record (OR) ]

Ewent | Type | Contents | Count | C.| Comments

Ewent Type:

Ewenk ] Camment ]

-~
&ddress Condition

Address: |1?UU j

Condition

" Mot specify

7 Mask: Compare:

* Range: |Inside the range {<=Values<=) LJ

End Address: |LFLF A

Data Condition

i melele Read/rite: |Read,l’Write ﬂ
Access Size: |N0t Specify ﬂ
Event used E)FC\DD Frg
: Compare Condition
Sawve... | Load... Compared Data: |
I~ | Compare:l J

I Specify the path count condition to this event

| oK | | Cancel

Figure 5.52 Setting an Address Condition

(3) The trace data in the monitor range (addresses 0x1700 to 0x171F) specified in trace extraction conditions is
displayed in the [RAM Monitor] window.

«# RamMonitor [000016D0] (=13
t ERED®XE P iz |6 040 8 2 el dedd £
[ 110ms] Label + +2 +4 +6 + +h +C +E HSCIT A
00001800 =
0000 1BED =
0000 1BFD
a000 1700
o0001710 NERIEEEEREEERY o72¢ 100 107 ore) NS
00001720
00001730
0001740
00001750 v
Figure 5.53 [RAM Monitor] Window (Monitor Range Specified)
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5.11  Using the Start/Stop Function

The emulator can be made to execute specific routines of the user program immediately before starting and immediately
after halting program execution. This function is useful if you wish to control a user system in synchronization with
starting and stopping of user program execution.

5.11.1  Opening the [Start/Stop function setting] Dialog Box

The routines to be executed immediately before starting and after halting execution of the user program are specified in
the [Start/Stop function setting] dialog box.

To open the [Start/Stop function setting] dialog box, choose [Setup -> Emulator -> Start/Stop function setting...] from
the menu.

Start/Stop function setting El

r iThe specitied routine 1z executed immediately betore exection i
of the user's program. i

Starting address(S) | J J

r The zpecified routine iz executed immediately after the stop
of the user's program.

Starting address(EN | | J
Ok | cancel ‘

Figure 5.54 [Start/Stop function setting] Dialog Box

5.11.2  Specifying the Routine to be Executed

The routines to run immediately before starting and after halting execution of the user program are specified separately.
When the [The specified routine is executed immediately before execution of the user’s program] checkbox is selected,
the routine specified in the [Starting address] combo box, which is below the checkbox, is executed immediately before
execution of the user program starts.

When the [The specified routine is executed immediately after the stop of the user’s program] checkbox is selected, the
routine specified in the [Starting address] combo box, which is below the checkbox, is executed immediately after
execution of the user program stops.

5.11.3  Restrictions on the Start/Stop Function

The start/stop function is subject to the following restrictions.
e The debugging functions listed below are not to be used while the start/stop function is in use.

(a) Memory setting and downloading into the program area of a routine specified as a start/stop function.
(b) Breakpoint setting in the program area of a specified routine

o While either of the specified routines is running, the four bytes of memory indicated by the interrupt stack pointer
are in use by the emulator.

o In the specified routines, the following restrictions apply to registers and flags.
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Table 5.17 Restrictions on Registers and Flags

Register and Flag Names  Restrictions

ISP register When execution of a specified routine is ended, the register must be
returned to its value at the time the routine started.

Flag U While a specified routine is running, switching to user mode is prohibited.

Flag | No interrupts are allowed during execution of a specified routine.

Flag PM While a specified routine is running, switching to user mode is prohibited.

e When either of the specified routines is running, the debugging functions listed below have no effect.
(a) Tracing
(b) Break-related facilities
(c) RAM monitoring
(d) Performance analysis
(e) Setting events within the specified routines
e While either of the specified routines is running, non-maskable interrupts are always disabled.
e The table below shows which state the MCU will be in when the user program starts running after execution of a
routine specified as a start function.

Table 5.18 MCU Status at Start of the User Program

MCU Resource Status

MCU general-purpose  These registers are in the same state as when the user program last stopped or in
registers states determined by user settings in the [Register] window. Changes made to the
contents of registers by the specified routine are not reflected.

Memory in MCU space  Access to memory after execution of the specified routine is reflected.

MCU peripheral Operation of the MCU peripheral functions after execution of the specified routine is
functions continued.

5.11.4  Limitations on Statements within Specified Routines

Statements within specified routines are subject to the limitations described below.
e Ifaspecified routine uses a stack, the stack must always be the interrupt stack.

e The processing of a specified routine must end with a return-from-subroutine instruction.

o Ensure that a round of processing by a specified routine is complete within 100 ms. If, for example, the clock is
turned off and left inactive within a specified routine, the emulator may become unable to control program
execution.

e The values stored in the registers at the time a specified routine starts running are undefined. Ensure that each
specified routine initializes the register values.

e The emulator executes the specified routines in supervisor mode. Do not switch the mode to user mode.

e The emulator executes the user program within approximately 20 ms after the start function.
(CPU clock: 25 MHz, JTAG clock: 16.5 MHz)

e The emulator executes the stop function no sooner than 20 ms after the end of execution of the user program.
(CPU clock: 25 MHz, JTAG clock: 16.5 MHz)
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5.12  Using the Debug Console

The debug console supports standard input and output by the user program. Standard input and output through the
[DebugConsole] window is obtained by replacing low-level interface routines (_charput and _charget) in the user
program.

Note: When you use the input/output function, be sure to leave the [DebugConsole] window open.

5.12.1  Opening the [DebugConsole] Window

To open the [DebugConsole] window, select [View -> CPU -> DebugConsole] or click on the [DebugConsole] button

(=)

## DebugCGonsole

1 B W

Figure 5.55 [Debug Console] Window

Standard output from the user program is displayed in this window. Keyboard input in the window becomes standard
input to the user program.

5.12.2  Low-Level Interface Routines

If you wish to use standard input and output in a C/C++ program, you need to create a low-level interface routine.

To utilize the debug console, functions charput and charget (or _charput and _charget), which respectively handle the
output and input of a single character and are called from within a low-level interface routine, must be replaced with
special code intended for the debug console.

If you wish to modify the respective functions, they must handle output to and input from a specific address. The flow
of processing and a sample program are given on the following pages.

Note: Any program that implements the given flow of processing, including the sample program, is specifically
intended for the debug console provided by the emulator. User programs must not include such code unless the
emulator is connected to the user system.

R20UT0399EJ0401 Rev.4.01 Page 149 of 210
Jul 01, 2011 RENESAS



E1/E20 Emulator

Section 5 Emulator Functions

charput

Standard output:
Start for output of one character

Read DBGSTAT
(address 0x000840C0)

Is bit 8 of
DBGSTAT ‘0'?

Write one character (= 1 byte)
to FC2EQ (address
0x00084080)

Standard outpult:
Output of one character completed

|

charget

Start for input of one character

{ Standard input:

|

Read DBGSTAT
(address 0x000840C0)

Is bit 12 of
DBGSTAT ‘1'?

Read one character (= 1 byte)
from FE2CO (address
0x00084090)

Standard input:
Input of one character completed

|

R20UTO399EJ0401 Rev.4.01
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Sample Program for the Debug Console

; FILE
; DATE

; DESCRIPTION

:lowlvl.

srcC

:Wed, Jul 01, 2009

:Program of Low level

; CPU TYPE :RX
.GLB charput
.GLB charget
FC2EO .EQU 00084080h
FE2CO .EQU 00084090h
DBGSTAT .EQU 000840C0h
RXFLOEN .EQU 00001000h
TXFLOEN .EQU 00000100h
.SECTION P, CODE
; charput
charput
STACK _charput = 00000000h
_ C2ESTART: MOV.L #TXFLOEN,R3
MOV.L #DBGSTAT, R4
__ TXLOOP: MOV.L [R4],R5
AND R3,R5
BNZ __ TXLOOP
__ WRITEFC2EO: MOV.L #FC2EO,R2
MOV.L R1, [R2]
__ CHARPUTEXIT: RTS
; charget
_charget:
.STACK charget = 00000000h
__ E2CSTART: MOV.L #RXFLOEN, R3
MOV.L #DBGSTAT, R4
__ RXLOOP: MOV.L [R4],R5
AND R3,R5
BZ __ RXLOOP
__ READFE2CO: MOV.L #FE2CO,R2
MOV.L [R2] ,R1
__ CHARGETEXIT: RTS
.END
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5.13  Hot Plug-in Function

Hot plug-in permits the E1/E20 emulator to be connected to the user program while it is being executed, allowing you
to debug the program under execution. To use hot plug-in with the E1 emulator, however, you need to connect the
separately available "hot-plug adapter” (ROE000010ACBO00) between the E1 emulator and the user system. The current
status of which emulator product supports the hot plug-in function is shown in the table below.

Table 5.19 Emulator Products and Support for Hot Plug-in Function

Product name (Product type name) Use of the hot plug-in function
E1 (ROEOOO010KCEOQO) Unusable.

E1 (ROEOO0010KCEOQO) + hot-plug adapter (ROEO00010ACBO00) Usable.

E20 (ROEO00200KCTO00) Usable.

5.13.1  Startup Procedure

Here is the startup procedure to be followed when using hot plug-in. Do not connect the user system and the emulator
until you are instructed to do so.

(1) While the user system and the emulator are not connected yet, choose [Programs -> Renesas -> High-performance
Embedded Workshop -> High-performance Embedded Workshop] from the Start menu and then select the
workspace you’re using.

(2) The [Initial Settings] dialog box is displayed. Select [Debugging mode] for [Mode] and check the [Hot plug-in]
checkbox.
After confirming that the user system and the emulator are not connected yet and that [Emulator Serial No.] for
[Communication] is displayed, click the [OK] button.
Note that the [Hot plug-in] checkbox you’ve checked has no effect the next time you start.
For other settings, refer to section 4.3.1, [Initial Settings] Dialog Box.

Initial Settings El

Device ]Starlup and Gommunication ]

MCU eroup: |RX51D Group ﬂ
Device: |REF5E108 Eal
Mode
v Debueeing mode
[v Hot plug-in

Check the following and press OK button:
= the emulatar is not connected with the user system
= the emulator serial No. iz displayed.

" ikiting the on-chip flash memory mode
I~

Power zupply
r
o e

Communication

ety (| E20: SO00O000 ﬂ] Eefresh

OK I Gancel |

[™ Do not show this dialog box again.

Figure 5.56 [Initial Settings] Dialog Box when Using Hot Plug-in (Device] Page)

Note: The contents displayed in the [Initial Settings] dialog box may differ with each MCU used.
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(3) The [Connect] dialog box is displayed. Connect the user system and the emulator following the procedure described
in the user’s manual of your emulator. Note that if the firmware needs to be rewritten, a rewrite is executed before
this dialog box is displayed. For details about firmware rewrite, refer to paragraph 5. of section 3.10, [Confirm

Firmware] dialog box.

Cionnect the emulator with the uzer system. _ _
In case of uzing Hot plug=in function, wour swstem may need some pin zettings for

GConnect

Hot plug—in.
Flease see the user's manual's additional document for each MCU before uzing this
function.
Figure 5.57 [Connect] Dialog Box (E20 Emulator)
GConnect

@ @
e

Hot-plug
adapter

°
-
o
o

La bbb

a0

Connect the emulator with the uzer system.

In case of uzing Hot plug=in function, wour swstem may need some pin zettings for
Hot plug—in.

Flease see the user's manual's additional document for each MCU before uzing this
function.

Figure 5.58 [Connect] Dialog Box (E1 Emulator)
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(4) The [ID Code verification] dialog box is displayed. For the sake of security of the target MCU’s internal flash

memory, supply the 1D code you’ve set*". If you did not set ID code, enter "OxFF" for a specified number of digits
according to the input mode (Hex or ASCII).

I Gode verification

Pleaze input the ID code being written in the flazh memaory.

ID Code: ||

Thput Made
(¢ Hex: Specify ID code by hexadecimal 32 digits.

(~ ASCH : Specify ID code by ASCT character within 16 letters.

| 2 | Cancel

Figure 5.59 [ID Code verification] Dialog Box when Using Hot Plug-in

Note: 1. Forinformation on ID code, refer to the hardware manual of your MCU.

(5) The [Connecting...] dialog box is displayed.

Uzer WiCG 0no W A
USE Buz Power 477 W

Target Board UNCONMECTED

User IF Gable 33 pin cable

Setting of debugeing information.

Setting of JTAG clock.

Setting of JTAG clock.

JTAG Clock 165 MHz

Connecting to MCGLU..

Debug function authentication.

v Cloze the dialog box when the connection is completed.

[ oee

Figure 5.60 [Connecting...] Dialog Box when Using Hot Plug-in
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(6) The [Configuration Properties] dialog box is displayed. Make the necessary settings for the emulator and debug
function, then click the [OK] button.

For details about these settings, refer to section 4.3.2, [Configuration Properties] Dialog Box.

Configuration Properties

Internal flash memaory overwrite ] External flazh memory ]
MCLU ] Syztem ]

Operating mode

Mode: | J
Endian: | =]
EXTAL Frequency: 2 5000 tHz

External memory areas

firea | Endian | BUS “Width |

Whiting internal flash memary by the emulator debugger

v Allow to change the clock source on writing internal
flazh memary.

Wiork, RAM start address
(400 bytes used): 13000

(0]4 I Cancel |

[ Do not show thig dialoe box again.

Figure 5.61 [Configuration Properties] Dialog Box when Using Hot Plug-in ([MCU] Page)

Note: The contents displayed in the [Configuration Properties] dialog box may differ with each MCU used.

(7) You’ll see that "Connected" is displayed in the [Output] window of High-performance Embedded Workshop and the
message box shown below is displayed. Click the [OK] button to download only the debug information of the
download module file and then click the [Go] button.

Tarzet

Mowe the target proeram iz running. Pleaze download the debue information anly, and then, invoke GO command.

Figure 5.62 Message Box Displayed at Completion of Hot Plug-in Connection
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Notes:
1. If you check the [Hot plug-in] checkbox and click the [OK] button in the [Initial Settings] dialog box while
the emulator and the user system are connected, the following error message is displayed.

Target

Starting up with the hot plug-in failed, because the uzer svstem haz already connected to the emulator. User program was reset.

Figure 5.63 [User System Connection Error] Dialog Box

2. If you click the [OK] button in the [Connect] dialog box while the emulator and the user system are not
connected, the following error message is displayed.

Target

Cannot detect the user system. Pleaze check the connection between the emulator and the uzer svstem.

Cancel |

Figure 5.64 [User System Connection Error] Dialog Box

3. If the power to the user system is no supplied from an external source, the following error message is
displayed.

Target

The command iz not executable because the power supply to the MCU iz off.

Figure 5.65 [Command Processing Error] Dialog Box
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5.13.2

Precautions to Take when Using Hot Plug-in

There are following precautions to take when using hot plug-in.

Until you click the [Go] button after the completion of a hot plug-in connection, do not change event settings,
set breakpoints, or use other debug functions. Also, be aware that the S/W breakpoints saved in session
information are not set in a hot plug-in connection.

Until you click the [Go] button after the completion of a hot plug-in connection, do not perform a memory
comparison in the [Command Line] or [Memory] window. If a memory comparison is performed in either
window, correct memory comparison results will not be displayed.

From when you first click the [Go] button after the completion of a hot plug-in connection till when the
program stops, you cannot use the trace functions.

Even when you use the step-in or step-over command to run the program after the completion of a hot plug-in
connection, the program behaves in the same way as it would when you pressed the [Go] button.
Immediately after you started with hot plug-in, what is displayed in the [Register] window and the actual
register values differ.

When you start with hot plug-in, you cannot use the realtime RAM monitor. (It is grayed out in the
[Configuration Properties] dialog box.)

The emulator stops the user program temporarily in approximately 800us to check the ID code at hot plug-in
(CPU clock: 100 MHz, JTAG clock: 16.5 MHz).

Hot plug-in activation via FINE interface is not supported.

For hot plug-ins using the RX630, RX631 or RX63N Group MCU, always make sure that the endian setting
value of the endian select register (MDEB, MDES) written in the MCU and the endian you set in the [Initial
Settings] dialog box are matched. For details about the endian select registers (MDEB, MDES), refer to the
hardware manual for the MCU you’re using.
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5.14  Graph Functions

To view the changes in memory contents in a graph, use the [Graph] window.
The [Graph] window shows changes in the values of registered symbols graphically.

5.14.1 Displaying the [Graph] window

To open the [Graph] window, select [View -> Graphic -> Graph] or click the [Graph] toolbar button [[E=Z]].

| ||t o | O Kl @ LEo% 15 10 #6 0 @ B

OxFF

0x80

0x00 . . . ;
103058 115903 134745 150593 166435

[Count)

< ?

Svrool Address Size Value |Calnr |Cnmment

a 0x00001006  1Byte 0x35 ]

b 0x00001007  1Byte Oxbé [ ]

Figure 5.66 [Graph] Window

(1) Selecting the Mode
There are two modes in the [Graph] window: Sampling Mode and Trace Mode. To switch between the mode, right-
click in the upper pane of the [Graph] window and choose [Mode -> Sampling], or [Mode -> Trace] from the pop-
up menu. Alternatively, you can click on the toolbar buttons ( @) in the [Graph] window.
In the Sampling Mode, values are measured and displayed each time the set sampling period elapses during the
execution of the program. In the Trace Mode, information of the trace memory is analyzed and displayed.
The Trace mode has two modes: Full and Free. In Full Mode, the information of the trace memory is analyzed and
displayed when the trace buffer is filled or the program is stopped. In Free Mode, the information of the trace
memory is analyzed and displayed when the program is stopped.
The Trace Mode requires time to analyze the trace memory. For this reason, not all the trace memory is analyzed at
the moment the graph is displayed.

When the graph is scrolled to the right or contracted, the area shown is analyzed.

The registered symbols are not common between the Sampling Mode and the Trace Mode. They must be registered
for individual modes.

Note:  In the Sampling Mode and a Free Mode of Trace, when exceeding the maximum amount of data that can be
held, the oldest data is erased first.
The Sampling Mode has up to 10 registered symbols for each [Graph] window. The Trace Mode has up to 4
registered symbols in sum total for all [Graph] windows.

If the switching function on the System page of the [Configuration Properties] dialog box has had [Realtime
RAM monitor] selected, the Trace Mode cannot be used.
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If the switching function on the System page of the [Configuration Properties] dialog box has had [Trace
conditions] selected and the Sampling Mode is enabled, values are retrieved from regular memory, and not
from the RAM monitor.

(2) Registering a Symbol
Choosing [Add Symbol...] from the pop-up menu of the [Graph] window or clicking the toolbar button () in the
[Graph] window opens the following dialog box.

You can also register a symbol by dragging and dropping a character string that can be evaluated from the Editor
window into the lower pane of the [Graph] window.

If a symbol is registered in the Trace Mode, part of the trace function becomes unusable for it.

symbol Setting

Sy mbal:
E - &l
Size
|'I Bivte ﬂ
Colaor
- Madify..
Ciomment: |
0] | Cancel |

Figure 5.67 [Symbol Setting] Dialog Box

(3) Setting a Sampling Period
When the [Graph] window is in the Sampling Mode, set the cycle for data measurement. Choose [Sampling

Period...] from the pop-up menu of the [Graph] window or click the toolbar button [@] in the [Graph] window to
open the following dialog box.

Sampling Period @
Sampling Period:

100 ms {10 - 10000mszec : 10msec unit)

_. ............... [:I K ................ Gancel |

........................................

Figure 5.68 [Sampling Period] Dialog Box

The sampling period can be specified separately for each window.
A sampling period from 10 ms to 10000 ms can be specified in 10 ms units. The initial value is 100 ms.
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(4) Setting the Expansion/Reduction Rates
Set a graph expansion rate or graph reduction rate with which you want the graph to be enlarged or contracted.

Choosing [Ration Setting...] from the pop-up menu of the [Graph] window or clicking the toolbar button [Q?] in
the [Graph] window opens the following dialog box.

Rate Setting @

Height Expand:
Heieht Reduce:  |1500000
Width Expand: 1 500000
Width Reduce: 1 500000

(0] 4 I Cancel

Figure 5.69 [Rate Setting] Dialog Box

Enter a graph expansion or graph reduction rate with which you want the graph to be enlarged or contracted
vertically or horizontally.

The initial value is 1.5.

For all the items in this dialog box, if a value smaller than 1 is specified, 1 is set. If a number with a decimal point is
specified, the value may be approximated due to a rounding error.

(5) Setting the borderline
Up to four borderlines can be set here.

Choosing [Borderline Setting...] from the pop-up menu of the [Graph] window or clicking the toolbar button [E]
in the [Graph] window opens the following dialog box.

Border Line Setting

BorderLine

Linel: v ‘“alue: | 2000 GColor: - Modity ..
LineZ [ “alue |  Caolore -
Lined [ “alue |  Colore -
Lined: [~ “alue |  Colore -

(] 4 | Cancel |

Figure 5.70 [Border Line Setting] Dialog Box

Set whether or not to display the borderline for Linel to line4 separately.

For the border you have selected to display, enter the value or the expression where the border is to be displayed,
and select the color.

If the Radix setting of the [Graph] window is [Signed Dec] or [Signed Hex], a negative value can be specified.
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5.15 Stack Trace Function

The emulator uses the information on the stack to display the names of functions in the sequence of calls that led to the
function to which the program counter is currently pointing. This function can be used only when the load module that
has the Elf/Dwarf2-type debugging information is loaded. For the usage of this function, refer to section 6.18, Stack
Trace Facility.

5.16  Online Help

An online help explains the usage of each function or the command syntax that can be entered from the command line

window.
Select [Emulator Help] from the [Help] menu to view the emulator help.
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Section 6 Tutorial

6.1 Introduction

A tutorial program for the E20 emulator is provided as a means of presenting the emulator’s main features to you. The
tutorial is described in this section.

The tutorial program was written in the C language, and sorts random data (10 items) into ascending and descending
order.

Processing by the tutorial program is as follows.

The main function repeatedly calls the tutorial function in order to repeatedly execute the process of sorting.

The tutorial function generates the random data to be sorted and calls the sort and change functions, in that order.

The sort function accepts input of an array that contains the random data generated by the tutorial function and sorts this
data into ascending order.

The change function accepts input of the array that was sorted into ascending order by the sort function and sorts the
data into descending order.

The tutorial program is designed to help users to understand how to use the functions of the emulator and emulator
debugger. When developing a user system or user program, refer to the user’s manual for the target MCU.

Notes: 1. This tutorial program is for operation in little-endian environments. If you need to run this program in a big
endian environment, recompile the program.
2. If the tutorial program is recompiled, the addresses in the recompiled program may not be the same as those
described in this section.
3. Filename extensions for the files to be used and the address where the tutorial program starts differs with the
MCU. Therefore, actual information shown on the screen may differ from the information given in this
section.
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6.2 Starting the High-performance Embedded Workshop

Open a workspace by following the procedure described in section 3.10, Procedure for Launching the E1/E20 Emulator

Debugger.

Specify the directory given below.

(Drive where the OS is installed)\Workspace\Tutoria\E1E20\RX600\Tutorial_L.ittleEndian
Specify the file shown below.

Open Workspace

FrAIWDIRRRD: | () Tutorial_LittleEndian ~| & & cf B

() Tutarial

= Tytarial hims

Fr MBI [Tutorial s Select |
IrAJWDIEERTY  |HEW Workspaces (% his) -] Cancel

Figure 6.1 [Open Workspace] Dialog Box

6.3 Booting Up the Emulator

On booting up the emulator, a dialog box for setting up the debugger is displayed. Make initial settings of the debugger
in this dialog box.
When you have finished setting up the debugger, you are ready to start debugging.
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6.4 Downloading the Tutorial Program
6.4.1 Downloading the Tutorial Program

Download the object program you want to debug. Note, however, that the name of a program to be downloaded and the
address where the program will be downloaded depend on the MCU in use. Accordingly, strings shown in the screen
shots should be altered to those for the MCU in use.

Choose [Download] for [Tutorial.abs] under [Download modules].

x|

=] @ Tutorial

| I@ Tutorial

-9 G source file
dbsctc
intprec
resetprec
sbrk o
sarte
Tutorialc
wectthlc

-1-=4 Download modules

3£ Dependenciey  Download
zhrk h Download (Debue Data Only)

zorth
stackzct]
typedetfin Download & MNew Module...

vecth Remove
Debug Settings..
Configure View..

v Allow Docking
Hide

Properties..

Ll |

Figure 6.2 Downloading the Tutorial Program

After the above operation, a download to the internal flash memory begins. When the download is completed normally,
a message is displayed to that effect in the [Output] window. An arrow is displayed in the [Tutorial.abs] icon of
[Download modules].

+ Output

&7 %]

Connect ed
Flash memory writing ...
Flash memory writing ... OK

[ * T\ Buld ), Debug £ FndinFies L J, FindinFiles2 } Macra j Test }y Version Cantral

Figure 6.3 Completion of Download of the Tutorial Program

Note that if you’ve checked the [Reset CPU after download] checkbox on the [Options] page of the [Debug Settings]
dialog box that is displayed when you select [Debug Settings] from the [Debug] menu, the CPU is reset each time you
download.
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6.4.2 Displaying the Source Program

In the High-performance Embedded Workshop you can debug programs at the source level.
Double-click on the C source file [Tutorial.c].

i |
= '@ Tutorial ) 5 &'ﬂ @
=I-[F Tutorial :

3239 G source file Line | Souwce &. 0. 5. Source
dbscte 32 [FFFF&TT7 oid main(void]
intprec 33 {
= 34 |FFFF8T7T while (131
risztprgc gg FFFFE770 } tutorial();
=| TOrK.C
sorte gg H
Tutorialc ; i i
Y ig FFFF&786 {Dld tutorial (void)

—-4=4 Download modules A1 long al10];

Tutarialabs - 00000000 42 long J;

—-4=4 Dependencies 43 int i3 )
<brk h jﬂﬁl struct Sample far #p_sam;
sorth 46 |FFFF&7aa p_san= malloc( {struct Samplel);
stackscth jg FFFF&795 initip_san);

tvpedefineh
:;pjhe e 49 FFFFaTaE far( i=0; i€1D; i++ )1
b0 |FFFFA7AL i = rand(});
51 |FFFF87E3 if(j <031
g% FFFFa7EL | I=-is
b4 |FFFFa702 alil = j;
il H
b6 |FFFFA7DE sort (a);
Eg FFFF&7E1 chanze(a);
<
"~ Eeroj... [ | s Test | 0 Tuteriale

Figure 6.4 [Editor] Window (Displaying the Source Program)

If necessary, you can change the font and size to make the text more easily readable. For details, refer to the High-
performance Embedded Workshop User’s Manual.
The [Editor] window initially shows the beginning of the program. Use the scroll bar to view other parts of the program.
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6.5 Setting S/W breakpoints

Setting of S/W breakpoints is one simple debugging facility.
S/W breakpoints are easy to set in the [Editor] window. For example, you can set a S/W breakpoint at the line where the
sort function is called.

Double-click in the row of the [S/W Breakpoints] column which corresponds to the source line containing the call of the
sort function.

4 Tutorial.c HJE|§|
= &|&
Line | Source A.| O 5. Source

45 j

47 |FFFF87495 p_sam = &g Sample; -

ﬁg FFFFET9E init(p_sam);

a0 |FFFFE744 for( 1=0;5 1<10; i++ )]

91 |FFFFE7EO I = rand(};

a2 |FFFF&7EY if() <03

93 |[FFFFE7CO i=-i;

a4 1

Eg FFFFETCE alil = s

a7 |FFFFETVEI [ sart (a);

Eg FFFFETET changeial;

B0 |FFFFEYED p_san->s0=al0];

Gl |FFFFGYF4 p_sam->sl=zall];:

G2 |FFFFETFC p_san-»s2=al2];

63 |FFFFGE04 p_sam->sd=al3d];:

64 (FFFFE80C p_san->sd=al4];

65 |FFFFG814 p_sam->s5=zald];

GG |FFFFEE1C p_san->sb=alf];

E7 |FFFFE824 p_san->s7=al7];:

63 |FFFFE82C p_san->sd=ald]; b

9 |FFFFaE34 b_sam-»g9=ald];

70 1

71 hd
1| | v

Figure 6.5 [Editor] Window (Setting a S/W breakpoint)

The source line that includes the sort function will be marked with a red circle, indicating that a S/W breakpoint has
been set there.
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6.6 Executing the Program

The following describes how to run the program.

6.6.1 Resetting the CPU

To reset the CPU, choose [Reset CPU] from the [Debug] menu or click on the [Reset CPU] toolbar button ().

6.6.2 Executing the Program

To execute the program, choose [Go] from the [Debug] menu or click on the [Go] toolbar button ).
The program will be executed continuously until a breakpoint is reached. An arrow will be displayed in the [S/W
Breakpoints] column to indicate the position where the program stopped.

2 Tutorial.c

EEE

S((=1[ES

Line Source A..

Q. 5. Source

47 |FFFFa795
43 FFFF879E

al FFFFETA4
a1 |FFFFGTED
a2 |FFFFGTE3
23 FFFFGTCO

2% FFFFGTCE

af |FFFFGETE]
a8 |FFFFGTVEY

B0 \FFFFGTED
E1 FFFFB7F4
B2 FFFFBIFC
63 FFFFGG04
G4 FFFFBE0C
ED FFFFBE14
BB |FEFFEE1C
b7 FFFFGG24
GG FFFFEG2C
B3 FFFFBE34

}

p_sam = &2 Sanple;

initip_samy;

farf i=0; i<10;
i = rand();
ifei < 0
| i=-i;

alil = j;

sort(a);
changetal;

p_sam-»s0=za
p_sam-»s51=za
p_sam-rs2=a
p_sam-»s3=a
p_sam-»sd=a
p_sam-»shza
p_sam-rsh=a
p_sam-»s7{=a
p_sam-»sB=a
p_sam-»59=a

WD - M a2 — 3

fifdef _cplusplus
{nid abart (void)

1
Hendif

i++ 11

Figure 6.6 [Editor] Window (Break)
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The [Status] window permits you to check the cause of the last break to have occurred.

Choose [View -> CPU -> Status] or click on the [View Status] toolbar button When the [Status] window is
displayed, open the [Platform] sheet and check the cause of the break.

EBX]

MCT Status

Memory

Fun titne count

Ftatu=

RX E1/EZ0 STSTEM
RIF56108

Little
Zingle-chip mode
Ready
Q0:00:00.000,000
SGoftware break
23.000576 MH=
32T W

Platform jr

Note:

Figure 6.7 [Status] Window

The items shown in the [Status] window vary with the MCU. For details, refer to the online help.
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6.7 Checking Breakpoints

Use the [Breakpoints] dialog box to check all S/W breakpoints that have been set.

6.7.1 Checking Breakpoints

Choose [Edit -> Source Breakpoints...] to open the [Breakpoints] dialog box.

Breakpoints

[tutorial cl

Line 56

Cancel
Edit Cade
Bemove
Femaove &l

Figure 6.8 [Breakpoints] Dialog Box

Use this dialog box to remove a breakpoint or enable or disable a breakpoint.

Note:  The [Breakpoints] dialog box cannot be opened if no S/W breakpoints have been set.
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6.8 Altering Register Contents

Choose [View -> CPU -> Registers] or click on the [Registers] toolbar button . The [Register] window shown
below will be displayed.

« Hegister

Nawe | Value Radix
jtu 0000160 Hex
Rl 0000z0Da Hex
RZ aoooooon Hex
R3 oooo1414 Hex
R4 oooo14oc Hex
RS 0000160 Hex
Eb aoooooon Hex
RT aoooooon Hex
2t 0ooooooo Hex
=] aoooooon Hex
Rr10 oooooooo Hex
R11 aoooooon Hex
R1Z aoooooon Hex
13 0ooooooo Hex
R14 ooonoooa Hex
R15 aoooooon Hex
usp 00o0016Dc Hex
I3P oooo1a1s Hex

FEFFE7DE

INTE FFFFE140 Hex
BPF3W  0O0O0OCO Hex
BRC aoooooon Hex
FINTV 00000000 Hex
FPSW 00000100 Hex
A oooooooooooonooon Hex
ren| em| uf 1| o] 32| ¢| |
a 1110011

Figure 6.9 [Register] Window

The contents of any register can be altered.
Double-click on the line for the register you want to alter. The dialog box shown below is displayed, allowing you to
enter the new value for the register.

PG — Set Yalue

Set Az |'|,|'|,|h.;.|e Feeizter ﬂ

(0] 4 | Cancel

Figure 6.10 [Set Value] Dialog Box (PC)

Note: The register items displayed in the [Register] window differ with each MCU used. For details about the register
items, refer to the hardware manual for the MCU you’re using.
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6.9 Referring to Symbols

The [Labels] window permits you to view the symbolic information in a module.
Choose [View -> Symbols -> Labels] or click on the [Labels] toolbar button (Z ). The [Labels] window shown below

will be displayed. Use this window to look at the symbolic information a module includes.

B

“mep X BB
EP |Address ‘ Name o
oaoolaoa _ g CharBuf
ooooloo4 _heap area
ooao1404 _g_IntEBuf
ooooi408 _brk
ooooi40c __Aldata
oooo1414 __rnext
FFFFE000 _PowerON Reset PC
FFFFE100 __shrk size
FFFF2 104 _DTEL
FFFFE 128 _EBTEL
FFFFE530 _shrk
FFFF35AS _init
FFFFE5EY _sort
FFFFETOD _change
FFFF3TTY _main
FFFFET726 _tutorial
FFFFE84C _free
FFFFEEDC _findmemn
FFFFEOc6A _malloc
FFFFEODE _rand
FFFFEOFZ __INITSCT
FFFF32a04 loonpl v
£ >

Figure 6.11 [Label] Window
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6.10  Checking Memory Contents

After you have specified a label name, you can use the [Memory] window to check the contents of memory where that
label is registered. For example, you can check the contents of memory corresponding to _main in byte units, as shown

below.

Choose [View -> CPU -> Memory] or click on the [Memory] toolbar button (/&) to open the [Display Address] dialog

box.

Enter “_main” in the edit box of the [Display Address] dialog box.

Dizplay Address

Display Address:

Scroll Start Address:

Scroll End Address

oK

e ~]
00000000 |
[FFFFFFFF ~]

Cancel

Figure 6.12 [Display Address] Dialog Box

Click on the [OK] button. The [Memory] window will be displayed, showing a specified memory area.

16

040 8 2

abe 48 & b dis &

b

o

B(=1ES

Address

FFFFa7YY
FFFFavay
FFFFa7EY
FRFFETAY
FFFFAYEY
FFFFaYCY
FFFFa7LY
FFFFEYEY
FFFFaYFY
FFFFaa07
FFFFa817
FRFFaa2Y
FFFFaEaY
FFFFaa4dy
FFFFa8aY
FRFFEEEY
FFFFREYY
FFFFaaay
FFFFaa9y
FRFFaaAY

+
11
I]1]
nc
AE
E
By
B1
FF
m
0z
113
n?
na
oc
n4
FD
20
1F
24
47

+
E
cc
EF
28
28
a1
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FF
fiH]
fik]
fik]
iy
ED
71
43
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22
47
BF
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1
75
E1
33
(I}
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23
EC
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05
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nE
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1]
Ch
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115}
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17
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41 2% 05 DG O
N5 0B FE FF EE
ns 2C 02 00 EF
ED OE 0A& FC 07
2E 51 ED OE 0B
0 EF M 0% 04
N5 ED 0NE 0C EB
ED OE 0C E? E5
ED 0OE 0C E? ES
ED OE 0OC E? ES
ED 0OE 0C EY E5
nc EF E1 05 OF
34 02 BE B7 BB
B2 7% 75 2% FB
n? 21 BE FB 72
41 23 3B FB 42
EF FZ ED IF O1
23 3F 47 13 13
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1
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NE
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Ef
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ER
n:
04
0B
na
o
0E
43
oG
oG
47
4B
2B

+]
NE
EF
E7
E7
vy
1E
FF
]
A
a4
g
L
n
47
i1
14
14
EF
b4
E7

+h
A1
1E
nE
E
ah
E7
EF
no
an
nn
an
no
Bf
B1
EC
n
n
21
E3
1F

+B
1E
E7
ne
A
EF
NE
117
ED
ED
ED
ED
ED
nh
n
15
n
n
Fh
24
m

+0
|
NE
ED
ED
I}
ne
EF
E
NE
NE
NE
E
EF
a7
Bl
]
A
EC
EF
&

+0
Fi
nc
nE
E
ED
ED
il
nc
nc
nc
nc
nc
AE
0o
a5
0
LF
24
21
29

+E
n:
ED
ne
I
NE
NE
117
E7
E7?
ET
ET
E7
E7
Tl
23
47
nF
FF
2E
no

.0.4.negf.Gaz..ge

LCebuuf. CO. sl 0t

dotnereaa.|Gd

EGAﬂ;.B..... .

J.G
SoGoll bt

SRIRIG. KT 5
Go.K.Gft+. .0,

Figure 6.13

[Memory] Window
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6.11  Referring to Variables

When single-stepping through a program, you can see how the values of the variables used in the program change as
you step through source lines or instructions. For example, by following the procedure described below, you can look at
the long-type array ‘a’ that is declared at the beginning of the program.

Click on the left-hand side of the line containing the array ‘a’ in the [Editor] window to place the cursor there.
Right-click and select [Instant Watch].

The dialog box shown below will be displayed.

Inztant Watch

+-a [000016DG } {lone[10])

Figure 6.14 [Instant Watch] Dialog Box

Click on the [Add] button to add the variable to the [Watch] window.

* Watch

Naune | Value | Address Type Scope |
+ @ a { ooooigope ) [long[1071) [Current Zcope]

[\ Watchl j Watchz Ji Watchd J Watchd [

Figure 6.15 [Watch] Window (Array Display)

Alternatively, you can specify a variable name to be added to the [Watch] window.
Right-click in the [Watch] window and choose [Add Watch] from the popup menu. The dialog box shown below will

be displayed.

Add Watch

Variable or expression: oK

| i
Cancel

Scope:

| [Current Scope] ﬂ Detail...

Figure 6.16 [Add Watch] Dialog Box
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Enter variable ‘i’ in the [Variable or expression] edit box and click on the [OK] button.
The int-type variable ‘i’ will be displayed in the [Watch] window.

«* Watch

Iy
{ 00001lepc } [long[107) [Current Zcope]
{ 00001708

H'0000000=

[Current Zcope]

watch1 fi watch2 }, watcha j watchd [

Figure 6.17 [Watch] Window (Showing a Variable)

Click on the “+” mark shown to the left of the array ‘a’ in the [Watch] window. You can now look at the individual
elements of the array ‘a.’

EOX
R E S XD R
Name | Value | Address Type Scope |
5B oa { 00001l&6DC } [long[107) [Current Zcope]
B [0] E' 00000000 { DOOO16DC } {long)
R 1] H'000053de { O0OO016ED } { long)
R 2] H'00002704 { ODOO1GE4 } { long)
R 3] H'00005665 { O0OO1GES ) {long)
R 4] H'00000das { ODOO1GEC } { long)
R [5] H'0000421f { O0Oo016F0 3} {long)
R [g8] H'00003ead { ODOOD1eF4 } { long)
R [7] H'00004d1d { O0OO16F8 3} {long)
B 8] H'00002£5= { ODOOleFC ) { long)
B [o] E'000020ds { DOOO1700 } {long)
R i H'OO0O0O0Oa { 00oo17o8 3 [int) [Current Scope]
Watchl /i Watchz J Wakch3 Ji ‘Watchd [

Figure 6.18 [Watch] Window (Showing Array Elements)
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6.12  Showing Local Variables

By using the [Local] window, you can view the local variables included in a function. As an example, let’s check the
local variables of the tutorial function. Four local variables are declared in this function: ‘a,’, ‘j,” i’ and ‘p_sam.’
Choose [View -> Symbols -> Local] or click on the [Locals] toolbar button ) to display the [Locals] window.

The [Locals] window shows the values of local variables in the function indicated by the current value of the program
counter (PC).

If no variables exist in the function, no information is displayed in the [Locals] window.

Type
[long[10]})

3 H'000020da { 00001704 [long)

i H'OOOOO0OO= { 00001708 ) [int)
#op sam O0x0000100e § OOCOL170C } [struct ZSample*)

Figure 6.19 [Locals] Window

Click on the “+” mark shown to the left of array “p_sam” in the [Locals] window to display the elements of class

instance p_sam.
Confirm that the random data are being sorted into descending order by inspecting the elements of class instance
“p_sam” before and after execution of the sort function.
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6.13  Single-Stepping through a Program

The High-performance Embedded Workshop provides various step commands that will prove useful in debugging
programs.

Table 6.1 Step Options

Command Description

Step In Executes a program one statement at a time (including statements within functions).

Step Over Executes a program one statement at a time by ‘stepping over’ function calls, if there are any.
Step Out After exiting a function, stops at the next statement of a program that called the function.
Step... Single-step a program a specified number of times at a specified speed.

6.13.1 Executing [Step In]

[Step In] ‘steps in’ to a called function and stops at the first statement of the function.
To enter the sort function, choose [Step In] from the [Debug] menu or click on the [Step In] toolbar button.

#

Figure 6.20 [Step In] Button

[z &|a
Line | Source A..| 0. 5., Source
1T [FFFFB5AE p_san->sl = [} j
12 [FFFFEGRA plsan->e7 = 0} =
13 |FFFFB5BA p_san->s3 = 0;
14 |FFFFB5CO p_san->s4 = 0;
15 |FFFFB5CE p_sam-»s3 = 03
16 |[FFFFE5CO p_sam->s6 = 03
17 |FFFFE3DZ p_san-»s7 = 0;
18 |FFFFB5DE p_san->s8 = 0;
19 |FFFFB5DE p_san->s8 = 0;
20 H
21
22 /
23 int g_IntBuf;
34 har g CharBuf;
25 7
26
gé FFFFBSET =3 {ort(\ong *a)
79 long t3
g? int 1.0, k, gap;
32 |FFFFA5EC zap = 5§;
33 |FFFFA5FT while( gap > 0 )1
34 [FFFFA5FB for( k=03 k<zap; k++) i
35 [FFFFGBOC fori izktear; i¢10; i=iteap )i
36 |[FFFFEB20 for(j=i-gap; j>=k; j=i-gap){
37 |FFFF8533 z_IntBuf = J;
38 FFFFAE40 Iflalil>alj+gar]){
33 [FEFFBE5F t=alils
40 FFFFBBEC alil = ali+eanl;
41 FFFFEBAT aliteap] = 1}
42 i
413 else
14 hreak;
5 H
25 1
47
& FreFaeDa gap = gap/?;
g? FFFFEEED \ 2_CharBuf = (char)z_IntBuf & 0x00FF;
52
Ei FFFFE700 hange (long *a)
55 long tme[101;
56 int i3
57
58 [FFFFG712 for(i=05 i<105 j++)4
Eg FFFFBTIE . tmpli] = alil;
61 |FFFFO740 fari=0; i<10; i++){
62 [FFFFA74C alil = twol9 - 113
53 } =
< | E

Figure 6.21 [Editor] Window (Step In)

The highlight in the [Editor] window moves to the first statement of the sort function.
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6.13.2  Executing [Step Out]

[Step Out] takes execution out of a called function by completing its execution at once and only stopping at the next
statement of the program from which the function was called.
To exit from the sort function, choose [Step Out] from the [Debug] menu or click on the [Step Out] toolbar button.

¥

Figure 6.22 [Step Out] Button

= &8
Line Source A..| 0. 5.| Source
49 j
50 |FFFFE7A4 for( i=0; <105 i++ J{ =
51 |FFFF&7ED iz rand();
52 |FFFF&7E4 iftj <0)f
53 |FFFFB7CO j=-is
54 H
55 |FFFF&7Ca alil = j;
56 i
57 |FFFFB7E] [ sart (a);
gg FFFFEIET 2 changa(a);
B0 |FFFFETED p_sam->sf=a[0];
&1 |FFFFETF4 psan->sl=all]: e
B2 |FFFFEYFC p_sam->s2=a[2];
B3 |FFFFB804 p_sam->s3=a[3];
G4 |FFFF&E0C p_sam->s4=a[4];
BES |FFFFGa14 p_sam->sb=a[h]; Name Value 2Address Type Scope
BB |FFFF8R1C p_san->s6=a[B]: = e —— s ; _—
67 |FFFFa824 psan->s7zal7]: =R { i e 0 G
gg ;FFFEE%S pisam—isgfa{g%i R [0] ®'00000000 { ODOO16FC ) {long)
4 [ o PRITARRR R [1] H'D0000das { 00001700 ) {Long)
1 R [2 H' 00002 0d; 00001704 1
iz #ifdef _cplusplus [z = { ! (long)
73 oid abart fvoid) B [i] H'O000Z2704 { 00001708 3} [ long)
%1 i B [4] HE'00002f5a { 0000170C } [ Loneg)
76 y R [5] H'00003ead { 00001710 ) {long)
%g Hendif R [6] E'00004Z1f { 00001714 ) {long)
R [7] E'D0004d1d { 00001718 ) {long)
R [8] E'D000D53de { 0000171C ) {Llong)
R [9] H'ODO0S665 { ooooiTzo ) { Lang)
B i H'O000000a { oopo17vzse ) [inkt) [Current Scope]
P '\ watch1 f watchz J, Watchd ), Watchd /

Figure 6.23 [Editor] Window (Step Out)

The data of the variable ‘a’ displayed in the [Watch] window will have been sorted into ascending order.
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6.13.3  Executing [Step Over]

[Step Over] executes the whole of a function call as one step and then stops at the next statement of the main program.
To execute all statements in the change function at once, choose [Step Over] from the [Debug] menu or click on the
[Step Over] toolbar button.

[T

Figure 6.24 [Step Over] Button

e

Line | Source .

0. 5. Source

30 |FFFFaTa4
51 |FFFF&7E0
32 |FEFFG7ES
53 |FFFF&7CO

95 |FFFF&E7CH

37 |FEFFETE]
58 |FFFFTET

B0 |FFFFB7ED
B1 |FEFFEIF4
B2 |FEFFETFC
B3 |FFFF6204
B4 |FEFF80C
B5 |FFFF6a(4
B6 |FFFF8AIC
§7 |FFFFO624
B8 |FFFF822C
B9 |FFFF8a34

j o= rand();
if{ <0
JE= =0

1
alil = j;

[ sort (a):
change(al;

o p_san->sl=a
p_san-»sl=al
p_san->s2=al
p_sam->s3=a[
p_san->sd=al
p_san->sh=a[
p_san->sh=al
p_san->s7=a[
p_san->»si=al
p_san—>s8=a[

0 00 —-J G2 CI1 o 00 PO — 3

H

Wifdef _colusplus
{oid abort (void)

i
Hendif

for{ 1=0; i<105 i+ 3{

R CHEA /X | | R
Natne ‘ Value | Address Type Scope I
=B a { 000016FC 3} {long[10]) [Current Scope]
R [0] H'0O000S665 { 0DO0OO1gFe } [ Long)
R [1] H'000053de { 0ooo1vaoo ) { Long)
R [2] H'00004d1d { 0ooo1704 } { Long)
B [3] H'O000O421f { 0ooO1708 } [ Llong)
R [4] H'00003ead { 0ooo170c ) [ Long)
R [5] H'0000Zf5a { 00001710 } { Long)
R [6] H'00002704 { 00001714 } { Long)
B [7] H'0000Z0da { 0ODO1718 } [ Llong)
R [2] H'00000d=sea { 0O0O171c } [ Long)
R [9] H'00000000 { 0Ooo17zo ) { Long)
B i H'00000O00= { 000D17Z8 1} [int) [Current Zcope]
[ watch1 f{ watchz }\ wiatch3 f watchd /.

Figure 6.25 [Editor] Window (Step Over)

The data of the variable ‘a’ displayed in the [Watch] window will have been sorted into descending order.

R20UTO399EJ0401 Rev.4.01

Jul 01, 2011

RENESAS

Page 178 of 210




E1/E20 Emulator Section 6 Tutorial

6.14  Forcibly Breaking Program Execution

The High-performance Embedded Workshop permits you to forcibly break program execution.
Clear all breakpoints.
To execute the rest of the tutorial function, choose [Go] from the [Debug] menu or click the on [Go] toolbar button.

Ell

Figure 6.26 [Go] Button

Since the program execution is now in an endless loop, choose [Stop Program] from the [Debug] menu or click on the

[Halt] toolbar button.
o

Figure 6.27 [Halt] Button
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6.15  On-Chip Break Facility

The on-chip break facility is available if it is supported by the MCU. An on-chip break causes the program to stop when
it executes the instruction at a specified address (execution address) or reads from or writes to a specified memory
location (data access).

6.15.1  Stopping a Program when It Executes the Instruction at a Specified Address

It’s easy to set an execution-address event as an on-chip breakpoint in the [Editor] window. For example, you can set an
on-chip breakpoint where the sort function is called.
Double-click in the row of the [On-Chip Breakpoint] column which corresponds to the source line containing the call of

the sort function.

#* Tutorial.c

EBX

Line Source .| Q. 3. Source

45 |FFFFGTIE

a0 |FFFFETA4
a1l |FEFFGTED
22 |FFFFGTEY
23 |FFFFGTCO

29 |FFFFGTCE

af |FEFFGTE]D | 4
a0 |FFFFGTET

G0 |FEFFGTED
Gl |FFFFETF4
G2 |FFFFBIFC
63 |FFFFGE04
G4 |FFFFEE0OC
G5 |FFFFBE14
GG |FEFFEEIC
G7 |FFFFGG24
G& |FFFFBEZC
B3 |FFFFEG34

init{p_sam);

sort {al;
changela);

p_sam-rsl=a
p_sam-»sl=a
b_sam-»52=za
p_sam-rs3=a
p_sam-rsd-a
b_sam-»55=a
p_sam-»sh=a
p_sam-»s¥=a
b_sam-»589=a
p_sam-rg9=a

OO0 =1 T L1 e OO —

h

Hifdef _colusplus
{oid abart (waid)

H
Hendif

-

oy

Figure 6.28 [Editor] Window (Setting an On-Chip Breakpoint)

The source line that includes the sort function will be marked with a filled blue circle, indicating that an on-chip

breakpoint that will cause a program to stop when it fetches an instruction has been set there.
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6.16  Stopping a Program when It Accesses Memory

To make a program stop when it reads or writes the value of a global variable, follow the procedure below.
Choose [View -> Event -> On-chip Break] to open the [On-Chip Break] dialog box.

Select the [OR] page of the [On-Chip Break] dialog box.
Select a global variable in the [Editor] window, and drag-and-drop the selected variable into the [OR] page so that the

program will stop when it reads or writes the value of that variable.

Then click on the [Apply] button.
The program will stop running when it reads or writes the value of the global variable you have set.

Bl On—Chip Break * Ali=l.3

on-Chip Break] Before PC OR l

Event | Type | Cantents | Counk | C.| Comments |
MiEvnl  PC [Address] g InkGuf

add... Delete | Enable | Disable |
Event used g‘;}j Free PO(.:ﬁ.i Reqistered events. ..
Save... | Load... | Apply Close

Figure 6.29 [On-Chip Break] Dialog Box

Notes: 1. Only global variables of 1 or 2 bytes in size can be registered.
2. Local variables cannot be set as on-chip break conditions.
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6.17  Tracing Facility

The two types of tracing facility listed below are available if they are supported by the MCU.
e Internal trace

Tracing of this type uses the internal trace buffer in the MCU. The branch and data access information is displayed
in the [Trace] window. The contents of the displayed information and the number of cycles that can be acquired
vary with the MCU.

o  External trace
Tracing of this type is only supported by the E20 emulator, and is only available when the MCU in use supports
external-trace output and its trace pins are connected to the E20 emulator. The contents of the displayed information
and the number of cycles that can be acquired vary with the MCU.

The following is an example of settings for the RX600 Series MCUs.
Choose [View -> Code -> Trace] or click on the [Trace] toolbar button ).
The [Trace] window will be displayed.

P — B

=V
Range:, [File: |[Gycle: |Address
Cycle Label Address Source Address | Destination | Data Size R/ BUS Master | Type BCN Eranch Type | Channel | TimeStamp {Count)

Figure 6.30 [Trace] Window

The following section gives an outline of the tracing facility and how to set up the facility.
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6.17.1

Showing the Information Acquired in “Fill until Stop” Tracing

In “fill until stop” tracing, trace information is successively acquired from the start of user program execution until a

break is encountered.

(1) Clear all break conditions. Click the right mouse button with the cursor anywhere in the [Trace] window and choose
[Acquisition] from the popup menu. The [Trace conditions] dialog box shown below will be displayed. Check that
the selected trace mode is [Fill until stop]. Click on the [Close] button.

H Trace conditions

Trace Start Poink (5P
* Go program

Trace Skop Point {EP)

(% Break program

Recording Condition
(* Al data

Trace Setting

condition and combination setting

(~ Start
condition:

" Shop condition:

" Capture condition:

| I

Eventinuse: 0

OR _Detail |

Ewvent in use : 0

CR
Eventin use : 0

Trace Mode: ‘

P
' Fill until Stop

Trace COukput:

|CPU execution

Trace Type:

|Branch

Trace Capacity: |1M Byte

Led Lef Lef Lo |

Advanced..,

PCi 1
Event used otn  ree

Save... | Load...

o 4

Registered events. ..

Close

il !

Figure 6.31 [Trace conditions] Dialog Box (Fill until Stop)

(2) Set a S/W breakpoint on the line of the tutorial function: “p_sam ->s0=a[0];".

< Tutorial.c EEX

Efsli=

Line | Source &.| 0] S.] Source

38 FFFF&ETSE init(p_sam);
50 |FFFFB7A4 for( =03 Q<105 i++ 34
51 |FFFFBYE0 o= rand(l;
52 |FFFF87E9 ifl <01
53 |FFFFBVCO 1= -0
54

EE FFFFBTCE alil = j;
57 |FFFFS7E] sort (a):

gg FFFFSTET changelal;

G0 |FFFFATED [ ] p_sam-rs=al0];
G1 |FFFFE7F4 p_sam-ysl=all];
G2 |FFFFETFC p_sam-rs2=al2];
63 |FFFF3804 p_sam-rs3=al3];
64 |FFFFaa0c p_san->sd=al4];
65 |FFFFa814 p_san->s5=a[5];
66 |FFFFEE1C p_san->sh=al6];
67 |FFFFEE24 p_san->s7=a[7];
68 |FFFF8B2C p_san->sé=al8];
69 |FFFF8B34 p_san->s9=a[9];
70 t

1

72 ftifdef _cplusplus
3 oid abort (void)
74 i

5

B ]

17 Hfendif

8
4] |

=

Figure 6.32 [Editor] Window (S/W breaks Set in tutorial Function)
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(3) Choose [Reset Go] from the [Debug] menu. Processing will be halted by the break, and the trace information
acquired prior to the break will be displayed in the [Trace] window.

=V
Range: -00000711, 00000000 |File: (Cycle: -00000018 Address: FFFFEE20
Cycle Label Address Source Address | Destination | Data BUS Master | Tupe ECH Branch Tvpe | Channel | TimeStamp (Count) -~
-00000018 FFFFa820  -------- FFFFOBED  ---—---- CPL DESTIMATION E T
-00000017 - - CPU ECHD mn -
-00000016 FFFFa620 E - FFFF8E20 -—----—- CPU DESTIMNATION E
-000o0n01s B CPU ECHD E
-00no0014 FFFFag20  --------  FFFF8B20  -------- CPU DESTINATION -
-00nonoi3 CPU BCHD m -
-00000012 FFFFE620  --------  FFFF8G20  -------- CPL DESTINATION 5
-00000011 - CPL B
-00000010 FFFFaB20 3 = FERREB20  smeessies CPU DESTINATION E
-00nonong - - CPU BCHD 0o -
-000o0o0g FFFFag20 E - FFFF8820  ------— CPU DESTINATION E
-0nnonoo? B 7 CPU ECHD 1] =
-00nonoog FFFFag20 - - FFFF8E20  -------- CPU DESTINATION -
-00000005 i - CPL ECHD -
-00000004 FFFFE7EL = - FFFFBTE!  -------- CPL DESTINATION 5
-00000003  _change FFFFa70D = - FFFF870D  -------- CPU DESTINATION =
-00nononz Fae N CPU ECHD 5
-0nnonont Fe e CPU ECHD - —
aonoonon FFFFa7Ed = = FFFF87E8  --——---- CPU DESTINATION B b

Figure 6.33 [Trace] Window (“Fill until Stop” Tracing)

(4) A mixed display of bus information and disassembly listing is possible. Choose [Display Mode —> DIS] from the
popup menu to view trace information in mixed bus and disassembly mode.

-V
Range: -00000111, 00000000 |File: |Gycle: -00000018 |Address: FFFFBE20
Cycle Label fddress Source Address | Destination | Data Size | RN BUS Master | Twpe ECN Eranch Type | Channel | TimeStamp (Count i ~
-0ononots FFFFBEZD  -------- FFFF8E20 -------- i, o CRU DESTIMATION ------- --------- E 1
FFFFa620 MOV.L 10H[RO].R14
FFFFa623 WOY.L D4H[RO], G
FFFFE62E SUE Ri4,R5,R1
FFFFa628 MOV.L R1.08H[RO]
FFFFaE2A WOY. L OCHIRO].R14
FFFFaE2D WOV, L 03H[RI],RE
FFFFa62F CHP R14,R5
FFFFaE31 ELT.B OFFFFEEACH
-goooooty - mmmmmmem mmmmees ---- - CRU BCND Mo - -
FFFFaR33 MOV. L DSH[RO]D,R14
FFFFaGIE WOY. L R14,R1
FFFFa638 WOV, L $00001404H,R14
FFFFSGSE MOV L R, [R14]
FFFFa640 WOY.L 14H[RI].R14
FFFFa643 WOV, L R14.RE
FFFFaE45 MOV.L DSH[RO],R14
FFFFa643 WOY. L [R14,R5],R4 =
FFFFaE4E WOV, L 14H[RO].R14 )

Figure 6.34 [Trace] Window (Mixed Bus and Disassembly Mode)

(5) Choosing [Display Mode — SRC] from the popup menu, on the other hand, shows a mixture of bus information,
disassembly listing, and source code as the trace information.

=V
Range: 00000111, 00000000 |File: Gycle: -00000018 Address: FFFF3620
Cycle Label Address Source Address | Destination| Data Size | R/W BUS Master | Type ECN Branch Tvpe | Channel | TimeStamp (Count) A
~00000018 FFFFO820 T Jes—— E oPU DESTINATION ——-—n e = 3
FFFFEE20 HOV.L 10H[ROT,R14
sort.c 36 o forlizi-zap; J3=ks i=j-zapli
FFFF8E23 HOY.L 04H[RO], RS
FFFFB625 =) R14,R5,R1
FFFFBE2E HOV.L R1,08H[R0]
FFFF&E2A MOV.L CH[RN] ,R14
FFFF&E2D HOY.L 03H[RO] RS
FFFF862F CHP R14,R5
FFFFEE31 ELT.B OFFFFREACH
-pooooopt? mmmmmmmm mmmmeo =R = CRU BCND L L =
FFFF8633 HOv.L 0gH[RI],R14
sort.c a7 2 IntBuf = 3
FFFFEE3E HOV.L R14,R1
FFFF&E3S MOV.L H00001404H, R14
FFFF863IE HOv.L R1, [R14]
FFFFEEAD HOv.L T14H[ROT,R14
sort.c 8 if(alil>ali+zap] }{ —
FFFFaE43 HOv.L R14,RE b
Figure 6.35 [Trace] Window (Mixed Bus, Disassembly, and Source Mode)
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6.18  Stack Trace Facility

Stack information can be used to find out which function called the function corresponding to the current PC value.
Set a S/W breakpoint in any line of the tutorial function by double-clicking on the corresponding row in the [S/W
Breakpoints] column.

Line Source B O 5. Source
21
11 T j
23 int g_IntBuf:
24 char g_CharBuf;
25 -
26
27 |FFFFB5EY sart (long *a)
28 {
29 long t;
g? int i, J. k, gap;
32 |FFFFB5EG gap = 5
33 |FFFF&5F1 whilel gap > 0 ){
34 |FFFF&5FE for( k=0; k<gap; k++){
35 |FFFF8R0C for( izk+gap; i<10; izitzap ){
36 |FFFF8620 o far(j=i-gap; j>=k; j=j-gap){
37 |FFFF8633 g_IntBuf = j;
38 |FFFF3640 iflalilralitzan]d
39 [FFFFGESF t = alil;
40 |FFFF3EEC alj] = ali+zapl;
41 |FFFF8RE7 alj+zgap] = t;
47 !
43 else
44 hreak ;
45 1
46 b
47 ! -
ﬁg FFFF3ED4 gap = zap/?;
g? FFFFBRED ) g _CharBuf = (char)g_IntBuf & 0x00FF;
b2
EE FFFFETOD clhange(long xa) =
< | ;I_‘

Figure 6.36 [Editor] Window (Setting a S/W breakpoint)

Choose [Reset Go] from the [Debug] menu.
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After the break, choose [View -> Code -> Stack Trace] to open the [Stack Trace] window.

# StackIlrace E| @l E|

Kind  Name Walue

F sort [long*) I FFFF36Z0 }
F tutorial() { FFFF37E1l }
F mainl) i FFFF377F }
F Power(QN_Reset PC() { FFEF3044 }

Figure 6.37 [Stack Trace] Window

You will see that the current PC value is within the sort() function, and that the sort() function was called from the
tutorial() function.

Clear the S/W breakpoint that you set on a line of the tutorial function by again double-clicking on the corresponding
row in the [S/W Breakpoints] column.

6.19  What Next?

In this tutorial, we have introduced to you several features of the emulator and usage of the High-performance
Embedded Workshop.
The emulation facilities of the emulator provide for advanced debugging. You can apply them to precisely distinguish

the causes of problems in hardware and software and, once these have been identified, to effectively examine the
problems.
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Section 7 Notes on Usage

7.1 Memory
711 1/0O Register Area

To view or set the data in the 1/O register area by such as memory window, access must be in the units defined in the
hardware manual. Therefore, using the 1/0 window is recommended.

7.1.2 Data Flash Area in the On-Chip Flash Memory

e When memory data in the data flash area are modified by an operation other than downloading (e.g. editing through
the [Memory] window or line assembly), the new values are written to the data flash area the next time the user
program starts running.

e An attempt at reading from the data flash area when it has been erased leads to undefined values according to the
specifications of the MCU are being displayed. If programming of the data flash area through the debugger is
attempted, data are written in 256-byte units and none of them is an undefined value.

e The blocks not registered on the [Internal flash memory overwrite] page are erased before a download is performed.

e When you’re going to download multiple files but their respective areas overlap in the same block of flash memory,
be sure to register that block on the [Internal flash memory overwrite] page.

e MCUs that are connected to the emulator and used in debugging are placed under stress by repeated programming
of flash memory during emulation. Do not use MCUs that were used in debugging in mass-production for end users.

7.13 Downloading to the Internal Flash ROM

Some "access sizes" in the [Download Module] dialog box are not supported. Make sure the specified access size is "1",
"2", or "4".

7.14 Re-Writing the Internal Flash ROM

o If, after rewriting the internal flash ROM (program ROM area) in the user program, you want to inspect the
rewritten content in the memory window, etc., check the [Debugging the program re-writing the internal
PROGRAM ROM] checkbox on the [System] page of the [Configuration Properties] dialog box.

If this is not selected, reference to re-written contents is not possible.
For the data flash area, check the [Debugging the program re-writing the internal DATA FLASH] checkbox in the
same way as for the above.

e During execution of the user program, do not refer to contents of the internal flash ROM (program area and data
flash area) which have been re-written with the user program. Values read out from re-written areas will not be
correct.
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7.15 FCU-RAM and FCU Firmware Areas

Do not use the debugger to alter the contents of the FCU-RAM area. The debugger is incapable of rewriting contents of
the FCU firmware area.

7.1.6 Working RAM Area for Use by the Debugger

The specified amount of bytes in use beginning with the working RAM address specified on the [MCU] page of the
[Configuration Properties] dialog box is used by the firmware when rewriting the internal flash memory. Although the
user program can also use this area (because memory data in this area will be saved in the host machine and then
restored), do not specify any address in this area as the origin or destination of a transfer by the DMA or DTC.

An area in the on-chip RAM must be designated as the working RAM area. The user program must not include any
process that will disable the on-chip RAM.

7.2 [Memory] Window
7.2.1 Copy, Comparison, Find
Do not specify 8 bytes as the data size for the copy, comparison, and find functions. If this size is specified, the

emulator will not operate correctly.
Also, these functions have a maximum range of 16 Mbytes.

7.2.2 Menu Items

Of the functions in the [Memory] window, the menu items that are grayed out do not work.

7.3 Running Programs

7.3.1 [Go To Cursor]

e When [Go To Cursor] is executed, the program does not stop at any breakpoints that have been set.

[RX600 Series MCUs]

o If atotal of 8 or more events of executed-address type have been set in trace condition or performance condition
settings, the “Go To Cursor" command cannot be used.

[RX200 Series MCUs]

e If atotal of 4 or more events of executed-address type have been set in trace condition or performance condition
settings, the “Go To Cursor" command cannot be used.

7.3.2 [Run Program]

Only the first of the temporary PC breakpoints set for [Run Program] is valid.

7.3.3 [Step Out]

Stepping out of a function that uses a jump instruction (i.e. not a subroutine-return instruction) to return to the origin of
the call is not possible.
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7.4 Reset
74.1 Contention between the Resets and the Operations by the Emulator System

An error message "A timeout error. The MCU is in the reset state. Is system reset issued?" is displayed in cases of
contention between a reset (through a pin, from the watchdog timer, etc.) and operations by the emulator system
(memory reference in the [Memory] window, etc.).

If the [Yes] button is clicked, the emulator is initialized and the user program stops. After a system reset is issued, the
trace record is initialized too. Or, if the [No] button is clicked, neither the emulator is initialized nor the user program
stops.

Note that after you’ve clicked the [Yes] button, you can continue with debugging.

7.4.2 MCU Reset When Using the Trace Function

If a reset through a pin, from the watchdog timer, etc. is issued while a user program is running, the correct recording of
trace information both before and after the reset will not be possible.

743 MCU Reset When Using the Realtime RAM Monitor

If a reset through a pin, from the watchdog timer, etc. is issued while a user program is running, the results of
subsequent RAM monitoring cannot be guaranteed (values displayed may be incorrect).

7.4.4 Pin Reset and Internal Reset

When the MCU is reset by a pin reset or internal reset, the precautions to be taken differs depending on the interface,
the target MCU, and the operation mode in the debugger.

The precautions to be taken for a pin reset are summarized in Table 7.1, and those for an internal reset are summarized
in Table 7.2.

Table 7.1 Precautions to Take When a Pin Reset Occurs

Group Interface  Operation mode Precautions for a pin reset
RX610, RX621, JTAG On-chip ROM disabled extended When the MCU is reset by a pin reset while
RX62N, RX62T mode the user program is under execution, the reset
RX630, RX631, JTAG User boot or is deactivated from the emulator. Therefore,
RX63N on-chip ROM disabled extended mode be aware that the reset timing here differs

FINE Any mode from when the actual MCU is operating singly.
RX210 FINE Any mode

User boot or When the MCU is reset by a pin reset while

on-chip ROM disabled extended mode the user program is under execution, the
counter values in the [Performance Analysis]
window and the acquired data in the [Trace]
window are initialized.
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Table 7.2 Precautions to Take When an Internal Reset Occurs

Group Interface  Operation mode

Precautions for an internal reset

RX610, RX621, jTAG
RX62N, RX62T,

RX630, RX631,

RX63N

On-chip ROM disabled extended
mode

After an internal reset, always set the
operation mode to the on-chip ROM disabled
extended mode in the target program.

If an internal reset is generated using a target
program that does not set operation modes, it
becomes impossible to control from the
emulator.

If an internal reset is generated using a target
program that sets operation modes, the reset
is deactivated from the emulator. Therefore,
be aware that the reset timing here differs
from when the actual MCU is operating singly.

RX630, RX631, JjTAG User boot mode

RX63N FINE Any mode

RX210 FINE Any mode

Do not deactivate from the deep standby
mode, nor use an internal reset actuated by
the watchdog timer or the like.

If an internal reset occurs, it becomes
impossible to control from the emulator.

7.5 [10] Window
75.1 Customization of the 1/O-Register Definition File

The internal 1/0 registers can be accessed from the [10] window.

Furthermore, since there will be changes to MCU specifications, change the 1/O-register definition file to match the
description in the hardware manual in cases where the addresses of 1/O registers in the 1/O-register definition file differ
from those given in the hardware manual for the target MCU. I/O registers are customizable in accord with the format

of the 1/O-register definition file.
7.5.2 Verify

In the [10] window, the verify function of the input value is disabled.
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7.6 Tracing

7.6.1 Traceable Accesses

e Only access via the CPU bus is traceable. No record of access by the DMAC or DTC is included in trace data.

7.6.2 Trace Information

o If conditions for tracing to start and stop have been specified, trace information is only acquired during each period
between satisfaction of the conditions at the respective points. In such cases, the disassembled code displayed in the
[Trace] window will not be correct.

e The disassembly display of the [Trace] window can show up to 1,024 instructions for a one-branch interval. If there
are 1,025 or more instructions in a branch interval, the disassembly display is disabled.

[RX600 Series MCUs]

o Trace information of type ‘BCND’ is not displayed until "BRANCH", "DESTINATION", or
"BRANCH/DESTINATION" is output. In other words, the [Trace] window shows no trace information if the type
of all trace cycles is "BCND".

[RX200 Series MCUs]

o |f the data type that is set for trace acquisition condition is “Data” (data access) or “Data + time” (data access +
time), be sure to set address conditions in the trace extraction function. Otherwise, trace information on data
accesses is not acquired.

The trace information on data accesses has only the accesses to specified addresses recorded in it. Note that the
Address column of the trace window shows the start address values that were set in the trace extraction function.

o TimeStamp in the trace window is implemented using the counter for performance measurement. Therefore, if the
counter start/stop condition by a combination of events is set in the [Performance] dialog, expected timestamps are
not displayed.
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1.7 Events

7.7.1 Detectable Accesses

e Only access via the CPU bus is detectable. Conditions for access by the DMAC or DTC cannot be included in
events.

7.7.2 Event Combinations

o If “AND’ or ‘Sequential’ has been selected as an event break condition, only ‘OR’ is selectable as the condition to
start tracing. If “AND’ or ‘Sequential’ has been selected as the condition to start tracing, only ‘OR’ is selectable as
the event break condition.

[RX600 Series MCUs]
e A data-access event specifiable in a sequential condition is for only event numbers 1 to 3 or the reset event.

¢ Inasequential condition, a data-access event for which an address range has been defined is only specifiable for
event number 1.

e The number of passes condition ([Pass Count]) is not specifiable for the reset event in a sequential condition.

[RX200 Series MCUs]
e A data-access event specifiable in a sequential condition is for only event numbers 1 and 2.

7.7.3 Number of Passes

[RX600 Series MCUs]
e The number of passes condition ([Pass Count]) is only specifiable for one event.

7.7.4 Data-Access Event with an Address Range Defined

[RX600 Series MCUs]
e A data-access event for which an address range condition has been defined is only specifiable for one event.

775 Registering Events

o If conditions on data access are registered for the [Before PC] event list, the settings will be ignored.
o If execution of the instruction at an address is registered for the [Trace Record] event list, the setting will be ignored.

[RX200 Series MCUs]

o Ifan event is registered by dragging-and-dropping an address range of the [Memory] window, no data-access event
can be set on condition that access is made to the address range. Therefore, an event that has had only the start
address set is added in an invalid state to the event list.

To register an event by dragging-and-dropping from the [Memory] window, select only one data in size of 1, 2 or 4
bytes.
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7.7.6 Events for the WAIT Instruction

[RX630, RX631, RX63N, and RX210 Group MCUs]

o If abreak occurs for an executed-address type of event that is set in the WAIT instruction or an instruction
immediately preceding it, a time-out error may occur. To cause the target program to break in the WAIT instruction
or an instruction immediately preceding it, use an on-chip breakpoint.

1.7 About the Cause of Event

e Regarding the causes of breaks displayed in the [Output] window, [Status] window, etc., please note that all events
that occurred are displayed here as causes of breaks.
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7.8 Break Functions

7.8.1 Notes on Setting Break Points

S/W break points replace the instructions at the corresponding addresses.

They cannot be specified in the area other than the on-chip ROM and on-chip RAM.

During stepped execution, specifications of S/W break points and on-chip breakpoints are invalid.

When execution is restarted from the address where it stopped at a breakpoint (S/W breakpoints or pre-PC-
execution breakpoints), the actual instruction at the address must be executed as a single step before further
execution continues. Operation is thus not in real time.

Note that any event that occurred in this single-step execution is cleared when the program is executed thereafter.
Therefore, if a trace or performance start event trigger is set in this step, neither trace acquisition nor performance
measurement begins until the event occurs again. The same applies to break-and-trace start combinational events, so
that any event that occurred in a step is not added to AND (cumulative), nor does it cause a state transition.
On-chip breakpoints cannot be set while the emulator is in a power-down mode.

If an on-chip breakpoint has been set through the [On-chip Break points] column of the [Editor] window in a power-
down mode, the [Output] window shows either of the messages given below.

In the sleep mode:

"The internal clock is halted because the MCU is in the sleep mode."

In the all-module clock stop, software standby, or deep software standby mode:
"The internal clock is halted because the MCU is in the standby mode."

This makes setting of on-chip breakpoints through the [On-chip Break points] column impossible. For release from
this state, open and then close the [On-Chip Break] dialog box (you do not have to change the settings in the dialog
box).

[RX630, RX631, RX63N, and RX210 Group MCUs]

If the [Allow to change the clock source on writing internal flash memory.] checkbox is unchecked before
performing a debug, do not set S/W breakpoints at any address that is set in the reset vector. If, while in this state,
the program is executed after reset, a write error occurs. To set one, use an on-chip breakpoint.
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7.9

Realtime RAM Monitoring
Only access via the CPU bus can be monitored. No record of access by the DMAC or DTC is displayed.
If a reset such as a pin reset or watchdog timer reset is issued while a user program is running, the results of
subsequent RAM monitoring cannot be guaranteed (values displayed may be incorrect).
The realtime RAM monitoring function rewrites the window values based on trace data, so that even when values
are rewritten in the [I/O] or the [Memory] window, regardless of whether the user program is running or not, the
changed values are not reflected in the [RAM Monitor] window.
If a monitor range is set by the trace extraction function, the watch function cannot be used for the data that does not
fit in the monitor range (those displayed in gray).

79.1 Displaying the Block Boundary Memory

To display memory for one block overlapping a boundary or an area consisting of two or more consecutive blocks in
the [RAM monitor] window, be sure that the display start address is a multiple of the display size. If these address
and size do not match when you display memory, the displayed memory content is grayed.

If any block preceding the one you registered in RAM monitor area settings is unregistered (grayed out), memory
contents cannot be monitored correctly in the registered block, even when one of the following accesses is attempted
in big endian mode.

Assuming that the start address of a registered block is address ‘n’

(1) Access in 2 and 4 bytes to the address n— 1

(2) Access in 4 bytes to the address n — 2

(3) Access in 4 bytes to the address n — 3

7.9.2 Uninitialized Area Detection

If a detection area is registered in the [Uninitialized area detection] dialog box, be aware that the output mode in the
[Trace conditions] dialog box is switched to “Trace output.”

Note that if all of the registered detection areas are deleted, it switches back to “CPU execution.”

Also, if the output mode is manually changed after registering a detection area, the changed setting has priority
when detection is performed.

The areas set for uninitialized area detection and the RAM monitor area are the common shared resources.
Therefore, if a block area not registered in the RAM monitor is registered for uninitialized area detection, this block
is registered in the list of RAM monitor area settings, too.
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7.10  Performance Measurement
7.10.1 Reset During Performance Measurement

Performance measurement proceeds even if the MCU is reset. However, the results may not be correct because the
clock settings for measurement have been initialized.

7.10.2  Limitation on Nesting for the Performance Measurement

[RX600 Series MCUs]

The number of times interrupts or exceptions occur and the number of RTE or RTFI instructions must be the same, so
obtaining this balance is a precondition. If the number of times interrupts or exceptions occur and the number of RTE or
RTFI instructions are not the same, that is, balance has not been obtained, correct measurement of the number of cycles
for processing is not possible.

Also, data can only be retained for 16 levels of nesting. Therefore, if nesting of interrupts or exceptions reaches the 17th
level, correct measurement is not possible.

7.10.3  Notes on Checking the [Measure the performance only once.] Checkbox

[RX600 Series MCUs]

While the measurement listed below is performed, even if the start event and end event occur, if the condition for
measurement is not satisfied even once, the results of measurement will not be displayed.

e  Execution count

e Exception and interrupt count

e  Exception count

e Interrupt count

e  Event match count

Examples: No exceptions or interrupts occur within the range for measurement.
No event matches occur within the range for measurement.

7.10.4 Handling of Events

[RX600 Series MCUs]
Measurement will be suspended when the start event for performance measurement occurs twice even though the end
event has not occurred. Measurement will be resumed on the next occurrence of the start event.
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7.11  Downloading

7.11.1  About the Access Size

When downloading the modules, the access size can be specified. This leads to download (write) the modules to the
memory by the specified access size.

Note, however, that the specifiable access size for the download module differs with each area.

Although the on-chip ROM/RAM areas accept an access size of "1", "2", or "4" (do not specify "8"), only the access
size "1" can be selected for the download module that includes data for the external flash ROM area.

Note also that for the access to external RAM areas, the bus width specified for each of external areas in the
[Configuration Properties] dialog box at startup has priority.

If you need to specify an access size of "2", set the bus width for the external RAM area to "16 bit" in the
[Configuration Properties] dialog box at startup, divide the download module for the external flash ROM area into
separate modules, and specify "2" for the module that does not include the external flash ROM area.

Also, as for the external flash ROM, the access size specified in the USD file will be used.

For details, refer to the manual of the External Flash Definition Editor described in the URL below.
http://www.renesas.com/efe

Example: When setting the access size as "2" to the external RAM in the following program.

Internal AR

External Rah

External RO

Internal RO
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To download the modules, sort them into two modules (a) and (b) as shown below.
(a) When "2" is specified for the access size (For the external RAM access sizes, the bus width "16 bits" specified at
startup has priority.):

Internal AR

External Ak

Internal ROM

(b) When "1" is specified for the access size:

External RO
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7.12  Downloading to the External Flash Memory

Only flash memory with 4096 or fewer sectors can be registered. If flash memory with more sectors is connected,
programming cannot be guaranteed.

A script specified by the USD file corresponds to the executable memory_fill command of the High-performance
Embedded Workshop debugger. However, note that some options are not available.

The format to be used for script is as follows.
mf<start><end><data>[<mode>]

<start> start address

<end> end address

<data> data value

<mode> BYTE (one byte)

<mode> WORD (two byte)

<mode> LONG (four byte)

Abbreviation: (same as BYTE)

S/W breakpoints cannot be set in external address spaces.

Data in external flash memory cannot be changed by using the [Memory] window or command line.

Select "1" as the size for access to download modules.

When downloading to the external flash memory, if you are using external RAM as working RAM, set it to the
same endian as the CPU.

If your device does support a lock command, select an option to clear lock-bits when creating a USD file. By doing
this, the emulator can skip the process of checking for unnecessary lock-bits.
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7.13 Execution Time

The execution time displayed in the status bar and the [Status] window is the time measured while the program is being
executed. Values smaller than 100 ps are discarded. The execution time will be incorrect when [Step In], [Step Over],
or [Step Out] is performed.

7.14  Start/Stop Function

If, in the Start/Stop function mechanism, a transfer from the Start function to the user program does not occur or the
Stop function does not stop, an error message "A timeout error has occurred in START/STOP function processing. Is
system reset issued?" is displayed.

If the [Yes] button is clicked, the emulator is initialized and the user program stops. After a system reset is issued, the
trace record is initialized too. Or, if the [No] button is clicked, the emulator is not initialized but the user program stops.
Note that after you’ve clicked the [Yes] or the [No] button, you can continue with debugging.

7.15 Watch Function

If a symbol is registered while the user program is under execution, the [Value] column of the [Watch] window shows a
caution “Not available now,” with the symbol unregistered. To register a symbol, be sure that the user program is
halted.

7.16  Debug Console Function

To use the debug console function, do not switch the system clock in the charput and charget functions of the user
program.

Switching of the system clock may adversely affect the communication between the emulator and MCU, hampering
normal transmission or reception of data.

7.17 FINE Interface

e The external trace-output and realtime RAM monitoring functions via FINE interface are not supported.
e Hot plug-ins via FINE interface are not supported.

[RX630, RX631, and RX63N Group MCUs]
e The FINE interface supports only a two-wire system making use of FINEC and MD/FINED pins. One-wire systems
are not supported.

[RX210 Group MCUs]
e The FINE interface supports a one-wire system making use of MD/FINED pin.
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7.18  Option Settings Related Registers

7.18.1  About the Endian Select Registers (MDEB, MDES)

[RX630, RX631, RX63N, and RX210 Group MCUs]

The endian select registers (MDEB, MDES) are such that endian information you set on the [Startup and
Communication] page of the [Initial Settings] dialog box is written to the register corresponding to the operation mode
in which to be debugged.

When debugging in the single-chip mode, you cannot rewrite the endian select register S (MDES) in the [Memory]
window, etc. When debugging in the user boot mode, you cannot rewrite the endian select register B (MDEB) in the
[Memory] window, etc.

7.18.2  About the Setting of Option Function Select Register 1 (OFS1)

[RX210 Group MCUs]

The option function select register 1 (OFS1) permits you to enable or disable a voltage monitoring O reset and set a
voltage detection level. This register is located in the flash memory, so be aware that depending on settings, it cannot be
connected to the emulator. For details about the option function select register 1 (OFS1), refer to the hardware manual
for the MCU you’re using.

7.19  Other

7.19.1 Register Values after the On-Chip Flash Memory Has been Programmed

When programming of the on-chip flash memory takes place (e.g. downloading of a program, setting a S/W breakpoint,
or modifying a value in the [Memory] window), the values of the flash-memory-related registers are also rewritten by
the debugger.

7.19.2 DMAC and DTC

Do not attempt the following operations if a DMAC or DTC request with the MCU’s internal flash ROM as the origin is
generated while execution of the user program is stopped.
e  Setting a S/W breakpoint in the MCU’s internal flash ROM area

e Writing to the MCU’s internal flash ROM area from the [Memory] window or [Command line] window
e Downloading to the MCU?’s internal flash ROM area

7.19.3  About the High-Speed Clock Oscillator (HOCO)

[RX210 Group MCUs]

e The emulator uses a device’s internal high-speed clock oscillator (hereafter the HOCO) to achieve communications
with the device.
Therefore, the HOCO is always in an oscillating state no matter how the HOCO-related registers are set.

o If there is a contention between switching of the HOCO frequency and memory access, the memory access
operation is not guaranteed.
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7.19.4  About the Lock-Bits

(a) About Clearing of the Lock-Bit at the Time of Download
If the user program is to be downloaded into a flash ROM area for which a lock-bit is set, the emulator clears the
lock-bit of the block that contains download data before it starts downloading.

(b) About Restoring of the Lock-Bit after Completion of a Download
Operation differs depending on how the [Debugging the program re-writing the internal PROGRAM ROM]
checkbox of the [Configuration Properties] dialog box is set.

[When the checkbox is checked]

The block that contains download data for a program ROM area and those that contain no download data and are not
registered in [Internal flash memory overwrite] as the ones to be overwritten have their lock-bits set back again after
a download is completed.

[When the checkbox is unchecked]
The lock-bits remain cleared and are not reset after a download is completed.

7.19.5  About Disconnection of the Emulator

To disconnect the emulator, follow one of the methods described in section 3.7, Disconnecting the Emulator. Always be
sure to disconnect the emulator this way.

If the debugger was forcibly terminated, the emulator cannot be started normally the next time you start. In that case,
turn the power to the emulator off briefly and then on again. Do this, for the E20 emulator, by switching over the power
switch, and for the E1 emulator, by removing the USB interface cable temporarily and then inserting again.

7.19.6  About the Operating Frequency

[RX630, RX631, RX63N, and RX210 Group MCUs]
The minimum operating frequency of the MCUs which can be debugged with the E1 and E20 emulators is 32.768 kHz.
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Table A.1 shows GUI menus.
Table A.1 GUI Menus

Toolbar
Menu Option Shortcut Button Remarks
View Difference Opens the [Difference] window.
Map @ Opens the [Map Section Information]
window.
Command Line Ctrl + L Opens the [Command Line] window.
TCL toolkit Ctrl + Shift + K ¢| Opens the [Console] window.
Workspace Alt + K Opens the [Workspace] window.
Output Alt+0O Opens the [Output] window.
Status bar Alt+ A = Shows or hides the status bar.
Disassembly Ctrl +D Opens the [Disassembly] window.
CPU Registers Ctrl +R Opens the [Register] window.
Memory... Ctrl + M Opens the [Memory] window.
10 Ctrl +1 Opens the [I0] window.
Status Ctrl + U Opens the [Status] window.
RAM Monitor = Opens the [RAM Monitor] window.
Debug Console g Opens the [DebugConsole] window.
Event On-chip Break 4 Opens the [On-Chip Break] dialog box.
Trace . ;
Opens the [Trace conditions] dialog box.
Conditions ﬁ P [ ] g
Performance F Opens the [Performance] dialog box.
Symbol Labels Ctrl + Shift + A Opens the [Labels] window.
Watch Crl + W Opens the [Watch] window.
Locals Ctrl + Shift + .
W Opens the [Locals] window.
Graphic Image... gm + Shift + . Opens the [Image Properties] dialog box.
Waveform... Ctrl + Shift + v @ Opens the [Waveform Properties] dialog
box.
Graph Opens the [Graph] window.
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Table A.1 GUI Menus (cont)

Menu Option

Shortcut

Toolbar
Button

Remarks

View Code Trace

(cont)

Ctrl+T

Opens the [Trace] window.

Stack Trace

Ctrl + K

Opens the [Stack Trace] window.

Performance
Analysis

Performance

Ctrl + Shift + P

Opens the [Performance Analysis]
window.

Debug Synchronized Debugging...

Opens the [Synchronized Debug] dialog
box, in which settings for synchronized
debugging can be made.

Debug Sessions...

Opens the [Debug Sessions] dialog box
for listing, adding, or removing debug
sessions.

Debug Settings...

Opens the [Debug Settings] dialog box to
set the debugging conditions or load
modules.

Reset CPU

14
—+

Resets the target MCU and sets the PC
to the reset vector address.

Go

F5

Starts running the user program from the
location currently indicated by the PC.

Reset Go

Shift + F5

[EIE !
= —

Resets the target MCU and executes the
user program from the reset vector
address.

Free Go

[C
Ealll

Starts running the user program with all
breakpoints ignored.

Go To Cursor

r!
-

Starts running the user program from the
address currently indicated by the PC
until the PC reaches the address
indicated by the current text cursor
position.

Set PC To Cursor

Sets the PC to the address at the row of
the text cursor.

Run...

Launches the [Run Program] dialog box
allowing the user to enter the PC or PC
breakpoint during executing the user
program.

Display PC

Ctrl + Shift + Y

Displays the current PC value in the
[Editor] window.

Step In

F11

=

Executes a block of user program before
breaking.

Step Over

F10

E

Executes a block of user program before
breaking. If a subroutine call is reached,
then the subroutine will not be entered.

Step Out

Shift + F11

E

Executes the user program to reach the
end of the current function.
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Table A.1 GUI Menus (cont)

Toolbar
Menu Option Shortcut Button Remarks
Debug Step... Launches the [Step Program] dialog box
(cont) allowing the user to modify the settings
for stepping.
Step Auto Steps only one source line when the
Mode [Editor] window is active. When the
[Disassembly] window is active, stepping
is executed in a unit of assembly
instructions.
Assembly Executes stepping in a unit of assembly
instructions.
Source Steps only one source line.
Halt Program Esc Stops the execution of the user program.
Initialize Disconnects and then restarts the
debugging platform.
Connect ol Connects the debugging platform.
-
Disconnect F| Disconnects the debugging platform.
Save Memory... Saves the specified range of data from
memory data in a file (.bin, .hex, or .mot).
Verify Memory... Verifies file contents against data in
memory.
Download Modules Downloads the object program.
Unload Modules Unloads the object program.
Setup Radix Hexadecimal Uses a hexadecimal for displaying a

radix in which the numerical values will
be displayed and entered by default.

Decimal

Uses a decimal for displaying a radix in

10
= which the numerical values will be
displayed and entered by default.

Octal Uses an octal for displaying a radix in
which the numerical values will be
displayed and entered by default.

Binary Uses a binary for displaying a radix in

= which the numerical values will be
displayed and entered by default.
Emulator Device - Opens the [Initial Settings] dialog box,
setting... in which settings for the target MCU
can be made.

System... ‘E\ Opens the [Configuration Properties]
dialog box allowing the user to modify
the debugging platform settings.

Start/stop Opens the [Start/Stop function setting]

Function dialog box.

Setting...
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Appendix B Notes on High-performance Embedded Workshop

(1) Note on Moving Source File Position after Creating Load Module
When the source file is moved after creating the load module, the [Open] dialog box may be displayed to specify the
source file during the debugging of the created load module. Select the corresponding source file and click on the
[Open] button.

(2) Source-Level Execution
e Source file

Do not display source files that do not correspond to the load module in the program window. For a file having
the same name as the source file that corresponds to the load module, only its addresses are displayed in the
program window. The file cannot be operated in the program window.

e Step
Even standard C libraries are executed. To return to a higher-level function, use [Step Out]. You can also select
not to step into addresses where no debugging information exists. Open the [Options] dialog box via [Setup ->
Options] and select the [Only step in when debug information is available] checkbox on the [Debug] page.
In a for statement or a while statement, executing a single step does not move execution to the next line. To
move to the next line, execute two steps.

(3) Operation During Accessing Files

Do not perform other operations during downloading the load module, operating [Verify Memory] or [Save
Memory] in the [Memory] window, or saving in the [Trace] window because this will not allow correct file
accessing to be performed.

(4) Watch
o Local variables at optimization
Depending on the generated object code, local variables in a source file that is compiled with the optimization
option enabled will not be displayed correctly. Check the generated object code by displaying the [Disassembly]
window.
If the allocation area of the specified local variable does not exist, displays as follows.

Example: The variable name is asc.
asc  Not available now.

o Variable name specification
When a name other than a variable name, such as a symbol name or function name, is specified, no data is

displayed.
Example: The function name is main.
main Not available now.
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(5) Command Line Interface
e Baitch file

To display the message “Not currently available” while executing a batch file, enter the sleep command. Adjust
the sleep time length which differs depending on the operating environment.

Example: To display “Not currently available” during memory_fill execution:
sleep d’3000
memory_fill O ffff 0

o File specification by commands

The current directory may be altered by file specifications in commands. It is recommended to use absolute
paths are recommended to be used to specify the files in a command file so that the current directory alteration is
not affected.

Example: FILE_LOAD C:\Workspace\Tutoria\E1E20\RX600\Tutorial\Tutorial_L ittleEndian
\Debug_RXxxx_E1 E20 SYSTEM\tutorial.abs

(6) Loading of Motorola S-type Files

This HEW does not support Motorola S-type files with only the CR code (0Dh) at the end of each record. Load
Motorola S-type files with the CR and LF codes (ODOAh) at the end of each record.

(7) Note on [Register] Window Operation During Program Execution

The register value cannot be changed in the [Register] window during program execution. Even if the changed value
is displayed, the register contents are not changed actually.

(8) Note on RUN-TIME Display

Although the execution time for the user program is displayed on the status bar and in the [Status] window, values
are rounded down to the nearest 100 pus (i.e. values less than 100 us are discarded) since an internal 32-bit counter of
the emulator is used for this measurement. Values are also not accurate during single stepping, [Step Over], or [Step
Out].

(9) Memory Test Function

This product does not support the memory test function, which is activated by selecting [Test...] from the [Memory]
menu.

(10) “Writing the On-Chip Flash Memory” Mode
e When MCUs are to be continuously programmed, be sure to turn the target system on or off.

¢ Debugging functions other than downloading of a program are not usable in the “writing the on-chip flash
memory” mode.

(11) Disassembled Display
The [Editor] window in the disassembly mode displays undefined codes as “???’.
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